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   Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
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symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
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DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
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be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
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Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
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in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

WARNING  
This device may only be used for the applications described in the catalog or the technical description and only 
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recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, 
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Trademarks 
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owner. 

Disclaimer of Liability 
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described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
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Preface 

Contents of this commissioning and hardware installation Manual 
This document is part of the SIMOTION D4xx documentation package. 

Scope 
The SIMOTION D4x5 Commissioning and Hardware Installation Manual is valid for the 
SIMOTION D425, SIMOTION D435, SIMOTION D445, and CX32 devices. 

Standards 
The SIMOTION system was developed in accordance with ISO 9001 quality guidelines. 

Information in this Manual 
The following is a description of the purpose and use of this commissioning and hardware 
installation Manual: 
● Description 

Provides information about the SIMOTION system and its integration in the automation 
environment. 

● Use planning 
Provides information on the transport, storage, and environmental conditions. 

● Installation 
Provides information on the various installation options for the device. 

● Connection 
Provides information on connecting and cabling the various devices and communication 
interfaces. 

● Commissioning (hardware) 
Provides information on commissioning the device. 

● Parameter assignment / addressing 
Provides information on configuring and parameterizing the various bus systems. 

● Commissioning (software) 
Provides information on configuring and commissioning the system. 
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● Maintenance and servicing 
Provides information about service and maintenance procedures that must be performed 
on the device. 

● Diagnostics via LED displays 
Provides information on the causes of messages that can be output by the system and 
their meaning. 

● Appendices with factual information for reference (for example, Standards and Approvals, 
ESD Guidelines, etc.) 

SIMOTION Documentation 
An overview of the SIMOTION documentation can be found in a separate list of references.  
This documentation is included as electronic documentation with the supplied SIMOTION 
SCOUT. 
The SIMOTION documentation consists of 9 documentation packages containing 
approximately 80 SIMOTION documents and documents on related systems (e.g. 
SINAMICS).  
The following documentation packages are available for SIMOTION V4.1 SP2: 
● SIMOTION Engineering System 
● SIMOTION System and Function Descriptions 
● SIMOTION Diagnostics 
● SIMOTION Programming 
● SIMOTION Programming - References 
● SIMOTION C 
● SIMOTION P350 
● SIMOTION D4xx 
● SIMOTION Supplementary Documentation 
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Hotline and Internet addresses 

Technical support  
If you have any technical questions, please contact our hotline: 

 

 Europe / Africa 
Phone +49 180 5050 222 (subject to charge) 
Fax +49 180 5050 223 
Internet http://www.siemens.com/automation/support-request  

 

 

 Americas 
Phone +1 423 262 2522 
Fax +1 423 262 2200 
E-mail mailto:techsupport.sea@siemens.com  

 

 

 Asia / Pacific 
Phone +86 1064 719 990 
Fax +86 1064 747 474 
E-mail mailto:adsupport.asia@siemens.com  

 

 Note 
Country-specific telephone numbers for technical support are provided under the following 
Internet address:  
http://www.siemens.com/automation/service&support  
Calls are subject to charge, e.g. 0.14 €/min. on the German landline network. Tariffs of other 
phone companies may differ. 

 

Questions about this documentation 
If you have any questions (suggestions, corrections) regarding this documentation, please 
fax or e-mail us at:  

 

Fax +49 9131- 98 63315 
E-mail mailto:docu.motioncontrol@siemens.com    
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Siemens Internet address 
The latest information about SIMOTION products, product support, and FAQs can be found 
on the Internet at: 
● General information: 

– http://www.siemens.de/simotion (German) 
– http://www.siemens.com/simotion (international) 

● Product support: 
– http://support.automation.siemens.com/WW/view/en/10805436 

Additional support 
We also offer introductory courses to help you familiarize yourself with SIMOTION. 
Please contact your regional training center or our main training center at D-90027 
Nuremberg, phone +49 (911) 895 3202. 
Information about training courses on offer can be found at: 
www.sitrain.com 

Product disposal 
SIMOTION D4x5 is an environmentally friendly product. It includes the following features: 
● In spite of its excellent resistance to fire, the flame-resistant agent in the plastic used for 

the housing does not contain halogens. 
● Identification of plastic materials in accordance with DIN 54840 
● Less material used because the unit is smaller and with fewer components thanks to 

integration in ASICs. 
For state-of-the art environmentally friendly recycling and disposal of your old modules, 
contact your local Siemens representative. Contact details can be found in our contacts 
database on the Internet at: 
http://www.automation.siemens.com/partner/index.asp 
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Further information / FAQs 
You can find further information on this manual under the following FAQs: 
http://support.automation.siemens.com/WW/view/de/27585482 
You can also find additional information: 
● SIMOTION Utilities & Applications CD: This CD is supplied together with the SIMOTION 

SCOUT and, along with FAQs, also contains free utilities (e.g. calculation tools, 
optimization tools, etc.) and application examples (ready-to-apply solutions such as 
winder, cross cutter or handling). 

● The latest SIMOTION FAQs are online at 
http://support.automation.siemens.com/WWview/de/10805436 

● SIMOTION SCOUT online help 
● Refer to the list of references (separate document) for additional documentation 
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Description 1
1.1 System overview 

Overview 
SIMOTION D is a compact, drive-based version of SIMOTION based on the SINAMICS 
S120 drives family. 
Two versions are available: 
● SIMOTION D410 is a compact control unit for single-axis applications and is snapped on 

to the SINAMICS S120 PM340 Power Module in blocksize format. 
● SIMOTION D4x5 is a control unit for multi-axis applications in SINAMICS S120 booksize 

format and is offered in several performance variants: 
– SIMOTION D425 (BASIC performance) for up to 16 axes 
– SIMOTION D435 (STANDARD performance) for up to 32 axes 
– SIMOTION D445 (HIGH performance) for up to 64 axes 

This manual describes the SIMOTION D4x5 for multi-axis applications. Separate manuals 
are available for the SIMOTION D410 single-axis module. 
Like SINAMICS S120, SIMOTION D also follows the Totally Integrated Automation (TIA) 
concept. TIA is characterized by integrated data management, configuration, and 
communication for all products and systems. Thus, an extensive toolbox of automation 
modules is also available for SIMOTION D.  

 

 Note 
In order to cover all variants of SIMOTION D for multi-axis applications, the product will be 
referred to as "D4x5". Specific product designations will be used for information that applies 
only to one product version, e.g., D435. 
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Application 
SIMOTION D4x5 is ideally suited to applications with many coordinated axes with high clock-
pulse rates. 
Typical applications include: 
● Compact multiple-axis machines 
● High-performance applications with short machine cycles 
● Compact machines 

– Including the complete machine control in the drive 
– With extensive connection possibilities for communication, HMI and I/O 

● Distributed drive concepts 
– Applications with many axes 
– Synchronization of several SIMOTION D Control Units using distributed synchronous 

operation 

Product variants 
The individual versions SIMOTION D425 (BASIC Performance), SIMOTION D435 
(STANDARD performance) and SIMOTION D445 (HIGH Performance) differ in their PLC 
performance and motion control performance. The main distinguishing features are: 

 

 SIMOTION D425 SIMOTION D435 SIMOTION D445 
Maximum number of axes 16 32 64 
Minimum servo/interpolator cycle 
clock 

2.0 ms 1.0 ms 0.5 ms 

DRIVE-CLiQ interfaces 4 4 6 

SIMOTION D4x5 features PLC and motion control performance (open-loop control and 
motion control) for up to 16, 32 or 64 axes, as required. The computing functions integrated 
into the drive allow the D4x5 Control Unit to operate up to 6 servo, 4 vector or 8 V/f axes. 
The drive control supports servo control (for a highly dynamic response), vector control (for 
maximum torque accuracy) and V/f control. 
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Hardware components: SIMOTION runtime module and SINAMICS drive control 
As the central hardware, SIMOTION D uses the SIMOTION D4x5 as a control unit consisting 
of the SIMOTION runtime module and the SINAMICS drive control. The control unit uses the 
SINAMICS Integrated drive with various SINAMICS S120 drive modules (Line and Motor 
Modules) to perform open-loop and closed-loop control of the axis grouping. A range of 
additional SINAMICS S120 components, such as SMx encoder systems or terminal modules 
can be connected via DRIVE-CLiQ. With a few exceptions (e.g. no basic positioner EPos, no 
Basic Operator Panel BOP20, etc.) the drive control integrated in SIMOTION D has the 
same control characteristics and performance features as the SINAMICS S120 CU320 
Control Unit. The EPos functionality is provided by the SIMOTION technology functions. The 
functionality of SIMOTION D can be expanded with the distributed I/O via PROFIBUS or with 
the CBE30 Option Module via PROFINET IO.  
The following figure shows a typical SIMOTION D axis grouping. 

 
Figure 1-1 Example of a SIMOTION D4x5 axis assembly 

A SIMOTION D axis grouping generally consists of the following elements: 
● SIMOTION D (Control Unit) (1) 

This unit contains the programmable runtime system of SIMOTION and the drive software 
of SINAMICS S120. In principle, SIMOTION D is capable of controlling multiple 
axes/drives.  

● One SINAMICS infeed (Line Module) (2) 
This module generates a DC link from the supply system. 

● SINAMICS power units (Motor Modules) (3) 
These modules are used to control motors. 
It is also possible to operate SINAMICS Power Modules with the SINAMICS CUA 
adapter. A separate infeed is then unnecessary. 
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● DRIVE-CLiQ components (4) 
In SINAMICS S120/SIMOTION D, the individual components of the drive system 
communicate with each other via DRIVE-CLiQ. In addition to power components, 
encoder systems and special DRIVE-CLiQ I/O devices can also be linked via DRIVE-
CLiQ. 

Extension of the drive computing performance 
The motion control performance of a SIMOTION D4x5 can be utilized in full by expanding 
the computing performance at the drive in two different ways: 
● Over PROFIBUS or PROFINET, SINAMICS S120 CU320/CU310 Control Units complete 

with further SINAMICS S120 drive modules can be connected. 
● With SIMOTION D435 and D445, the CX32 Controller Extension can be connected over 

DRIVE-CLiQ. This module is extremely compact and can control up to 6 servo, 4 vector 
or 8 V/f axes. 

Software components: SIMOTION runtime system and SINAMICS closed-loop drive control 
The basic functionality of SIMOTION D is supplied on a Compact Flash card containing the 
following:  
SIMOTION runtime system including the following functions: 
● User-programmable runtime system (IEC 61131) 
● Various runtime levels (tasks) 
● PLC and arithmetic functionality 
● Motion control functions 
● Communication functions 
SINAMICS S120 drive control including the following functions: 
● Closed-loop current and torque control 
● Closed-loop speed control 
● Closed-loop infeed 
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1.2 System components 

Central components 
SIMOTION D4x5 communicates with automation components via the following interfaces:  
● PROFIBUS DP 
● Ethernet 
● PROFINET (when using a CBE30) 
● DRIVE-CLiQ (DRIVE Component Link with IQ) 
The most important components of the system and their functions are shown below. 

Table 1- 1 Central components  

Component Function 
SIMOTION D4x5 controller ... is the central motion control module.  

You can use the integrated rapid digital I/Os as: 
• Homing inputs 
• Inputs for measuring inputs 
• User-addressable process inputs/outputs 
The measuring sockets can output any analog signals. 

System software The basic functionality of SIMOTION D is supplied on a Compact Flash 
card containing the following: 
• SIMOTION Runtime (Kernel and technology packages) 
• Drive software of SINAMICS S120 - implements all drive functions 

Power supply ... provides the electronic power supply for SIMOTION D, e.g., via the 
SITOP power supply. 



Description  
1.2 System components 

 D4x5 
20 Commissioning and Hardware Installation Manual, 08/2008 Edition 

PROFIBUS DP  
The control unit can communicate with the following components via the PROFIBUS DP 
interfaces: 

Table 1- 2 Components on PROFIBUS DP 

Component  Function 
Programming device (PG/PC) ... configures, parameterizes, programs, and tests with the 

"SIMOTION SCOUT" engineering system (ES) 
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an 

essential requirement for the operation of a control unit. 
Other controllers (e.g. 
SIMOTION or SIMATIC) 

 

Additional control unit  
Distributed I/O systems  
SIMATIC ET 200M  Modular I/O system for control cabinet installation and high channel 

density 
SIMATIC ET 200S Finely scalable I/O system for control cabinet installation and 

particularly time-critical applications; including motor starters, safety 
technology and individual grouping of load groups. 

SIMATIC ET 200pro Modular I/O system with IP65/67 rating for machine-related 
applications with no control cabinet; with features such as compact 
designs, integrated PROFIsafe safety technology, PROFINET 
connection and live module replacement. 

SIMATIC ET 200eco I/O system with IP65/67 degree of protection for cabinet-free use 
close to the machine with flexible and fast ECOFAST or M12 
connection methods 

Other PROFIBUS I/O 
Gateways • DP/AS-Interface link 20E and DP/AS-Interface link Advanced for 

the PROFIBUS DP gateway to AS-Interface 
• DP/DP coupler for connecting two PROFIBUS DP networks 

Drive interfaces • ADI4 (Analog Drive Interface for 4 axes) for connection of drives 
with analog ± 10 V setpoint interface or for external encoders 

• IM174 (Interface Module for 4 axes) for connection of drives with 
analog ± 10 V setpoint interface, for external sensors, or for 
connection of stepper drives with pulse-direction interface 

Drive units with 
PROFIBUS DP interface 
(e.g., SINAMICS S120) 

... convert speed setpoints into signals for controlling the motor and 
supply the power required to operate the motors. 
Also can be operated as an isochronous slave on PROFIBUS DP. 
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Ethernet 
The control unit can communicate with the following components via the Ethernet interfaces 
or be embedded in an automation environment: 

Table 1- 3 Components on the Ethernet 

Component  Function 
Programming device (PG/PC) ... configures, parameterizes, programs, and tests with the 

"SIMOTION SCOUT" engineering system (ES) 
Master computer ... communicates with other devices via UDP, TCP/IP 
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an 

essential requirement for the operation of a control unit. 

PROFINET 
The use of a Communication Board Ethernet (CBE30) enables SIMOTION D4x5 to 
communicate with the following components via PROFINET: 

Table 1- 4 Components on the PROFINET 

Component Function  
Programming device (PG/PC) ...configures, parameterizes, programs, and tests with the 

"SIMOTION SCOUT" engineering system (ES) 
Master computer ... communicates with other devices via UDP, TCP/IP. 
SIMATIC HMI device ... is used for operator control and monitoring functions. This is not 

an essential requirement for the operation of a SIMOTION D4x5. 
SIMATIC ET 200M Modular I/O system for control cabinet installation and high 

channel densities. 
SIMATIC ET 200S Finely scalable I/O system for control cabinet installation and 

particularly time-critical applications; including motor starters, 
safety technology and individual grouping of load groups. 

SIMATIC ET 200pro Modular I/O system with IP65/67 rating for machine-related 
applications with no control cabinet; with features such as compact 
designs, integrated PROFIsafe safety technology, PROFINET 
connection and live module replacement. 

Drive units with PROFINET 
interface 

... convert speed setpoints into signals for controlling the motor 
and supply the power required to operate the motors. 

Other controllers (e.g. 
SIMOTION or SIMATIC) 

 

Gateways • IE/AS-Interface link PN IO for the PROFINET IO gateway to 
AS-Interface 

• PN/PN coupler for connecting two PROFINET IO networks 
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DRIVE-CLiQ 
The DRIVE-CLiQ interfaces permit a fast connection to the SINAMICS drive components. 
DRIVE-CLiQ offers the following advantages within the DRIVE-CLiQ topology rules:  
● Independent expansion of components possible 
● Automatic detection of components by the control unit 
● Standardized interfaces to all components 
● Uniform diagnostics down to the components 
● Complete service down to the components 
● Simple mechanical handling 
The controller can communicate with the following components via DRIVE-CLiQ: 

Table 1- 5 Components on DRIVE-CLiQ:  

Component Function 
Control Unit (SINAMICS S120) Central control module in which the open- and closed-loop 

control functions for the drive are implemented. 
Line Module (SINAMICS S120) ... generates a DC link from the supply system. 
Motor Module (SINAMICS S120) ... used to control motors (DC/AC inverters, booksize). 
Power Module (SINAMICS S120) ...used to control motors (AC/DC converters, blocksize). 
Controller Extension CX32 ... enables additional axes to be connected for SIMOTION D435 

and D445. 
CUA31/CUA32 control unit 
adapter 

...enables a blocksize power module (PM340) to be connected to 
a booksize control unit D4x5, CX32 or CU320. 

Terminal Module TM31 ... enables a terminal expansion via DRIVE-CLiQ (additional 
analog and digital I/Os). 

Terminal Module TM41 ... enables a terminal expansion (analog and digital I/Os) and 
encoder simulation. 

Terminal Module TM54F ... enables a terminal expansion (secure digital inputs/digital 
outputs) for control of secure motion monitoring functions. 

Terminal Module TM15, TM17 
High Feature 

The terminal modules TM15 and TM17 High Feature are used to 
implement inputs of measuring inputs and outputs of cam 
outputs. In addition, these terminal modules provide drive-related 
digital inputs and outputs with short signal delay times. 

SMx sensor modules ... enable acquisition of encoder data from connected motors via 
DRIVE-CLiQ. 

Motors with DRIVE-CLiQ 
interface 

...allow simplified commissioning and diagnostics, as the motor 
and encoder type are identified automatically. 

DMC20 DRIVE-CLiQ Hub …Enables the number of DRIVE-CLiQ interfaces to be increased 
and the creation of a star-shaped topology. 

 

 Note 
You can find detailed information about components in the SINAMICS S120 family of 
products in the SINAMICS S120 manuals. 
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Optional components  
The following components enable an expansion of the functionality. 

Table 1- 6 Optional components for the control unit: 

Component Function 
Communication Board Ethernet 
CBE30 

… enables communication via PROFINET IO with IRT and 
PROFINET IO with RT. 

Terminal Board TB30 ... enables a terminal expansion through plug-in of the option 
board (additional analog and digital I/Os). 

1.3 Approved components for SIMOTION D 
 

 Note 
The modules and devices approved for the SIMOTION C are listed in the PM 21 Catalog. 
For catalog order numbers, refer to the list of references (separate document). 

 

 Note 
Note that not all modules in the ET 200 I/O family are approved for SIMOTION. Moreover, 
system-related functional differences can come into play when these I/O or I/O systems are 
used on SIMOTION vs. on SIMATIC. For example, special process-control functions (e.g., 
HART modules, etc.) are not supported by SIMOTION for the ET 200M distributed I/O 
system. 
A detailed, regularly updated list of the I/O modules approved for use with SIMOTION, as 
well as notes on their use, can be found on the Internet at: 
http://support.automation.siemens.com/WW/view/en/11886029  

 

In addition to the I/O modules approved for SIMOTION, all certified standard slaves can, in 
principle, be connected to SIMOTION if they support the following: 
● Cyclic data traffic (DP-V0) and, possibly, 
● Acyclic data traffic (DP-V1) or 
● Isochronous data traffic (DP-V2) 
These modules are integrated via the GSD file of the device's manufacturer. 

 

 Note 
Please note that in individual cases further boundary conditions must be fulfilled in order to 
integrate a standard slave into SIMOTION. Thus, a few modules require "driver blocks" , 
e.g., in the form of function blocks, that permit (or simplify) integration. 
For modules enabled for SIMOTION (e.g., SIMATIC S7-300 module FM 350-1, etc.), these 
driver modules are part of the SIMOTION SCOUT Engineering System command library. 
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1.4 Commissioning software 

Requirement 
To create and edit projects on your PG/PC, you need the SIMOTION SCOUT commissioning 
and configuration tool. For information on how to install SIMOTION SCOUT, refer to the 
SIMOTION SCOUT Configuration Manual. 

 

 Note 
SIMATIC S7-Technology is integrated in SCOUT from SIMOTION V4.0 and higher. 
SIMOTION SCOUT also contains STARTER functionality. You can insert a standalone drive 
(e.g. SINAMICS S120) with the "Insert single drive unit" element in the project navigator. It is 
commissioned using wizards in the working area of the workbench that contains the 
STARTER functionality. 
Simultaneous operation of SIMOTION SCOUT, STARTER and SIMATIC S7-Technology as 
a single installation on one PC/PG is not possible. 

 

Upgrade SIMOTION D4x5 projects and hardware 
Projects that you have created for one SIMOTION D4x5 firmware version can also be 
converted for other firmware versions. In addition, it is possible to amend the version of 
SIMOTION D4x5. For example, a D425 can be converted to a D435 (and vice versa, insofar 
as the performance and quantity structure allow this). 

Additional references 
For detailed information on working with projects, refer to the SIMOTION SCOUT 
Configuration Manual. 

See also 
Performing a software and firmware upgrade (Page 229) 
Upgrading or replacing D4x5 (Page 223) 
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1.5 Safety notes 
Note the following safety information when working with the control unit and its components. 

 

CAUTION  
An option board may only be inserted and removed when the control unit and option board 
are disconnected from the power supply. 

 

NOTICE  
The 80 mm clearances above and below the components must be observed. The unit 
protects itself from overheating by shutting down. 

 

CAUTION  
The Compact Flash card may only be inserted or removed when the control unit is 
disconnected from the power supply. 
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Use planning 2
2.1 Shipping and storage conditions 

Shipping and storage conditions 
With regard to transportation and storage conditions, SIMOTION D4x5 surpasses the 
requirements specified in IEC 1131, Part 2. The following conditions apply to modules that 
are transported and stored in the original packaging.  

Conditions 

Table 2- 1 Shipping and storage conditions 

Type of condition Permissible range 
Free fall ≤ 1 m 
Temperature From -40 °C to +70 °C 
Atmospheric pressure Air pressure in mbar (kPa): 

> > 700 mbar (70 kPa) 
<1060 mbar (106 kPa) 
The specified values correspond to a transport or storage altitude of up 
to 3,000 m. 

Relative humidity 5% to 95%, without condensation 
 

 Note 
If you have a spare parts inventory, you must not store a SIMOTION D4x5 with the 
fan/battery module mounted. Only connect the fan/battery module if the fan or battery 
backup voltage is required. 

 

2.2 Mechanical and climatic ambient conditions 
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Conditions of use 
SIMOTION D4x5 is designed for use in stationary, weather-protected locations. The 
operating conditions surpass the IEC 1131-2 requirements. 
SIMOTION D4x5 satisfies the operating conditions for Class 3C3 in accordance with DIN EN 
607213-3 (operating locations with high traffic densities and in the immediate vicinity of 
industrial equipment with chemical emissions).  

Use prohibition 
Without additional measures, SIMOTION D4x5 may not be used in 
● Locations with a high percentage of ionizing radiation 
● Locations with extreme operating conditions, e.g. 

– Dust accumulation 
– Corrosive vapors or gases 

● In systems, which require special monitoring, e.g. 
– Elevator installations 
– Electrical installations in highly sensitive areas 

An additional measure for using SIMOTION D4x5 can, for example, be installation in 
cabinets. 

Mechanical ambient conditions 
SIMOTION D4x5 meets the following standards for mechanical stress: 
● Vibrational load: DIN EN 60721-3-3, Class 3M4 
● Shock load: DIN EN 60721-3-3, Class 3M4 
● Free fall: DIN EN 60721-3-2, Class 2M1 and Class 2M2 
● Toppling: DIN EN 60721-3-2, Class 2M1 
The mechanical ambient conditions for SIMOTION D4x5 are listed in the following table in 
the form of sinusoidal vibrations. 

Table 2- 2 Mechanical ambient conditions 

Frequency range (Hz) continuous infrequent 
10 ≤ f ≤ 58  0.0375 mm amplitude 0.075 mm amplitude 
58 ≤ f ≤ 150  0.5 g constant acceleration 1 g constant acceleration 
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Vibration reduction 
If SIMOTION D4x5 is subjected to larger shocks or vibrations, you must use suitable 
measures to reduce the acceleration or the amplitude.  
We recommend installation on shock-absorbing material (e.g. rubber-metal vibration 
dampers). 

Testing mechanical environmental conditions 

Table 2- 3 Mechanical ambient conditions 

Testing Test standard Comments 
Vibrations Vibration testing in 

accordance with IEC 68 
Part 2-6 (sine) severity 
level 12 

Type of vibration: Frequency sweeps at a rate of 
change of 1 octave per minute. 
10 Hz ≤ f ≤ 58 Hz, const. Amplitude 0.075 mm 
58 Hz ≤ f ≤ 500 Hz, const. acceleration 1 g 
Duration of vibration: 10 frequency cycles per axis in 
each of the 3 perpendicular axes 

Shock Shock testing in 
accordance with 
IEC 68 Part 2-27 

Type of shock: half sine 
Severity of shock: 15 g peak value, duration = 11 ms 
Direction of shock: 3 shocks each in +/- direction in 
each of the 3 perpendicular axes 
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Climatic ambient conditions 
SIMOTION D4x5 satisfies the climatic environmental conditions for Class 3K5 in accordance 
with DIN EN 60721-3-3.  
SIMOTION D4X5 may not be used under the following climatic ambient conditions: 

 

Ambient conditions Application range Comments 
The fan/battery module is optional for SIMOTION 
D425 and D435 (Type 6AU1435-0AA00-0AA1).  
The fan/battery module is required at supply air 
temperatures of 43° C and above for 
SIMOTION D435 (Type 6AU1435-0AA00-0AA0, 
previous version).  

Temperature: Vertical 
mounting position: 

0° C to 55° C 

The fan/battery module is always 
required for SIMOTION D445. 
The maximum supply air temperature for all 
modules is 55° C. 

Relative humidity 5% to 95% Without condensation, corresponds to relative 
humidity (RH) severity level 2 in accordance with 
IEC 1131-2 

Atmospheric pressure 700 hPa to 1060 hPa 3000 m - 0 m above mean sea level 
Pollutant concentration  

SO2: < 0.5 ppm; 
Relative humidity < 60%, no condensation 
H2S: < 0.1 ppm; 
Relative humidity < 60%, no condensation

Test: 
10 ppm; 4 days 
 
1 ppm; 4 days 
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2.3 Information on insulation tests, safety class, and degree of protection 

Test voltages 
During the routine test, the insulation resistance is tested at the following test voltage in 
accordance with IEC 1131 Part 2: 

Table 2- 4 Test voltages 

Circuits with rated voltage Ue relative to other circuits or 
ground 

Test voltage 

0 V < Ue ≤ 50 V 500 VDC 

Class of protection 
Safety class I in accordance with VDE 0106, Part 1 (IEC 536), i.e. a protective-conductor 
terminal is required on the mounting rail. 

Protection against ingress of solid foreign bodies and water 
Degree of protection IP 20 in accordance with IEC 529, i.e., protection against contact with 
standard probes. 
Also: Protection against ingress of solid foreign bodies with diameters greater than 12.5 mm.  
No special protection against ingress of water. 
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Installing 3
3.1 Installation notes 

Open equipment 
These modules are open equipment. This means they may only be installed in housings, 
cabinets, or in electrical equipment rooms that can only be entered or accessed with a key or 
tool. Housings, cabinets, or electrical equipment rooms may only be accessed by trained or 
authorized personnel. An external fire-protection housing is required. 

 

DANGER  
The equipment must be deenergized when you install the control unit. 
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3.2 Mounting a SIMOTION D4x5 

Requirement 
The control unit is installed in a control cabinet along with the SINAMICS components. 
The following requirements must be met for installing a control unit: 
● The control cabinet has been installed and wired. 
● SINAMICS components should already have been installed and wired (for side 

mounting). 
● Components and tools are available. 

Designs 
The control unit is compatible with the SINAMICS S120 in booksize format. There are two 
possible mounting methods:  
● Side mounting on the SINAMICS S120 line module 

In this type of installation, the control unit is attached to the side panel of the line module 
in the control cabinet. 

● Direct mounting on the rear wall of the control cabinet 
In the case of both designs, the CF card and the options slot can be accessed from the 
outside. The fan/battery module can be mounted later. 
Because the control unit is related to the SINAMICS S120 family when it comes to 
installation, please observe these notes and the corresponding reference documents. 
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Mounting and installation aids 
The Control Unit is designed for mounting in a control cabinet (IP20 degree of protection). All 
versions of SIMOTION D4x5 are supplied with preassembled spacers for mounting on the 
rear wall of the control cabinet. With SIMOTION D425 and D435, the spacers can be 
removed if necessary. 

 
Figure 3-1 Mounting aids for SIMOTION D425 and D435 

Mounting a SIMOTION D445 
Because a SIMOTION D445 has cooling ribs for heat dissipation, the spacers provided as 
standard cannot be disassembled.  
The D445 can be mounted on the control cabinet's rear wall using spacers, or side-mounted 
on the SINAMICS assembly using mounting fixtures. 

 

 Note 
SIMOTION D445 can only be operated with a fan/battery module. This module is supplied 
with SIMOTION D445 and has to be mounted first. A description of how to install the 
fan/battery module can be found in the section titled "Installing the fan/battery module" in the 
SIMOTION D4x5 Manual. 
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See also 
Side-mounting of SIMOTION D4x5 on SINAMICS assembly (Page 36) 
Mounting the SIMOTION D4x5 with spacers (Page 37) 
Mounting the SIMOTION D425 and D435 on the rear wall of the control cabinet (Page 38) 

3.3 Side-mounting of SIMOTION D4x5 on SINAMICS assembly 
The Control Unit is normally mounted on the side wall of a SINAMICS S120 Line Module. 
The mounting fixtures required for this are supplied with the SINAMICS S120 Line Module.  
The SINAMICS S120 Line Module has five mounting fixtures on the left side. To mount the 
control unit, proceed as follows: 
1. Attach the Control Unit to the left side of the SINAMICS S120 Line Module. The mounting 

fixtures fit exactly in the five cutouts on the module. 
2. Push the two units together. 
3. Press down on the module until the unit engages and is securely connected to the 

SINAMICS S120 Line Module. 
The module is connected flush with the SINAMICS assembly on top and in front. 

 
Figure 3-2 SINAMICS assembly with SIMOTION D4x5 
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3.4 Mounting the SIMOTION D4x5 with spacers 

Precondition for mounting with spacers 
By using spacers, you can attach the control unit to a blank, conductive metallic rear wall of 
a control cabinet using two M5 or M6 screws. This mounting method must be used if several 
control units are required and the mounting depth of the SINAMICS S120 booksize assembly 
is to be achieved. The spacers are provided with the control unit.  

Procedure 
1. Attach the spacers that have been removed from the D425/D435 to the Control Unit. 
2. Use two M5 or M6 screws to mount the Control Unit on the rear wall of the control 

cabinet. 

 
Figure 3-3 Mounting the control unit with spacers 

Result 
The control unit is mounted separately from the SINAMICS booksize components but flush 
with the assembly on the rear wall of the control cabinet. 
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3.5 Mounting the SIMOTION D425 and D435 on the rear wall of the 
control cabinet 

The control unit can also be mounted on the rear wall of the control cabinet if separation 
from the line module is either necessary or desirable. Two mounting options are provided for 
mounting on the back wall of the control cabinet: 
● Direct mounting on the rear wall of the control cabinet (D425/D435 only) 
● Mounting with spacers on the rear wall of the control cabinet 
The control unit has a metal clip at the top of the rear panel; when shipped, the clip is 
pushed in and secured with three M3 screws (0.8 Nm).  
1. Loosen the screws and push the clip up until the upper hole extends beyond the housing. 
2. Tighten up the three screws on the clip again. 
3. Mount the top and bottom of the Control Unit directly on the rear wall of the control 

cabinet using two M5 or M6 screws (6 Nm tightening torque). 

 
Figure 3-4 Mounting the control unit on the rear wall of the control cabinet 

The control unit is mounted separately from the SINAMICS booksize components on the rear 
wall of the control cabinet. 
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Connection 4
4.1 Complete overview (example) 

Overview 
The SIMOTION D4x5 has a number of interfaces that are used for connecting the power 
supply and for communication with the other components of the system. To make these 
connections, the front cover of the SIMOTION D4x5 must be removed. 
● The different SINAMICS components are interconnected via DRIVE-CLiQ. 
● Actuators and sensors can be connected to the digital inputs/outputs. 
● For communication purposes, the SIMOTION D4x5 can be connected to PROFIBUS DP, 

PROFINET IO with IRT/RT, MPI, and Ethernet. 
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Overview of connections 
The following overview shows an example of the various interfaces and their connection 
options.  

?

 
Figure 4-1 Connection options for SIMOTION D4x5 
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4.2 Safety information for wiring 

Requirement 
Once you have mounted the control unit in the control cabinet, you can begin wiring the 
assembly. 

 

 Note 
Safety functions, reliability, and EMC are guaranteed only with original SIEMENS cables. 

 

Note the following safety information: 
 

DANGER  
The equipment must be deenergized when you wire the control unit. 

 

Equipotential bonding 
The SIMOTION D4x5 is designed for use in cabinets with a PE conductor connection.  
If the drive line-up is arranged on a common unpainted metal-surfaced mounting plate, e.g. 
with a galvanized surface, no additional equipotential bonding is needed within the drive line-
up. If the drive components are located in different cabinets, you have to ensure 
equipotential bonding. If, for example, the PROFIBUS, PROFINET, Ethernet, or DRIVE-CLiQ 
cable is routed through several control cabinets, the "potential connection" of the SIMOTION 
D4x5 must be used for connecting the equipotential bonding conductor. Use a finely 
stranded copper conductor with 4 mm² cross section and lay it with the 
PROFIBUS/PROFINET/Ethernet/DRIVE-CLiQ connecting cable. 
The "potential connection" is located below the mode selector on the SIMOTION D4x5. See 
also the chapter titled  "Description" in the SIMOTION D4x5 Manual. 
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4.3 Opening the front cover 

Introduction 
The interfaces are concealed behind a front cover. You must remove this cover before you 
can wire the interfaces.  
A hinge connects the front cover to the front of the housing. Once opened, the cover can be 
completely removed. When the front cover is closed (flipped up), it automatically locks into 
place by means of a hook on the connector panel. 

Procedure 
1. Disengage the release hook on the inside of the front cover (the front cover is open and 

in the up position). 
2. Remove the front cover with a forward motion. 

 

 
Figure 4-2 Removing the front cover 

 
 

 Note 
All cables must be routed vertically upwards to the fullest extent possible so that the front 
cover can be closed. The front cover is open and in the up position. 
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4.4 Power supply 

4.4.1 Safety rules 

Basic rules 
Because of the wide range of possible applications, only the basic rules for electrical 
installation can be included in this section. At a minimum, you must comply with these basic 
rules to ensure problem-free operation. 

Rules for safe operation 
In order to ensure safe operation of your equipment, implement the following measures, 
adapting them to suit your conditions:  
● An EMERGENCY STOP strategy in accordance with the generally accepted rules of 

current engineering practice (e.g. European Standards EN 60204, EN 418 and similar).  
● Additional measures for end position limiting of axes (e.g., hardware limit switches). 
● Equipment and measures for protection of motors and power electronics in accordance 

with the SINAMICS installation guidelines. 
In addition, in order to identify hazards, we recommend that a risk analysis be conducted 
on the entire system in accordance with the basic safety requirements set out in 
Appendix 1 of EU Machinery Directive 89/392/EEC. 

Additional references 
● Guidelines on Handling Electrostatically Sensitive Devices (ESD), see Appendix. 
● For configuring a system with SIMATIC ET 200 I/O (e.g. ET 200S, ET 200M, ...), refer to 

the manuals for the relevant ET 200 I/O system. 
● For further information on EMC guidelines, we recommend the publication: EMC 

Installation Guide, Configuring Guide (HW), Order no.: 6FC5 297-0AD30-0AP2.  

4.4.2 Standards and Regulations 

VDE guideline compliance 
During wiring, you must observe the appropriate VDE guidelines, in particular VDE 0100 and 
VDE 0113 for tripping devices and short-circuit and overload protection. 
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System startup after certain events: 
The following list identifies considerations required for startup of a system following certain 
events. 
● If the system starts up again following a voltage drop or power failure, all hazardous 

operating states must be prevented from occurring. If necessary, force an EMERGENCY 
OFF. 

● If the system starts up again after the EMERGENCY OFF apparatus is released, the 
startup must not be unchecked or undefined. 

4.4.3 Mains voltage 

Rules for the line voltage 
The following list indicates what you must take into account for the line voltage: 
● For stationary installations or systems that do not have all-pole line disconnect switches, 

the building installation must include a line disconnect switch or a fuse. 
● For load power supplies and power supply modules, the rated voltage range set must 

correspond to the local line voltage. 
● For all circuits, the fluctuation/deviation of the line voltage from the rated value must be 

within the permitted tolerance (refer to the technical data for the SIMOTION D and 
SINAMICS modules).  

24 V DC supply 
 

For... Requirement 
Buildings External lightning 

protection 
Install lightning protection (e.g. 
lightning conductors). 

24 V DC supply lines, signal lines Internal lightning 
protection 

 

24 V supply safe (electrical) isolation of the extra-low voltage  

Protection against external electrical phenomena 
The table below shows how you must protect your system against electrical interference or 
faults.  

Table 4- 1 External electrical phenomena 

For ... Requirement 
All plant or systems in which the 
component is installed 

The plant or system is connected to a protective 
conductor for the discharge of electromagnetic 
interference. 

Supply, signal, and bus lines The wiring arrangement and installation complies with 
EMC regulations.  

Signal and bus lines A cable or wire break cannot lead to undefined states in 
the plant or system. 
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4.4.4 Connecting the power supply 

Wiring the screw terminal block 
The required 24 VDC load power supply is wired to the screw-type terminal block (X124).  

 

DANGER  
The 24 VDC should be configured as functional extra-low voltage with safe isolation. 

 

Supply system lines 
Use flexible cables with a cross section of 0.25 to 2.5 mm2 (or AWG 23 to AWG 13) for wiring 
the power supply. 
If you only use one wire per connection, a ferrule is not required. 
You can use ferrules without an insulating collar in accordance with DIN 46228, Form A long 
version. 

Pin assignments 
For the pin assignment for the screw-type terminal block, refer to the Manual for the 
corresponding control unit. 
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4.5 Connecting DRIVE-CLiQ components 

4.5.1 DRIVE-CLiQ wiring 

Introduction 
The components of the SINAMICS S120 drive family and the SIMOTION D4x5 are wired 
together by means of DRIVE-CLiQ. DRIVE-CLiQ is a communication system that enables 
SIMOTION D4x5 to detect the connected components automatically. The wiring tree 
provided by DRIVE-CLiQ can be visualized in SCOUT.  

 

 Note 
For information on the number of DRIVE-CLiQ interfaces and their properties, refer to the 
SIMOTION D4x5 Manual. 

 

Rules for wiring DRIVE-CLiQ 
The following rules must be followed for wiring DRIVE-CLiQ: 
● Ring wiring is not permitted. 
● Components must not be double-wired. 
● For a motor module, the power line for the motor and the associated motor encoder must 

be connected.  
You will find detailed information about DRIVE-CLiQ wiring in the SINAMICS S120 Control 
Units and Additional System Components Manual. 
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Example 
The example shown in this diagram shows the rules for DRIVE-CLiQ wiring. 

 
Figure 4-3 DRIVE-CLiQ wiring (example) 
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4.5.2 Connectable DRIVE-CLiQ components 

Components 
As a general principle, all SINAMICS components approved for SIMOTION D can be 
connected directly to SIMOTION D or another DRIVE-CLiQ component using the DRIVE-
CLiQ interface.  

Table 4- 2 DRIVE-CLiQ  

Component Description 
Controller Extension CX32 The CX32 allows scaling for the drive-end computing performance of 

the SIMOTION D435 and D445. Each CX32 can control up to 
6 additional servo, 4 vector, or 8 V/f axes. 

Line modules Line modules (Active Line modules) provide the DC link voltage and 
can be connected via DRIVE-CLiQ depending on the module type.  

Motor modules Motor modules are used to control motors. SMC modules for 
processing encoder signals, for example, can be connected to motor 
modules. 

Motors with DRIVE-CLiQ 
interface 

Motors with a DRIVE-CLiQ interface allow simplified commissioning 
and diagnostics, as the motor and encoder type are identified 
automatically. 

SMx modules SMx Sensor Modules allow the acquisition of encoder data from the 
connected motors via DRIVE-CLiQ. 

TM15 and TM17 High 
Feature terminal modules 

The TM15 and TM17 High Feature Terminal Modules are used to 
implement inputs for measuring inputs and outputs for cam outputs. In 
addition, these Terminal Modules provide drive-related digital inputs 
and outputs with short signal delay times. 
• TM15: 24 isolated bidirectional DI/DO, with sensor and cam 

functionality 
• TM17 High Feature: 16 non-floating, bidirectional DI/DO with sensor 

and cam functionality for the highest demands with respect to 
resolution, accuracy and short input delay times. 

Terminal Module TM31 TM31 provides 8 DI, 4 bidirectional DI/DO, 2 relay outputs, 2 AI, 2 AO 
and 1 temperature sensor input (KTY84-130 or PTC). 

Terminal Module TM41 TM41 provides 4 DI, 4 bidirectional DI/DO, 1 AI and 1 TTL encoder 
output. 

Terminal Module TM54F TM54F provides the following interfaces: Four (4) failsafe DO (F-DO), 
10 failsafe DI (F-DI), 2 sensor power supplies with dynamic capability, 1 
sensor power supply without dynamic capability, and 4 DI to check the 
F-DO during a test stop. 

DMC20 DRIVE-CLiQ hubs provide 4 more DRIVE-CLiQ interfaces. They can be 
used, for example, to establish star topologies. 

SINAMICS S120 Power 
Module  
(with CUA31/CUA32) 

An AC DRIVE Power Module PM340 can be connected by means of 
the CUA31/CUA32 adapter module. 
You will find more information on the CUA31/CUA32 in the 
SINAMICS S120 AC Drive Manual. 
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Example of axis assembly 
The following diagram shows a possible DRIVE-CLiQ wiring scheme for an axis assembly. 

 
Figure 4-4 Axis assembly with DRIVE-CLiQ 
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4.5.3 Connecting CX32 

Installation/Mounting/Wiring 
Please refer to the SIMOTION Manual titled Additional SINAMICS System Components for 
SIMOTION for information on installing, mounting, and wiring the CX32. 

CX32 DRIVE-CLiQ topology 
Unlike other DRIVE-CLiQ components (e.g. Terminal Modules), special rules apply when 
wiring the CX32. 
● Only a star topology is possible between the CX32 and SIMOTION D. Each CX32 needs 

its own DRIVE-CLiQ port on the SIMOTION D Control Unit. 
● When a CX32 is inserted in an existing DRIVE-CLiQ connection (destination port for 

CX32 is occupied by, for example, a TM31), this connection is disconnected and replaced 
by the CX32 connection. The component that is freed up is moved to the component 
archive of the SINAMICS topology overview. A notice is displayed indicating that the 
component has been moved to the archive. The components must then be reassigned. 

● A CX32 is inserted via HW Config (see Configuring a CX32 (Page 139)). Here, the 
selection made for the PROFIBUS address automatically and permanently assigns the 
DRIVE-CLiQ port for connecting the CX32. Given that this assignment is permanent, the 
following points must be noted: 
– A connected and configured CX32 cannot be connected to another DRIVE-CLiQ port 

without taking additional measures. Reconnecting a CX32 results in a discrepancy 
between the specified and actual topologies of the DRIVE-CLiQ components. 

– A cross-exchange of two occupied DRIVE-CLiQ ports is not permissible. Such an 
exchange results in inconsistencies in the specified-actual topologies. 

– Once it has been created in HW Config, the connecting port of a CX32 cannot be 
changed. 

– In order to change the connecting port of a CX32, the CX32 must be deleted from HW 
Config and recreated with another address. 

– In order to delete a CX32, it must be deleted from HW Config before the configuration 
can be saved and compiled. 

– It is not possible to replace a D445 with a D435 if a CX32 has been configured with 
the address 14 or 15 (since a D435 does not have DRIVE-CLiQ ports X104/X105, it 
does not have addresses 14 and 15). 

 

 
 

Note 
Connection possibility 
A CX32 can only be connected to and operated on a SIMOTION D445 or D435. 
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Figure 4-5 CX32 topology 

Quantity structures 
If one or more CX32 modules are being used on a SIMOTION D435 or D445, the number of 
drives that can be used on the SINAMICS Integrated is reduced by one. This results in the 
following quantity structures: 
SIMOTION V4.1/SINAMICS V2.5 

Table 4- 3 Quantity structure for SIMOTION V4.1/SINAMICS V2.5 

 SINAMICS 
Integrated 

1. CX32 2. CX32 3. CX32 4. CX32 

SERVO D435 5+1 (5 drives + 
1 ALM 1)) 

6+1 6+1 --- --- 

SERVO D445 5+1 6+1 6+1 6+1 6+1 
VECTOR 
D435 

3+1 4+1 4+1 --- --- 

VECTOR 
D445 

3+1 4+1 4+1 4+1 4+1 

1) ALM = Active Line Module 
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SIMOTION V4.0 HF2/SINAMICS V2.4 

Table 4- 4 Quantity structure for SIMOTION V4.0 HF2/SINAMICS V2.4 

 SINAMICS 
Integrated 

1. CX32 2. CX32 3. CX32 4. CX32 

SERVO D435 5+1 (5 drives + 
1 ALM 1)) 

6+0 6+0 --- --- 

SERVO D445 5+1 6+0 6+0 6+0 --- 
VECTOR 
D435 

3+1 4+0 4+0 --- --- 

VECTOR 
D445 

3+1 4+0 4+0 4+0 --- 

1) ALM = Active Line Module 
 

 Note 
Mixed operation of servo and vector-controlled drives 
Mixed operation of servo and vector-controlled drives is not possible on a CX32. Therefore, 
drives on a CX32 must be operated in servo or in vector mode only. As with the SIMOTION 
D4x5, mixed operation of servo-controlled and V/f-controlled drives is possible on a CX32. 
V/f-controlled drives 
A maximum of 8 V/f-controlled drives are supported by each CX32. 

 

Additional references 
You will find more detailed information about the CX32 in the Manual Additional SINAMICS 
System Components for SIMOTION. 
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4.6 Connecting digital inputs/digital outputs 

Connecting cables for digital inputs/outputs 
The following conditions apply to connecting cables:  
● Use flexible cables with a cable cross-section of at least 0.25 mm2 
● Ferrules are not required. 
● You can use ferrules without an insulating collar in accordance with DIN 46228, Form A 

long version. 
● You can connect two cables each with a cross section of 0.25 mm2 in one ferrule. 

 

 
 

Note 
To achieve optimum interference immunity, shielded cables must be used for connecting 
measuring inputs or external zero marks. 

 

Tools required 
3.5-mm screwdriver or power screwdriver 

Wiring digital inputs/outputs 
1. Strip off 6 mm of cable insulation and, if necessary, press on a ferrule. 
2. Wire the digital inputs of the interface for connection of the sensors. 
3. Wire the digital outputs of the interface for connection of the actuators. 
4. Insert the cable into the corresponding spring-loaded terminal.  

Pin assignment 
For detailed information about the pin assignment of the X122/X132 interfaces, refer to the 
section entitled Interfaces in the SIMOTION D4x5 Manual. 

Using shielded cables 
The following options are available for the shield connection when using shielded cables: 
● A shield connection using a shielding bus supplied separately 
● A shield connection using the SIMOTION D shield connecting element 
If using a shielding bus, please proceed as follows: 
1. Attach the cable shield to a grounded shielding bus immediately after the cable entry 

point in the cabinet (strip the insulation off the cable for this purpose). 
2. Continue routing the shielded cable as far as the module but do not make a connection to 

the shield there. 
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Using a shield connection 
1. Remove the fixing bracket. 
2. Insert the cable (strip it first) and fasten the fixing bracket. 
This figure shows where to attach the cables to the front panel connector and where to apply 
the cable interference suppression using the shield connecting element.  

 
Figure 4-6 Using a shield connection 
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4.7 Connecting PROFIBUS/MPI 

4.7.1 PROFIBUS connection components 

Connection components 
Individual nodes are connected via bus connectors and PROFIBUS cables. Remember to 
provide a bus connector with a programming port at the ends of the subnet. This will give 
you the option of expanding the subnet if required, for example, for a programming device or 
SIMATIC HMI device.  
Use RS 485 repeaters for the connection between segments and to extend the cable. 

Segments 
A segment is a bus cable between two terminating resistors. A segment can contain up to 32 
nodes. In addition, a segment is limited by the permissible cable length, which varies 
according to the transmission rate.  

Terminating resistor 
A cable must be terminated with its own surge impedance to prevent line disturbances 
caused by reflections. Activate the terminating resistor at the first and last node of a subnet 
or segment. 
Make sure that the nodes to which the terminating resistor is connected are always supplied 
with voltage during power-up and operation.  
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4.7.2 PROFIBUS cables and connectors 

Features of PROFIBUS cables 
The PROFIBUS cable is a two-core, twisted, and shielded cable with the following features:  

Cable features 

Table 4- 5 Features of PROFIBUS cables 

Characteristics Values 
Wave impedance Approx. 135 to 160 Ω (f = 3 to 20 MHz) 
Loop resistance ≤ 115 Ω/km 
Effective capacitance  30 nF/km 
Damping 0.9 dB/100 m (f = 200 kHz) 
Permissible conductor cross section 0.3 mm2 to 0.5 mm2 
Permissible cable diameter 8 mm + 0.5 mm 

Connector features 
The bus connector is used to connect the PROFIBUS cable to the PROFIBUS DP interfaces 
(X126, X136), thus establishing a connection to additional nodes.  
Only bus connectors with a 35° cable outlet should be used in order to ensure that the front 
cover can be closed. 

See also 
Manual SIMOTION D4x5, Chapter "Spare parts and accessories" 

4.7.3 PROFIBUS cable lengths 

Cable lengths and baud rate 
The baud rate determines the cable length of a subnet segment.  

Table 4- 6 Permitted cable length of a subnet segment for specific baud rates 

Baud rate Max. cable length of a segment (in m) 
19.6 to 187.5 kbit/s 10001) 
500 kbit/s 400 
1.5 Mbit/s 200 
3 to 12 Mbit/s 100 

1) With isolated interface 
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Greater cable lengths 
If you must realize greater cable lengths than permitted in one segment, you must use 
RS 485 repeaters. The maximum possible cable lengths between two RS 485 repeaters 
correspond to the cable length of a segment. Please note that these maximum cable lengths 
only apply if there is no further node interconnected between the two RS 485 repeaters. You 
can connect up to nine RS 485 repeaters in a series. 
Note that an RS 485 repeater must be counted as a subnet node when determining the total 
number of nodes to be connected. This is true even if the RS 485 repeater is not assigned its 
own PROFIBUS address. 

4.7.4 Rules for routing PROFIBUS cables 

Routing bus cables 
When routing the PROFIBUS cable, you must avoid:  
● Twisting 
● Stretch the bus cable 
● Squeezing 

Boundary conditions 
In addition, when routing a bus cable for indoor use, you must take into account the following 
boundary conditions (dA = external cable diameter): 

Table 4- 7 Boundary conditions for routing of PROFIBUS cables 

Features Boundary conditions 
Bending radius for a single bend 80 mm (10xdA) 
Bending radius for multiple bends 160 mm (20xdA) 
Permissible temperature range for cable routing -5° C to +50° C 
Temperature range for storage and stationary operation -30° C to +65° C 

Additional references 
Length codes for the preassembled cables are found in the following source: 
● Ordering information Catalog NC 60.1 
● Ordering information Catalog PM 21 
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4.7.5 Connecting PROFIBUS DP (interfaces X126 and X136) 
PROFIBUS cables are connected to the corresponding interface by means of a bus 
connector.  

Connecting the bus connector 
Proceed as follows to connect the bus connector:  
1. Plug the bus connector into the corresponding interface of the control unit. 
2. Screw the bus connector into place. 

If the control unit is located at the start or end of a segment, you must switch on the 
terminating resistor ("ON" switch setting). 

 
Figure 4-7 Terminating resistor switched on and off 

 

 
 

Note 
Make sure that the nodes at which the terminating resistor is located are always supplied 
with voltage during startup and operation. 

 

Removing the bus connector 
You can remove the bus connector with a looped-through bus cable from the PROFIBUS DP 
interface at any time without interrupting data traffic on the bus.  

 

WARNING  
Data traffic error might occur on the bus! 
A bus segment must always be terminated at both ends with the terminating resistor. This 
is not the case, for example, if the last node with a bus connector is de-energized. The bus 
connector draws its power from the node, and the terminating resistor is thus disabled. 
Make sure that power is always supplied to nodes on which the terminating resistor is 
active. 
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4.7.6 Connection rules in the PROFIBUS subnet 

Introduction 
There are a number of rules for configuring and installing cables for PROFIBUS networks to 
ensure seamless communication over PROFIBUS. These rules apply to both configuring and 
cabling as well as address assignment for the different network nodes. 

Connection rules 
● Before you interconnect individual nodes in a subnet, you must assign a unique 

PROFIBUS address to each node.  
● Narrow down the number of nodes by limiting the PROFIBUS addresses to the highest 

address in the network. 
Tip: Mark the address on the housing of all nodes in a subnet. You can then always see 
which address is assigned to which node in your plant.  

● Connect all nodes in a subnet "in a series". No spur lines may be routed to the 
PROFIBUS DP. 
In addition, integrate the programming devices and SIMATIC HMI devices for 
commissioning or servicing in the subnet in series. 

● If you are operating more than 32 nodes in one subnet, you must use RS 485 repeaters 
to connect the bus segments (see also the description of the RS 485 repeater in the S7-
300 Automation System, Module Data Manual). 
In a PROFIBUS subnet, all bus segments combined must have at least one DP master 
and one DP slave. 

● Use RS 485 repeaters to connect ungrounded bus segments and grounded bus 
segments. 

● The maximum number of nodes per bus segment decreases with each RS 485 repeater. 
That is, if a bus segment contains one RS 485 repeater, the bus segment can contain no 
more than 31 additional nodes. However, the number of RS 485 repeaters does not affect 
the maximum number of nodes on the bus. 

● Up to 10 segments can be connected in a row (max. 9 repeaters). 
● At least one termination must be supplied with 5 V. 

To accomplish this, the PROFIBUS DP connector with an activated terminating resistor 
must be connected to a device that is switched on. 

● Before inserting a new node on the subnet, you must switch off its supply voltage. 
The station must be inserted first and then switched on. 
When a station is disconnected, the connection must first be deactivated and then the 
connector withdrawn. 

● The bus line of a segment must be terminated at both ends. This is achieved by switching 
on the terminating resistor in the PROFIBUS DP connector at the first and last node and 
switching off the other terminating resistors. 
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Example 
This illustration below shows an example configuration of a subnet with D435. 

A

S A/SS

S A/M M

 
Figure 4-8 Networking example for a D435 
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4.7.7 Operating the X136 interface as MPI 

Applications 
The X136 interface can also be operated as an MPI interface instead of a PROFIBUS DP 
interface. The typical (default) baud rate is 187.5 kBaud. A baud rate of up to 12 MBaud can 
be set for communication with other CPUs. It should be noted, however, that a rate of 12 
MBaud is not supported by all CPUs (e.g. smaller SIMATIC S7 CPUs). 
The following list provides examples of when using MPI (Multi Point Interface) may prove 
effective: 
● If a PC/PG is being used with an MPI interface 
● If an OP/TP only has an MPI interface 

(newer devices have PROFIBUS or PROFINET interfaces) 
● If SIMOTION and SIMATIC CPUs are coupled via XSEND/XRECEIVE 
When communicating with XSEND/XRECEIVE, there is no need to configure the connection 
in NetPro. XSEND/XRECEIVE can be used via PROFIBUS or MPI. 
● Via PROFIBUS: For communication between SIMOTION devices 
● Via MPI: For communication between SIMOTION and SIMATIC S7 devices 

The SIMOTION interface must be connected to the MPI interface of the SIMATIC S7 
devices. Connection via PROFIBUS is not possible. 
The baud rate of the SIMATIC S7 device must be set at the SIMOTION interface (see 
documentation for the relevant SIMATIC S7 devices). 

Operate MPI like PROFIBUS 
The information on wiring the connector (terminating resistors) and the rules for routing of 
cables for PROFIBUS apply to this interface as well. When carrying out this procedure, 
consult the relevant references. 

Connector features 
The bus connector is used to connect the MPI bus cable to the MPI interface (X136). This 
enables you to establish connections to additional nodes (e.g. PG or SIMATIC S7-CPU). 
Only bus connectors with a 35° cable outlet should be used in order to ensure that the front 
cover can be closed.  

Additional information 
See SIMOTION D4x5 Manual, Chapter "Spare parts and accessories" 

MPI bus cable 
The PROFIBUS cable specifications apply here as well;  
Please note the relevant information on setting up an MPI network. 
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Setting up an MPI network 
Keep in mind the following basic rules when setting up an MPI network:  
● When using the interface as an MPI interface, it is not possible to arrange additional 

control for a drive in isochronous mode or to connect distributed I/Os to this interface. 
● An MPI bus line must be terminated at both ends. This is achieved by activating the 

terminating resistor in the MPI connector in the first and last station and deactivating the 
other terminating resistors. 

● At least one terminator must be supplied with 5 V. 
This means that an MPI connector with an activated terminating resistor must be 
connected to a device that is switched on. 

● Spur lines (cables leading from the bus segment to the station) should be as short as 
possible, that is, < 5 m in length. Unused spur lines should be removed wherever 
possible. 

● Every MPI station must be connected to the bus first and then activated. 
To disconnect the station, it must first be deactivated. Then, the station can be removed 
from the bus. 

● Maximum cable lengths: 
– 200 m per bus segment 
– 2000 m total length with RS 485 repeaters 

 
 

 Note 
You can also use intelligent DP slave functionality for PROFIBUS communication between 
CPUs. 

 

See also 
PROFIBUS cables and connectors (Page 56) 
PROFIBUS cable lengths (Page 56) 
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4.8 Connecting PROFINET IO components 

4.8.1 Wiring PROFINET 

Procedure 
PROFINET IO is possible on the SIMOTION D4x5 only in connection with the CBE30 option 
board. PROFINET IO components can then be connected via the four ports of the X1400 
interfaces of the CBE30. You must use suitable PROFINET cables and connectors for this 
purpose.  
The autocrossing functionality of the CBE30 means both crossed and uncrossed cables can 
be used. 

 
Figure 4-9 CBE30 connections 

Mixed operation of IRT and RT 
For mixed operation of IRT and RT, note that the IRT-compatible devices must form a so-
called IRT domain, i.e., there must not be any non-IRT devices on the data transmission link 
between the IRT devices. 
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4.8.2 PROFINET cables 

Cable and connector types 
 

 Note 
For connecting PROFINET IO to CBE30 it is recommended using a connector with a 145° 
cable outlet (IE FC RJ45 plug 145). 

 

 
Figure 4-10 RJ45 PN connector with a 145°cable outlet 

 

Table 4- 8 Connector types for PROFINET 

Connectors Name Order No. 
IE FC RJ-45 Plug 145 RJ45 FastConnect connector for 

Industrial Ethernet/PROFINET with 145° 
cable outlet 
• 1 package = 1 unit 
• 1 package = 10 units 

 
 
 
6GK1 901-1BB30-0AA0 
6GK1 901-1BB30-0AB0 

 

Table 4- 9 Cable types for PROFINET 

Cable Name Order No. 
IE FC Cable GP 2 (Type A) 4-wire, shielded TP installation cable for 

IE FC RJ45 
6XV1 840-2AH10 

IE FC Flexible Cable GP 2 
(Type A) 

4-wire, shielded flexible TP installation 
cable for IE FC RJ45 

6XV1 870-2B 

IE FC Trailing Cable GP 2x2 
(Type C) 

4-wire TP installation cable for ground 
cable use  

6XV1 870-2D 

IE FC Trailing Cable 2x2  
(Type C) 

4-wire shielded TP installation cable for 
connection to FC OUTLET RJ 45, for 
ground cable use  

6XV1 840-3AH10 

IE FC Marine Cable 2x2 4-wire shielded marine-certified TP 
installation cable for connection to FC 
OUTLET RJ45 

6XV1 840-4AH10 
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Table 4- 10 Stripping tool for Industrial Ethernet/PROFINET 

Tools Designation Order No. 
IE FC stripping tool Stripping tool for Industrial 

Ethernet/PROFINET 
6GK1 901-1GA00 

 

 Note 
For a description of how to connect the connector to the cable, please refer to the 
information on the respective connector in the Industrial Communication Catalog (IK PI 
Catalog). You can also order cables and connectors there. 

 

4.8.3 Routing of SIMOTION D and CBE30 

Routing between the different interfaces 
The two standard Ethernet interfaces X120 and X130 each form a separate subnet, all ports 
on CBE30 also form a joint subnet. 
● Routing from subnet to subnet (IP routing) is not supported. You can use an external IP 

router for this. 
● Routing from a PROFINET/Ethernet subnet to a PROFIBUS is possible. 
There are two options for connecting a PG/PC or HMI to a SIMOTION D with CBE30. 

Engineering system / HMI to PROFINET (CBE30) 

 
Figure 4-11 PG/PC to CBE30 

● STEP 7 routing to the PROFIBUS interfaces 
● No STEP 7 routing to the standard Ethernet interfaces (X120, X130) 
● Access to the components on the same subnet (CBE30) via the switch functionality 
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Engineering system / HMI to PROFIBUS 

 
Figure 4-12 PG/PC to PROFIBUS 

● STEP 7 routing to the other PROFIBUS interfaces 
● STEP 7 routing to X1400 on the CBE30 
● No STEP 7 routing to the standard Ethernet interfaces (X120, X130) 

Engineering system / HMI to Ethernet 

 
Figure 4-13 PG/PC to Ethernet X120, X130 

● STEP 7 routing to the other PROFIBUS interfaces 
● No STEP 7 routing to X1400 on the CBE30 
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Commissioning (hardware) 5
5.1 Requirements for commissioning 

Prerequisites 
The following requirements must be satisfied for the initial commissioning of the SIMOTION 
D4x5 and the SINAMICS S120 modules required for operation (SINAMICS S120 Line 
Modules and SINAMICS S120 Motor Modules): 
● Your system with SIMOTION D4x5 has been installed and wired. 
● Your PG/PC has been connected to the SIMOTION D4x5 via a PROFIBUS or Ethernet 

interface or via PROFINET (CBE30). 

Commissioning steps 
Commissioning the hardware involves the following steps: 
1. Inserting the CF card 
2. Checking the system 
3. Switching on the power supply 

Additional references 
For information on installing/mounting and commissioning the SINAMICS S120 components, 
refer to the SINAMICS S120 Commissioning Manual. 

See also 
Inserting the CompactFlash card (Page 68) 
Switching on the power supply (Page 69) 
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5.2 Inserting the CompactFlash card 

Properties of the CF card 
The CF card is mandatory for operation of the SIMOTION D4x5. The SIMOTION Kernel and 
the software used to control the drives (SINAMICS firmware) are contained on the CF card.  
In order to load the SIMOTION kernel, the CF card must be inserted when the SIMOTION 
D4x5 is powered up. 

 

CAUTION  
The CompactFlash card may only be inserted or removed when the SIMOTION D4x5 
control unit is disconnected from the power supply. 

 

Procedure 
To insert the CF card, carry out the following steps:  
1. The direction of insertion of the CF card is indicated by an arrow located on both the plug-

in slot and the CF card. Align the CF card with the arrows. 
2. Gently insert the CF card into the empty plug-in slot of the SIMOTION D4x5 until it clicks 

into place. 
If correctly inserted, the CF card is flush with the housing.  
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Figure 5-1 Inserting the CF card 

See also 
Changing the CompactFlash Card (Page 239) 

5.3 Switching on the power supply 

Checking the system 
Check the final installed and wired system one more time before it is switched on, keeping in 
mind the safety points in the following check list: 
● Have you observed all ESD measures when handling the components? 
● Are all screws tightened with their specified torque? 
● Are all connectors properly inserted and locked/screwed? 
● Are all components grounded and all shields applied? 
● Have you taken the load capacity of the central power supply into consideration? 
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DANGER  
 

SIMOTION D445 must not be operated without a fan/battery module. The SIMOTION 
D445 will not power up without a fan/battery module. 

 

Switching on the external power supply 
Power is supplied to the SIMOTION D4x5 via an external power supply unit, e.g. SITOP.  
Switch on this power supply. 

 

CAUTION  
It is essential to ensure that the external 24 VDC power supply to the D4x5 is not 
interrupted for longer than 3 ms. After the expiration of these 3 ms, the SIMOTION D4x5 
powers down and can be recommissioned with OFF/ON only. 
For additional information, refer to the section titled Properties of the user memory 
(Page 73). 

 

Power-up of control unit 
Once the power supply has been switched on, the SIMOTION D4x5 begins to power up: 
1. At the start of the power-up, all LEDs are briefly illuminated. The LEDs on the SIMOTION 

D4x5 enable you to track the progress of the power-up. Any errors are displayed. 
2. Power-up of the SIMOTION Kernel 
3. All DRIVE-CLiQ connections (e.g. with the SINAMICS S120 Active Line Module) are also 

detected automatically. 
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Note 
As long as the RDY LED continues to flicker, power up is not complete and it is not 
possible to go online. 
Depending on the firmware used, the components are automatically upgraded during 
commissioning. This can take several minutes. Please note the relevant information in 
the alarm window of SIMOTION SCOUT. 
SIMOTION D4x5/CX32: 
When the RDY LED flashes yellow at a slow rate (0.5 Hz), this indicates that a 
D4x5/CX32 firmware update is in progress. 
When the RDY LED flashes yellow at a rapid rate (2 Hz), this indicates that the firmware 
update is complete and the components for initializing OFF/ON have to be connected. 
DRIVE-CLiQ components (Motor Modules, Terminal Modules, etc.): 
When the RDY LED flashes red-green at a slow rate (0.5 Hz), this indicates that a 
firmware update of the DRIVE-CLiQ components is in progress.  
When the RDY LED flashes red-green at a rapid rate (2 Hz), this indicates that the 
firmware update is complete and the components for initializing have to be switched 
OFF/ON. 
CBE30 Option Board: 
During the firmware update, the OPT LED of the SIMOTION D module and the SYNC 
LED of the CBE30 flash green. 

 

4. The first time it is energized, the SIMOTION D4x5 goes to STOP mode following power-
up. 

Following power-up, the SIMOTION D4x5 is in a state in which it can be configured. 

Fan/battery module not mounted or mounted improperly on a SIMOTION D445 
While the SIMOTION D445 is powering up, a test is performed to check whether the 
fan/battery module is functioning properly. If a fan/battery module is not mounted or is 
mounted improperly, the kernel is not downloaded and the RDY LED flashes red/yellow (2 
Hz). Switch off the power supply and correct the fault before switching on the power supply 
again. 

 

DANGER  
If the SIMOTION D445 is operated for longer than 1 minute without a fan/battery module or 
with an improperly mounted fan/battery module, the module switches off automatically. 

 

See also 
Diagnostics via LED displays (Page 243) 
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5.4 User memory concept 

5.4.1 SIMOTION D4x5 memory model 
The following figure provides an overview of the memory model of SIMOTION D4x5.  

 
Figure 5-2 SIMOTION D4x5 memory model 

 
As a result, the SIMOTION Kernel (D4x5 firmware) contains the functions needed for 
virtually all applications and corresponds in essence to a PLC with the IEC 61131-3 
command set plus system functions for controlling various components, such as inputs and 
outputs. 
The SIMOTION Kernel can be expanded by loading technology packages (TPs), e.g. for 
motion control or temperature control. 
In the following chapters, you will learn information about the user memories and the steps 
involved in certain operations. 
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5.4.2 Properties of the user memory 

Non-volatile data 
Non-volatile data make it possible to retain relevant data for the user and the system even 
when the SIMOTION D4x5 has been switched off. You will find information about the area 
that can be used for non-volatile data in the SIMOTION SCOUT Configuration Manual and in 
the SIMOTION D4x5 Technical Data Manual. 
A SIMOTION device has the following non-volatile data: 

Table 5- 1 Non-volatile data contents 

Non-volatile data Content 
Kernel data • Last operating mode 

• IP parameters (IP address, subnet mask, router address) 
• DP parameters (PROFIBUS DP addresses, baud rate) 
• Diagnostics buffer 

Retain variables • Variables in the interface or implementation section of a unit declared 
with VAR_GLOBAL RETAIN 

• Global device variables set with the "RETAIN" attribute 

Retain TO Absolute encoder offset 
DCC blocks SAV blocks and user-defined blocks with retain behavior 

 
 

 Note 
DCC SIMOTION blocks with retain behavior act like retain variables in terms of copying RAM 
to ROM, resetting memory, downloading, backing up non-volatile data 
(_savePersistentMemoryData), and backing up data. 
With DCC SINAMICS blocks, data is only backed up using SuperCap or battery rather than 
_savePersistentMemoryData. 
For additional details, please refer to the DCC Programming Programming Manual. 

 

The non-volatile data of the SIMOTION D4x5 have the following properties: 

Table 5- 2 Non-volatile data properties 

Property Meaning 
City: The non-volatile data is in the SIMOTION D SRAM. The following backup 

options are available: 
• SRAM backed up by SuperCap (maintenance-free), or 
• SRAM backed up by fan/battery module; with battery mounted 
• Non-volatile data backed up from SRAM to CF card 

(_savePersistentMemoryData) 

Backup time: • SuperCap: 5 days, minimum 
• Battery: At least 3 years 
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The integral real-time clock in the SIMOTION D4x5 is also backed up, like the SRAM. The 
same backup time applies for the integral real-time clock. 

Fan/battery module 
If the backup time is insufficient, a battery can be connected by means of an external 
fan/battery module. The backup time of a used type of battery is at least 3 years. 
A 3V lithium battery SN: 575332 battery type (with cable tail and connector) is used. The 
battery can be replaced without data loss, because the retain data is backed up internally via 
the SuperCap. 
The fan/battery module is optional for the D425/D435 and must be ordered separately. Since 
the fan/battery module is always required for the D445, it is included in the D445 scope of 
supply (see SIMOTION D4x5 Manual). 

CF card 
With the _savePersistentMemoryData system function, the user program can back up the 
contents of the non-volatile data to the CF card. This ensures that the retain variables and 
the absolute encoder position are backed up in the event that a spare part is used. 

 

 Note 
IP and DP parameters in non-volatile data 
If the CF card contains a configuration, the IP and DP parameters are loaded from the CF 
card during power-up and used by the SIMOTION device. The SIMOTION D4x5 uses the 
addresses defined in these parameters to go online. During power-up, the IP and DP 
parameters on the CF card are also written to the non-volatile data. If the SIMOTION device 
is then powered up with a CF card with no configuration, the IP and DP parameters are 
retained in the non-volatile data and are used by the device. Thus, the SIMOTION device 
can continue to go online if a configuration was loaded with SIMOTION SCOUT at least one 
time or if the SIMOTION device is powered up with a CF card containing a configuration. 
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Volatile data 
The non-volatile data are defined by the following properties:  
● The non-volatile data are located in the RAM memory of the SIMOTION device. 
● The download data of SIMOTION SCOUT are written to this memory. 
● These data are lost with the SIMOTION D4x5 is switched off. 
● The "volatile data" area contains the following data: 

– SIMOTION Kernel (D4x5 firmware) 
– Technology packages (TP) 
– User data (programs, configuration data, parameter settings) 

 
Figure 5-3 Configuration data and system variables in the volatile memory 

You can find additional information about memory management in SIMOTION in the 
SIMOTION Basic Functions Function Manual. 

CompactFlash card (CF card) 
The CF card contain the following data:  
● SIMOTION Kernel (D4x5 firmware) 
● Technology packages (TP) 
● User data (units, configuration data, parameter settings, task configuration) 
● IP parameters (IP address, subnet mask, router address) 
● DP parameters (PROFIBUS DP addresses, baud rate) 
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See also 
Switching on the power supply (Page 69) 

5.4.3 Operations and their effect on the user memory 
The operations marked with arrows in the figures entitled "SIMOTION D4x5 memory model" 
and "Configuration data and system variables in the volatile memory" and their effects on the 
user memory will be described below. 

SIMOTION SCOUT Download 
The Download menu command transfers the following data from the engineering system to 
the "volatile data" area: 
● User data (units, configuration data, parameter settings, task configuration) 
● Technology packages (TPs) 
In addition, the IP and DP parameters are saved to the "non-volatile data" area. The retain 
variables are set to their initial values, but this depends on the settings in SIMOTION 
SCOUT. If the SIMOTION D4x5 is switched off following the download, the volatile data are 
lost. 

Copy RAM to ROM 
The Copy RAM to ROM menu command saves the following data via the engineering 
system to the CF card: 
● Technology packages and user data (units, configuration data, parameter settings, task 

configuration) from the "volatile data" area 
● Current values can also be copied to the "volatile data" area, depending on the settings in 

SIMOTION SCOUT. Select the option "Transfer current values to RAM for RAM to ROM" 
under "Options" > "Settings" > "CPU download". The current values of the system are 
then first transferred to the RAM and then copied to the ROM from there with this setting. 

 

 
 

Note 
The "Copy RAM to ROM" menu command does not save the current values of the retain 
variables to the CF card. Use the system function "_savePersistentMemoryData" for this.
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SIMOTION D4x5 power-up 
During power-up of the SIMOTION D4x5, the SIMOTION Kernel is loaded from the CF card 
to the "volatile data" area. 
When the SIMOTION D4x5 is switched off, the contents of the "volatile data" area are lost. 
When the SIMOTION D4x5 is powered up again, the following data are loaded from the CF 
card: 
● Technology packages and user data to the "volatile data" area 
● IP and DP parameters the "non-volatile data" area 

Backing up non-volatile data 
With the _savePersistentMemoryData system function, the user program can back up the 
contents of the non-volatile data to the CF card. This ensures that the retain variables and 
the absolute encoder position are backed up in the event that a spare part is used.  
The contents are saved to the "PMEMORY.XML" backup file in the "USER/SIMOTION" 
directory. On the system side, this system function ensures that a consistent overall image of 
the non-volatile data is always available the next time the unit is powered on, even if there is 
a power failure during backup. To this end, before a new backup file is created, any existing 
backup file is renamed as "PMEMORY.BAK". If the save operation to the new backup file 
fails (e.g. because the capacity of the CF card is insufficient), this backup copy of the backup 
file is used the next time an attempt is made to restore the contents of the non-volatile data. 
If the new file is successfully created, the backup copy of the backup file is deleted. 

 

NOTICE  
If you do not save the data to the CF card, they will be lost if a spare part must be used (in 
the event of a module defect). 
If an absolute encoder overflow occurs after "_savePersistentMemoryData", the actual 
position value will no longer be correct after the non-volatile data have been restored. In 
this case, homing (absolute encoder adjustment) must be repeated. 

 

Network failure 
In the event of a power failure, the data in the SRAM of the Control Unit is backed up by an 
internal SuperCap and a fan/battery module (where applicable).  
The non-volatile data are available again the next time the unit is powered up. Thus, the 
control unit is immediately operational without data loss. 

 

 Note 
After the unit is powered off and then on again, the SIMOTION part runs in coordination with 
SINAMICS Integrated, whereby SINAMICS Integrated ends the power-up at a later point. 
The "Incoming station" alarm is triggered, and the PeripheralFaultTask is called. 
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Power-up and non-volatile data 
The table below lists the cases that can arise during power-up in connection with the volatile 
data and explains how they are handled.  

Table 5- 3 Cases: power-up with non-volatile data 

Case Initial condition Result 
1 The non-volatile data are valid. SIMOTION D4x5 powers up with the non-volatile data, 

meaning, for example, that the PROFIBUS address in 
the non-volatile data is valid. 

2 The non-volatile data are invalid, and there is no backup 
file (PMEMORY.XML) and no backup copy of the backup 
file (PMEMORY.BAK). 

SIMOTION D4x5 copies the default settings to the non-
volatile data and powers up with these data. In this 
case, for example, the default PROFIBUS address is 
used. 

3 The non-volatile data are invalid. A valid backup file 
(PMEMORY.XML) exists. 

SIMOTION D4x5 copies the backup file contents to the 
non-volatile data and powers up with these data. 

4 The non-volatile data are invalid, the backup file is invalid, 
and there is no backup copy of the backup file 
(PMEMORY.BAK). 

SIMOTION D4x5 copies the default settings to the non-
volatile data and powers up with these data, in which 
case, for example, the default PROFIBUS address is 
used. 

5 The non-volatile data are invalid; a backup file exists, but 
it is invalid; a backup copy of the backup file exists, and it 
is valid. 

SIMOTION D4x5 copies the backup file contents to the 
non-volatile data and powers up with these data. 

Non-volatile data diagnostics 
The user can determine the status of the non-volatile data and the battery using the 
diagnostic buffer, system variables, and PeripheralFaultTask.  
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Evaluating via the diagnostic buffer 
When they are issued, the following messages are entered once in the diagnostics buffer: 

Table 5- 4 Messages of the diagnostics buffer 

Entry Meaning Remedy 
Level 1 battery voltage warning 1) Battery voltage below prewarning level Replace battery in the 

fan/battery module 
Level 2 battery voltage warning 1) The battery voltage is below the warning 

level, backing up of non-volatile 
data/clock can no longer be guaranteed.

Replace battery in the 
fan/battery module 

Battery voltage for data backup in 
permissible range 

  

Non-volatile data memory voltage error The buffer voltage of the SuperCap or 
the battery was too low after Power On. 
Possible data loss in the non-volatile 
data/clock. 

Replace battery in the 
fan/battery module or charge 
SuperCap by energizing it for a 
longer period. 

Non-volatile data loaded from a file 
(Persistent Data File Loading done) 

Non-volatile data have been 
successfully restored from the backup 
file on the CF card. 

- 

Non-volatile data loaded from the backup file 
(Persistent Data Backup File Loading done) 

Non-volatile data have been 
successfully restored from the backup 
copy of the backup file on the CF card. 

- 

Error while loading non-volatile data from a 
file 
(Persistent Data File Loading Failure) 

Backup file or backup copy of backup 
file could not be loaded. 
Possible causes: 
• Backup file or backup copy of 

backup file does not exist 
• Data in backup file are invalid 

Use the 
"_savePersistentMemoryData" 
system function to generate a 
valid backup file. 

Device with battery module Fan/battery module is present. - 
Device without battery module Fan/battery module is not present. Connect fan/battery module if 

necessary. 
1) These warnings are only signaled when the fan/battery module has been inserted.  
 
Refer to the SIMOTION SCOUT Configuration Manual for information about how to read out 
the contents of the diagnostic buffer. 
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Evaluating via PeripheralFaultTask 
Battery status changes in RUN are reported to the user program by calling 
PeripheralFaultTask. Changes can be evaluated here using Taskstartinfo: 
● TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) 
● TSI#details = Detailed information on battery status, see SIMOTION SCOUT Basic 

Functions Function Manual. 
If there is no fan/battery module present or no battery inserted when the power is on, or in 
STOP mode, no PeripheralFaultTask will be triggered when powering up or in RUN 
(application case: D4x5 should generally be operated without a fan/battery module or 
battery). 

References 
Detailed information on setting up Taskstartinfo(#TSI) can be found in the SIMOTION Basic 
Functions Function Manual. 

Evaluating via system variables 
The system variables in the "device.persistentDataPowerMonitoring" structure indicate the 
status of the non-volatile data and the battery. 

Table 5- 5 Status of non-volatile data and battery 

system variables Designation Status Updating 
powerFailure Buffer voltage 

(SuperCap or battery) 
too low, possible loss of 
data 

NO (91) 
YES (173) 

"YES" was set at too 
low a buffer voltage 
when powering up; 
status needs to be 
reset to "NO" via the 
application. 

persistentDataState Reading the persistent 
data 

See Table 5.6, "Status 
of non-volatile data 
after powering up" 

During power-up 

warningBatteryVoltage 
Level1 1) 

Battery voltage below 
the prewarning level 

NO (91) 
YES (173) 

During a status change, 
remains set if Level 2 is 
reached 

warningBatteryVoltage 
Level2 1) 

Battery voltage below 
the warning level 

NO (91) 
YES (173) 

During a status change 

1) Both battery warning levels are set under the following conditions: 
- Fan/battery module is present and battery inserted, battery voltage is below the warning 
level 
- Fan/battery module is present, no battery is inserted (V4.1 SP2 and higher) 
- No fan/battery module is present (V4.1 SP2 and higher) 
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While the control is being powered up, it is possible to query the two system variables 
warningBatteryVoltageLevel1 and warningBatteryVoltageLevel2 regarding whether a battery 
is actually present. 

Table 5- 6 Status of non-volatile data after powering up (persistentDataState system variable) 

Status Meaning 
FROM_RAM (1) Non-volatile data in the SIMOTION device are used 
FROM_FILE (2) Non-volatile data are restored from the backup file 
FROM_BACKUP (3) Non-volatile data are restored from the backup copy of the backup file 
INVALID (4) Data in the non-volatile data and in the backup file/backup copy of backup 

file are invalid or non-existent/deleted. 
The SIMOTION device copied the default settings to the non-volatile data 
and used these data to power up. 

5.5 Fan 

5.5.1 Cooling the SIMOTION D4x5 

Overview 
If natural convection proves inadequate in terms of dissipating heat away from the module, 
and the supply air temperature exceeds the permissible limits as a result, in the case of 
SIMOTION D425/D435 an external fan/battery module must be mounted on the underside of 
the module. The fan/battery module is always required for SIMOTION D445. 

Table 5- 7 Fan/battery module for SIMOTION D4x5 

Property SIMOTION D425 SIMOTION D435 SIMOTION D445 
D435 with order no. 
6AU1435-0AA00-0AA1: 
Optional 

Fan/battery module Optional 

D435 with order no. 
6AU1435-0AA00-0AA0: 
required for supply air 
temperatures of 43° C 
or above 

Always required 

Max. permissible supply 
air temperature 

55° C 55° C 55° C 

Fan control Switches on at supply 
air temperatures of 
approx. 43° C or above 

Switches on at supply 
air temperatures of 
approx. 43° C or above 

Fan is always on 
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Fan faults 
Fan faults are indicated as follows: 
● Entry in diagnostic buffer 
● During fan faults the SF LED flashes red/yellow at 2 Hz (SIMOTION D445 only). 
● Indicated via system variable 
● Calling the PeripheralFaultTask 
The variable device.CpuDataRW.fanwarning indicates whether the current fan speed has 
fallen below a minimum value. 
Possible states are (Enum): 
● NO (91): Fan speed in permitted range (or operation without fan) 
● YES (173): Warning; fan speed is too low or fan/battery module has been unplugged 
The value must be reset to NO by the application. D425/D435 can also be operated without 
a fan/battery module. If no fan/battery module is connected, "NO" is output at Power On. 
Fan faults in RUN are reported to the user program by calling PeripheralFaultTask. Changes 
can be evaluated here using Taskstartinfo: 
● TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205) 
● TSI#details = Detailed information on fan/temperature, see SIMOTION SCOUT Basic 

Functions Function Manual. 
If there is no fan/battery module present when the power is on, or in STOP mode, no 
PeripheralFaultTask will be triggered when powering up or in RUN (application case: D4x5 
should generally be operated without a fan/battery module). 

 

DANGER  
SIMOTION D445 must not be operated without a fan/battery module. The SIMOTION D445 
will not power up without a fan/battery module. 

 

DANGER  
If the SIMOTION D445 is operated for longer than 1 minute without a fan/battery module or 
with an improperly mounted fan/battery module, the module switches off automatically. 

 

References 
Detailed information on setting up Taskstartinfo (#TSI) can be found in the SIMOTION Basic 
Functions Function Manual. 
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Parameter assignment / addressing 6
6.1 Software requirements 

SIMOTION SCOUT Engineering System 
To commission the SIMOTION D4x5, the SIMOTION SCOUT Engineering System must be 
installed on your PG/PC. Please read the information on the current DVD for "SIMOTION 
SCOUT." 
For instructions on how to install SIMOTION SCOUT on your PG/PC, see: 
● SIMOTION SCOUT Configuration Manual 
● SIMOTION SCOUT Online Help 

6.2 Creating a project and configuring communication 

6.2.1 Creating a SIMOTION project and inserting a D4x5 

Procedure 
1. Select the Project > New... menu command.  
2. In the "New Project" dialog box, assign a name and confirm with "OK." 

A new folder with the name of the project will be created in the project navigator. 
3. In the project navigator, double click "Insert New Device." The "Create New Topic” dialog 

box is opened. 

 
Figure 6-1 Create new device 
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4. In the "Create new device" dialog box, select, for example, SIMOTION D445 V4.1 and the 
version: in this case, SINAMICS Integrated V2.5. 

 

 
 

Note 
If there are hardware types with different order numbers or versions of one device 
available, you can select these under "Variant." 

 

5. Select the "Open HW Config" option and confirm the "Create New Device" dialog with 
"OK." 

Device variants 
PROFINET V2.1 and V2.2 (as of SCOUT V4.1 SP2) 
Up to Version 4.0, SIMOTION D4x5 supports PROFINET with IRT in accordance with 
PROFINET standard IEC61158 V2.1. With V4.1, IRT can also be operated with the new 
PROFINET standard IEC61158 V2.2. 
Therefore, with Version 4.1, the following variants are available for the SIMOTION D4x5 
modules: 
● "D4x5 PN V2.1, SINAMICS ...": IRT in accordance with PROFINET standard IEC61158 

V2.1 
● "D4x5 PN V2.2, SINAMICS ...": IRT in accordance with PROFINET standard IEC61158 

V2.2 
● "D4x5 DP, SINAMICS ...": For PROFIBUS users 
 
You can always operate a D4x5 with PROFIBUS and/or PROFINET irrespective of the 
selection. The selection option "D4x5 DP, SINAMICS ..." corresponds to the selection "D4x5 
PN V2.1, SINAMICS ...." and serves only as a simplified selection option for the PROFIBUS 
user. 
Please note that separate SIMOTION D firmware is available for PN V2.1 and PN V2.2. CF 
cards up to and including V4.1 SP2 contian the PN V2.1 version as delivered. If PN V2.2 is 
to be used, the firmware must be upgraded on the CF card. The required firmware can be 
found on the SCOUT DVD. You also requrie at least STEP7 Version 5.4 SP4 for PN V2.2. 
Mixed operation of PN V2.1 and PN V2.2 synchronization processes is not possible.  
SINAMICS S120/SM150 
The following additional variants are available for SIMOTION D445 modules: 
● SINAMICS S120 Integrated 
● SINAMICS SM150 Integrated for applications with medium-voltage converters 

Additional references 
For further information on IRT in accordance with PROFINET standard IEC61158 V2.1 and 
V2.2, refer to the SIMOTION Communication System Manual. 



 Parameter assignment / addressing 
 6.2 Creating a project and configuring communication 

D4x5 
Commissioning and Hardware Installation Manual, 08/2008 Edition 85 

Result 
You can now configure the PG/PC interface.  

See also 
Configuring the PROFIBUS PG/PC interface (Page 85) 
Configuring the Ethernet PG/PC interface (Page 87) 

6.2.2 Configuring the PROFIBUS PG/PC interface 

Prerequisites 
The following requirements must be satisfied in order to configure the PG/PC interface: 
● You have connected your PG/PC using a PROFIBUS interface. 
● SIMOTION SCOUT has been installed on the PG/PC and powered up. 
● You have created a project. 
A PROFIBUS subnet with factory settings (1.5 Mbit/s/s transmission rate) is created 
automatically.  

Procedure 
1. In the "Select Interface - D4x5" dialog. select "PROFIBUS DP2/MPI." 

 
Figure 6-2 Selecting a PROFIBUS interface 
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Note 
The "Select Interface - D4x5" dialog is only displayed if an interface has not yet been 
configured. 

 

2. Confirm with "OK". 
The dialog is closed, the SIMOTION D4x5 is created in the project navigator, and HW Config 
is automatically started. 
You now have access to the internal SINAMICS Integrated drive and can configure and 
commission this drive. 

Inserting additional SIMOTION D4x5 
If you insert another SIMOTION D4x5 using "Create New Device", the PG/PC interface 
selection dialog is no longer displayed. The SIMOTION D4x5 is not connected to the 
PROFIBUS network of the PG. 
You must connect the new SIMOTION D4x5 to the PG/PC manually using HW Config or 
NetPro. 

See also 
Establishing a PG/PC assignment (Page 97) 
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6.2.3 Configuring the Ethernet PG/PC interface 

Requirement 
The following requirements must be satisfied in order to configure the PG/PC interface: 
● You have connected your PG/PC using an Ethernet interface. 
● SIMOTION SCOUT has been installed on the PG/PC and powered up. 
● You have created a project. 

Procedure 
1. In the "Select Interface - D4x5 dialog", select "Ethernet IE2/NET (X130)".  

 
Figure 6-3 Configuring an Ethernet Interface 

 
 

 
 

Note 
The "Select Interface - D4x5" dialog is only displayed if an interface has not yet been 
configured. 

 

2. Select the interface parameter assignment that you would like to use to go online, and 
confirm with "OK". 

Your PG/PC is now connected to the SIMOTION D4x5 the Ethernet. You can configure and 
parameterize your system.  

 

 Note 
If you want to change the default settings for IP addresses and the transmission rate, you 
must configure the Ethernet interfaces in HW Config and NetPro. 
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Inserting additional SIMOTION D4x5 
If you insert another SIMOTION D4x5 using "Create New Device", the PG/PC interface 
selection dialog is no longer displayed. The second SIMOTION D4x5 is automatically 
connected to the PG/PC via Ethernet, and a new unique IP address (last digit + 1, up to 255) 
is calculated.  

See also 
Establishing a PG/PC assignment (Page 97) 

6.2.4 Representation of SIMOTION D4x5 in HW Config 
Once you have created a project and inserted a SIMOTION D4x5 as a module, HW Config 
opens automatically. 
In HW Config, the SIMOTION D4x5 is represented with the SINAMICS Integrated and the 
interfaces. 

 
Figure 6-4 Representation of SIMOTION D4x5 in HW Config 
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6.3 Configuring PROFIBUS DP 

6.3.1 General information about communication via PROFIBUS DP 

Definition of PROFIBUS DP 
PROFIBUS DP is an international, open field bus standard specified in the European field 
bus Standard EN 50170 Part 2. PROFIBUS DP is optimized for fast, time-critical data 
transmissions at the field level.  
Components communicating by means of PROFIBUS DP are classified as master or slave 
components. 
● Master (active bus device) 

Components that represent a master on the bus define data transfer along the bus, and 
are therefore known as active bus nodes. 
Masters components are divided into two classes: 
– DP master class 1 (DPMC1): 

Central master devices are thus designated, which exchange information with the 
slaves in specified message cycles. 
Examples: SIMOTION D435, C230-2, P350, SIMATIC S7, etc. 

– DP master class 2 (DPMC2): 
These are devices for configuration, commissioning, and operator control and 
monitoring while the bus is in operation. 
Examples: Programming devices, operator control/monitoring devices 

● Slaves (passive bus nodes): 
These devices may only receive, acknowledge and transfer messages to a master when 
so requested. 
Examples: SINAMICS drives, I/O modules 

Functions on PROFIBUS DP 
The functional scope can differ between DP masters and DP slaves. The functional scope is 
different for DP-V0, DP-V1 and DP-V2. 
These functions on the PROFIBUS DP are characterized by: 
● User configurable, equidistant, cyclic PROFIBUS DP cycle clock 
● Synchronization of slaves by the master by means of a global control message frame in 

each cycle clock 
● Independent maintenance of the isochronous cycle clock by the slaves in the event of a 

short-term communication failure 
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Additional references 
You will find additional information about PROFIBUS DP in the SIMOTION Communication 
System Manual. 

See also 
Connection rules in the PROFIBUS subnet (Page 59) 

6.3.2 Operating SIMOTION D4x5 on PROFIBUS DP. 

PROFIBUS DP interface (X126, X136)  
SIMOTION D4x5 provides two interfaces for connection on the PROFIBUS DP. 
Transmission rates up to 12 Mbit/s are possible. Both interfaces can be operated 
isochronously.  
The X136 interface can also be used as an MPI interface. 
As supplied, both PROFIBUS DP interfaces are preset as a master with address 2 and a 
transmission rate of 1.5 Mbit/s. The PROFIBUS DP network is automatically created for this 
setting. 
However, other settings can also be configured. This requires that you configure the network 
manually using HW Config and NetPro. 

 

 Note 
Communication with the SINAMICS Integrated of a D4x5 or CX32 is always equidistant. 
Here, SIMOTION D4x5 is the master and the SINAMICS Integrated drives are slaves. 

 

Master-slave configuration 
The master/slave configuration can be used, for example, to establish hierarchical 
PROFIBUS networks that can be used to implement a modular machine concept. 

Table 6- 1 Master-slave configuration 

X126 X136 Note Actions in the application
DP slave, 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136), application 
controls synchronization to DP slave (X126) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-136 = cycle clock DP Integrated 

DP master/DP slave 
synchronization 
mechanisms 

DP master, 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP master (X126), application 
controls synchronization to DP slave (X136) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-126 = cycle clock DP Integrated 

DP master/DP slave 
synchronization 
mechanisms 
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X126 X136 Note Actions in the application
DP slave, 
isochronous 

DP master, not 
isochronous 

Application synchronized to DP slave (X126) 
(can be monitored by the application) 
Internal drive is synchronous with X126 

DP slave 
synchronization 
mechanisms 

DP master, not 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP slave (X136)  
(can be monitored by the application)  
Internal drive is synchronous with X136 

DP slave 
synchronization 
mechanisms 

DP master, 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X126, X136) 
Internal drive is synchronous with external cycle clock 
Cycle clock DP-126 = cycle clock DP-136 = cycle clock 
DP Integrated  

None 

DP master, 
isochronous 

DP master, not 
isochronous 

Application synchronized to DP master (X126) 
Internal drive is synchronous with X126 
Cycle clock DP-126 = cycle clock DP Integrated 

None 

DP master, 
isochronous 

DP slave, not 
isochronous 

Application synchronized to DP master (X126) 
Internal drive is synchronous with X126 
Cycle clock DP-126 = cycle clock DP Integrated 

None 

DP master, not 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136) 
Internal drive is synchronous with X136 
Cycle clock DP-136 = cycle clock DP Integrated 

None 

DP slave, not 
isochronous 

DP master, 
isochronous 

Application synchronized to DP master (X136) 
Internal drive is synchronous with X136 
Cycle clock DP-136 = cycle clock DP Integrated 

None 

DP master, not 
isochronous 

DP master, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP slave, not 
isochronous 

DP master, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP master, not 
isochronous 

DP slave, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP slave, not 
isochronous 

DP slave, not 
isochronous 

Application synchronized to internal drive cycle clock None 

DP slave, 
isochronous 

DP slave, not 
isochronous 

Application synchronized to DP slave (X126) (can be 
monitored by the application) 
Internal drive is synchronous with X126 

DP slave 
synchronization 
mechanisms 

DP slave, not 
isochronous 

DP slave, 
isochronous 

Application synchronized to DP slave (X136)  
(can be monitored by the application)  
Internal drive is synchronous with X136 

DP slave 
synchronization 
mechanisms 

For information about actions in the application, refer to the SIMOTION Basic Functions for 
Modular Machines description of functions. 
Alternatively, the X136 interface can be used as an MPI interface with a transmission rate of 
19.2 kbit/s up to 12 Mbit/s.  
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6.3.3 Assignment of the PROFIBUS addresses in HW Config 

Assigning PROFIBUS addresses 
In order for all devices to communicate with each other, you must assign a PROFIBUS 
address to each device before connecting them:  

 

 Note 
Before you assign any PROFIBUS addresses, please remember that all addresses must be 
unique on the PROFIBUS subnet. 

 

You set these PROFIBUS addresses individually for each device with the PG/PC using HW 
Config. Some PROFIBUS DP slaves have a switch for this purpose. 

Recommendation for PROFIBUS addresses 
Reserve PROFIBUS address "0" for a service programming device and "1" for a service HMI 
device, which will be connected to the subnet if required. 
Recommendation for the PROFIBUS address of the SIMOTION D4x5 in case of 
replacement or service: 
Reserve address "2" for a SIMOTION D4x5. This prevents duplicate addresses from 
occurring when a SIMOTION D4x5 is installed in the subnet using default settings (for 
example, when replacing a SIMOTION D4x5). You should therefore assign addresses 
greater than "2" to additional units on the subnet. 

See also 
Connection rules in the PROFIBUS subnet (Page 59) 

6.3.4 Setting the DP cycle and system cycle clocks 
All cycle clocks for SIMOTION D4x5 are based on the DP cycle of SINAMICS Integrated, 
which must be set in HW Config.  
To do so, click the SINAMICS block on the integrated PROFIBUS. The "DP Slave Property" 
dialog window opens. You can adjust the DP cycle of the SINAMICS Integrated on the 
"Isochronous Mode" tab. 

Table 6- 2 Range of values for SIMOTION D4x5 

 D425 D435 D445 
DP cycle ≥ 1 ms ≥ 1 ms ≥ 0.5 ms 
Grid 0.125 ms 0.125 ms 0.125 ms 
Min. IPO cycle ≥ 2 ms ≥ 1 ms ≥ 0.5 ms 
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External DP interfaces can only be operated with a system cycle clock of ≥ 1 ms.  
In addition, SINAMICS Integrated always runs isochronously. The DP cycle setting of the 
SINAMICS Integrated is displayed as the "Bus Cycle Clock" in the "System Cycle Clocks" 
dialog. In SIMOTION SCOUT, select SIMOTION D4x5 and then select the "Set System 
Cycle Clocks" option in the "Target System" > "Expert" menu item. 
The table below shows the possible ratio settings for the SIMOTION D4x5 system cycle 
clocks based on the bus cycle clock. 

Table 6- 3 Ratios of system cycle clocks 

Bus cycle clock: Servo cycle clock Servo cycle clock: IPO cycle Servo cycle clock: IPO 2 
cycle clock 

1:1 …1:4, 1:8 1:1 … 1:6 1:2 … 1:64 

 
In addition, if the DP interfaces (DP1/DP2) are configured as equidistant master interfaces, 
you must set both DP cycles equal to the bus cycle clock of the SINAMICS Integrated in HW 
Config. 
If the DP interfaces (DP1/DP2) are operated as the master, the system cycle clocks are 
obtained from an internal cycle clock of the module. Of the two DP interfaces (DP1/DP2), no 
more than one can also be operated as an isochronous slave interface. In this case, the 
system cycle clocks are obtained from the cycle clock of the slave interface.  
As a result, the task system of SIMOTION and SINAMICS Integrated runs synchronously to 
the slave cycle clock. This assumes that a slave cycle clock exists and synchronization with 
the slave cycle clock has been achieved. If this is not the case, the system cycle clocks are 
acquired from an internal replacement clock. 
When the project is downloaded, the cycle clock configuration is downloaded to the 
SIMOTION D4x5 and automatically set according to the specifications. 

See also 
Setting a send cycle clock and a system cycle clock (Page 104) 
Settings for DP slave properties (Page 153) 
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6.3.5 Cycle clock scaling of external PROFIBUS interface to internal PROFIBUS 
interface 

Definition 
Cycle clock scaling means that an external PROFIBUS interface of the SIMOTION D4x5 
(X126/X136) can be operated in an integer multiple of the internal PROFIBUS interface. This 
reduces the CPU load, thereby allowing you to operate more axes, for example. The settings 
of the scaled cycle clocks for the external DP interfaces are made in HW Config.  

Boundary conditions 
The following boundary conditions are applicable to cycle clock scaling: 
● An external DP interface of D4x5 is used as an isochronous slave interface. Only in this 

case can an integer cycle clock scaling of isochronous external DP slave interface to 
internal interface be specified. This is checked during compilation, and in the event that 
this boundary condition is not met, an error message is output. If the external DP 
interfaces are configured as equidistant interfaces but none are configured as a slave 
device, and cycle clock scaling is specified for these interfaces, an error is output during 
compilation. 

● For SERVO, IPO, and IPO2, settings can also be made for all permissible cycle clocks. 
Master and slave axes can run in different IPO levels. Different cycle clocks and phase 
offsets are tolerated by the system. 

 

 
 

Note 
The IPO cycle clock of the IPO in which the Synchronous Operation technology object 
runs must be set equal to the cycle clock of the equidistant external DP slave interface. 

 

● The second external DP interface can be operated as an equidistant master (while the 
other is an equidistant slave) in order to operate external drives, for example. In this case, 
the cycle clock must be the same as the cycle clock of the internal PROFIBUS DP. If this 
condition is not satisfied, an error message is output during compilation. 

● One or both external DP interfaces can also be operated as non-isochronous, free-
running interfaces. In this case, there is no effect on the cycle clock settings. 

Example of an application 
The system consists of a synchronous master (DP master) and at least one SIMOTION 
D4x5 synchronous slave (DP slave). The synchronous master contains the master axis; the 
synchronous slave contains the following axes: 
● The axes in SINAMICS Integrated of the D4x5 synchronous slave must exhibit high 

performance with a servo cycle clock of 1 ms and an internal DP cycle of 1 ms. This 
requires that the internal fast PROFIBUS DP be decoupled from the slower external 
PROFIBUS DP. 

● The PROFIBUS DP has, for example, a cycle time of 4 ms due to the quantity framework 
on the bus; in all cases, its cycle time exceeds that of the cycle clock of the internal DP 
interface. 

● The master setpoints are transmitted via the DP bus. Further nodes can also be 
connected to the DP bus, e.g. DP drives, distributed I/Os, etc. 
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Figure 6-5 Example application for a cycle clock scaling 

6.3.6 Creating a new PROFIBUS subnet 

Introduction 
SIMOTION SCOUT is used to network the SIMOTION D4x5. During the configuration 
process, the desired bus parameters can be set for the PROFIBUS DP interfaces. 

 

 Note 
If a hardware configuration is loaded without a PROFIBUS network (DP1 or DP2) being 
configured on the CPU, a new PROFIBUS address that was previously set in HW Config or 
NETPRO will not be accepted by the CPU. 

 

Requirement 
You have created a project and have already inserted a SIMOTION D4x5. 
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Procedure 
To create a new subnet, proceed as follows:  
1. In the project navigator, double-click D4x5 to access HW Config. 
2. In the SIMOTION D4x5 representation, double-click the interface for which you want to 

create a PROFIBUS subnet. 
The "DPx Properties" dialog box is opened. 

3. Click "Properties" to show the "PROFIBUS Interface DPx" dialog box. 
4. Click "New" to call the "Properties - New PROFIBUS Subnet" dialog. 
5. Name the new subnet and enter the properties of the new subnet, such as transmission 

rate, on the "Network Settings" tab. 
6. Confirm with "OK" to accept the settings. 

The new subnet is now displayed in the "Properties - PROFIBUS Interface DPx" dialog. 
You can now connect the new subnet to the corresponding PROFIBUS interface. 

Follow the same steps to configure the second PROFIBUS interface. 
A graphical representation of the PROFIBUS subnet you have created is shown in HW 
Config. 

6.3.7 Modifying the data transmission rate 

Introduction 
You can modify the transmission rate in a PROFIBUS subnet in HW Config according to 
your requirements.  

Procedure 
1. Open the project in SIMOTION SCOUT. 
2. Double-click the device whose PROFIBUS subnet you want to configure. 

HW Config is displayed showing the settings for this device. 
3. In HW Config, double-click in the graphical display on the PROFIBUS network whose 

transmission rate you want to configure. 
The "Properties - DP Master System" dialog is displayed. 

4. Click on "Properties" to display the "PROFIBUS Properties" dialog. 
5. Select the required transmission rate on the "Network Settings" tab. 

If you wish to activate an equidistant bus cycle, the setting can be made under "Options". 
6. Confirm with "OK". 
7. Save and compile the new hardware configuration, and load it on the SIMOTION D. 
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Note 
If you modify the transmission rate of the subnet over which you are operating the 
PG/PC, the PG/PC loses its active designation. You must then reconfigure it manually in 
NetPro or else you will no longer be able to go online by means of this PG/PC. 

 

 
 

Note 
PROFIBUS DP functionality is both equidistant and isochronous in nature. As such, it can 
guarantee that bus cycles will have exactly the same length and ensures deterministic 
behavior.  
Applications: Connecting drives or synchronized I/O devices. 

 

See also 
Function Manual SIMOTION SCOUT Basic Functions, Chapter Isochronous I/O processing 
on fieldbus systems 

6.3.8 Establishing a PG/PC assignment 

Introduction 
A PG/PC is required to create projects for a SIMOTION D4x5 and download them to the 
target device. The interface via which the PG/PC can be connected is polled during the 
automatic communication configuration. If you change these settings, you must reestablish 
the active designation of the PG/PC in NetPro.  

Procedure  
1. Open the project in SIMOTION SCOUT. 

2. Click the "Open NetPro"  button. 
NetPro is accessed, and the configured network is graphically displayed. The PG/PC 
connection to the configured network is shown in bold in a color other than yellow. 

3. Double-click the PG/PC you would like to configure. 
The "Properties - PG/PC" dialog will be displayed with the "Assignment" tab in 
foreground. 

4. Select the interface in the "Assigned" field and activate S7-ONLINE Access by clicking 
the appropriate checkbox. 

5. Click "OK" to accept the settings. 
The PG/PC connection to the configured network is displayed again in bold and yellow. 

6. Save and compile the changes and download them to the SIMOTION D4x5. 
You can now go online via the PG/PC once again. 



Parameter assignment / addressing  
6.4 Configuring an Ethernet subnet 

 D4x5 
98 Commissioning and Hardware Installation Manual, 08/2008 Edition 

6.4 Configuring an Ethernet subnet 

6.4.1 Properties of the Ethernet interfaces 

Properties 
SIMOTION D4x5 has two onboard Ethernet interfaces (X120 and X130). You can connect 
an Industrial Ethernet with a transmission rate of 10/100 Mbit/s to the 8-pin X120 and X130 
RJ45 sockets.  
There is no HUB/switch functionality, i.e. message frames are not forwarded from one 
interface to the other. The interfaces belong to separate Ethernet subnets. SIMOTION D4x5 
does not have any router functionality; it does not forward the message frames from one 
subnet to another. 
The TCP/IP timeout parameters can be set once for both interfaces. 
The transmission rate/duplex can be set individually for the two interfaces. 
The interfaces do not have autocrossing functionality. 

Ethernet communication 
SIMOTION D4x5 offers the following functions via Industrial Ethernet: 
● Communication with STEP 7, SIMOTION SCOUT, and SIMATIC NET OPC via a PG/PC 
● Communication via UDP (user datagram protocol) with other components, e.g. other 

D4x5 devices 
● Communication with other devices via TCP/IP 
● Connection of SIMATIC HMI devices such as MP27x, MP37x, or PC-based HMIs 
● IT communication (via software options SIMOTION IT DIAG, SIMOTION IT OPC XML-

DA, SIMOTION IT Virtual Machine) 

Routing 
"Utilities via TCP" are supported for both Ethernet interfaces. This enables routing from the 
Ethernet interfaces to the PROFIBUS interfaces. "Utilities via TCP" are not routed from one 
Ethernet interface to the other. 
You can find the MAC addresses on the nameplate located on the front of the SIMOTION 
D4x5. 
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Default Ethernet addresses 
The following addresses are set on the module when shipped: 
X120 (IE1/OP) 
● IP address: 192.168.214.1 
● Subnet mask: 255.255.255.0 
● Router address: 0.0.0.0 
X130 (IE2/NET) 
● IP address: 169.254.11.22 
● Subnet mask: 255.255.0.0 
● Router address: 0.0.0.0 

 

 
 

Note 
The IP addresses 192.168.241 to 255 are reserved for internal communication in 
SIMOTION D4x5. When configuring the external Ethernet interfaces (X120 and X130) it 
has to be observed that the internal addresses are not inside their network. (In IP, the 
network is defined as an AND link of IP address and subnet mask.) 

 

 
 

Note 
If you want to go online via Ethernet, you have to make sure that the connection from 
PG/PC to SIMOTION D4x5 is active. You can check this in NetPro. A description of how 
to switch a connection to active again can be found in the section entitled "Establishing 
the PG/PC Assignment" in the chapter entitled "Configuring PROFIBUS DP." 

 

Separate Ethernet interfaces 
The two Ethernet interfaces are implemented separately from one another and must be 
connected to two different networks without any connection (routing) between them. 
Consequently, SIMOTION D4x5 can be connected to the machine user's internal company 
network using one interface, while the second interface can be used, for example, for remote 
maintenance by the machine manufacturer without this third party being able to "look" in the 
machine user's network.  
The following values are preset in the "Transmission Rate/Duplex" menu. 
● Auto 
● 10/100 Mbit/s 
● Half duplex/full duplex 
The automatic setting in HW Config arranges the setting automatically. 
A shielded twisted pair cable is used for the networking in this case. For additional 
information, refer to the SIMATIC NET Industrial Twisted Pair and Fiber Optic Networks 
Manual. See the list of references for the order number (this is a separate document). 
You can obtain additional information about the different cable systems for Ethernet from 
your SIEMENS contact. 
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6.4.2 Configuring Ethernet addresses in HW Config 

Requirement 
For configuration using Industrial Ethernet, SIMOTION D4x5 must be provided with an IP 
address, the subnet mask, and the router address. 

 

 Note 
Only one router may be configured. 

 

Procedure 
To configure and transfer Ethernet addresses to the D4x5, proceed as follows:  
1. Open your project. 
2. Open HW Config. Double-click the interface to be configured to open the "Properties" 

dialog box. 
3. On the "General" tab, click the "Properties" button of the Ethernet interface. The 

"Properties - Ethernet Interface" dialog is displayed. 
4. Click the "New" button. The "New Industrial Ethernet" subnet dialog is displayed. In this 

dialog box, you can change the name of the new subnet or confirm the default setting 
with "OK". 

5. The newly created Ethernet subnet is now displayed under "Subnet" in the "Properties - 
Ethernet Interface" dialog box and must be selected. 

6. In this dialog box, enter the required addresses for "IP Address" and "Subnet". Under 
"Router", choose whether a router is to be used. If using a router, enter the router 
address. 

7. Confirm this dialog box with "OK". 
8. Close the "Properties" dialog by clicking "OK". 
9. To configure the second Ethernet interface, open the "Properties" dialog of the second 

interface and repeat Steps 3 to 7. 
10. Save and compile the modified hardware configuration. 
11. Load the new hardware configuration to the SIMOTION D4x5 via PROFIBUS 

DP/Ethernet. 
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6.4.3 Reading out IP and MAC address 

Requirement 
To read out the IP and MAC addresses, the following requirements must be met: 
● SIMOTION D4x5 is wired. 
● You have assigned the communication parameters. 
● You are online. 

Procedure 
The IP addresses and MAC addresses of SIMOTION D4x5 can be displayed as follows via 
SIMOTION SCOUT. 
1. Right-click the module. 
2. Select "Target Device" > "Device Diagnostics" in the context menu. 
The examples below show how addresses are displayed: 
X120 (IE1/OP) 
● Active MAC Address: 08-00-06-73-25-3E 
● IP address: 192.168.214.1 
● Subnet mask: 255.255.255.0 
● Standard gateway: No router used 
X130 (IE2/NET) 
● Active MAC Address: 08-00-06-73-25-3F 
● IP address: 169.254.11.22 
● Subnet mask: 255.255.0.0 
● Standard gateway: No router used 
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6.5 Configuring PROFINET IO 

6.5.1 General information about communication via PROFINET IO 

Communication cycle 
In PROFINET, the communication cycle is subdivided into different, time-specific intervals. 
The first interval is used for isochronous real-time communication (IRT), followed by real-
time communication (RT) and standard TCP/IP communication. The bandwidth reservation 
for IRT ensures that RT communication and standard communication have no effect on the 
transmission of IRT message frames, which are important for motion-control applications. 
The following figure shows how the PROFINET communication cycle is divided into 
isochronous real-time communication (IRT), real-time communication (RT), and standard 
TCP/IP communication. 

 
Figure 6-6 PROFINET communication cycle 

Isochronous realtime Ethernet 
STEP 7 V5.4 and higher can be used to configure PROFINET devices supporting data 
exchange via isochronous real-time Ethernet (IRT). IRT message frames are transmitted 
deterministically via planned communication paths in a defined sequence to achieve the best 
possible synchronism and performance.  
IRT requires special network components supporting a planned data transmission.  
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Equidistance and Cycle Clock Synchronization 
What is possible for PROFIBUS DP with isochronous bus cycles and clock synchronization, 
also functions for PROFINET IO.  
For PROFIBUS DP, in isochronous operation all nodes are synchronized using a Global 
Control Signal created by the DP master.  
In PROFINET IO with IRT, a sync master generates a signal to which sync slaves 
synchronize themselves. Sync master and sync slaves belong to a sync domain which is 
assigned a name via configuration. The role of the sync master can in principle be played by 
an IO controller as well as an IO device. A sync domain has exactly one sync master.  

Context: Sync domain and IO systems 
An important fact is that sync domains do not need to be limited to one PROFINET IO 
system: The devices of several IO systems can be synchronized by a single sync master 
provided that they are connected to the same Ethernet subnet.  
The following applies the other way around: An IO system must only belong to a single sync 
domain.  

Signal propagation delays not negligible 
For the extremely exact synchronization interval, line lengths, namely the associated delay 
times, must be taken into consideration. You can use a topology editor to enter the 
properties of the lines among the ports of the switches. STEP 7 uses these data and the 
other configuration data to calculate the optimized process of the IRT communication and 
the resulting updating time.  

Keeping the network load within certain limits 
In order to be able to limit the network load by extremely short update times, update groups 
are configured for the IRT data. If only few devices require shortest update times, they are 
assigned to the first update group. Each further updating group has an updating time that is 
n-times the previous updating time (n can be set), i.e. the data will be updated 
correspondingly less often and the network loading sinks. 
Up to and including STEP 7 V5.4 SP4, only one update group can be configured with IRT.  

IRT runs in parallel to realtime and TCP/IP communication 
Apart from IRT communication for which a defined bandwidth is reserved within the update 
time, RT communication and TCP/IP communication are also permitted within the update 
time.  
With RT communication (realtime communication), the cyclic data are transmitted between 
IO controller and IO device, though without "best possible synchronism". 
With non-synchronized IO devices, data communication is carried out automatically via RT 
communication.  
Due to the fact that TCP/IP communication is also possible, other non-realtime data, e.g. 
configuration data or diagnostic data, can be transported. 
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IRTtop and IRTflex 
IRTflex (IRT with high flexibility) has a bandwidth reservation for IRT message frames. By 
contrast, with IRTtop (IRT with high performance), IRT message frames are predefined 
implicitly when the topology is configured, and the appropriate configuration data are 
generated. This results in optimal utilization of the reserved bandwidth, enabling the smallest 
cycle times to be achieved 

PROFINET IO controller 
The PROFINET IO controller takes on the master function for I/O data communication of the 
distributed field devices. The IO controller is usually the communications interface of a 
SIMOTION module, in this case SIMOTION D4x5 with CBE30. The function is comparable to 
a PROFIBUS DP master class 1. 

PROFINET IO device 
Distributed field devices such as I/Os, drives (e.g. SINAMICS S120 with CBE20), or operator 
terminals are designated as IO devices. The function is comparable to a 
PROFIBUS DP slave. 

6.5.2 Setting a send cycle clock and a system cycle clock 

Setting the DP cycle in HW Config 
All cycle clocks for SIMOTION D4x5 are based on the DP cycle of SINAMICS Integrated, 
which must be set in HW Config.  
To do so, click the SINAMICS block on the integrated PROFIBUS. The "DP Slave Property" 
dialog window opens. You can adjust the DP cycle of the SINAMICS Integrated on the 
"Isochronous Mode" tab.  

Table 6- 4 Range of values for SIMOTION D4x5 

 D425 D435 D445 
DP cycle ≥ 1 ms ≥ 1 ms ≥ 0.5 ms (DP internal) 

≥ 1.0 ms (DP external) 
Grid 0.125 ms 0.125 ms 0.125 ms 
Min. IPO cycle ≥ 2 ms ≥ 1 ms ≥ 0.5 ms 
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Setting the send cycle clock in HW Config 
The send cycle clock for PROFINET IO must be set in the "Domain Management" dialog in 
HW Config. To do this, select the "Edit" > "PROFINET IO" > "Domain Management ..." menu 
command in HW Config. 
The configured PROFINET send cycle clock is displayed in SIMOTION SCOUT as the "Bus 
Cycle Clock" in the "System Cycle Clocks - D4x5" dialog. Select SIMOTION D4x5 and then 
select the "Set System Cycle Clocks" option in the "Target System" > "Expert" menu item. 
The PROFINET interface can be operated with a send cycle clock in the range of: 0.5 ms ≤ 
send cycle clock ≤ 4 ms. The smallest configurable grid is 0.125 ms. 

Cycle clock scaling 
When PROFINET is operated isochronously, the servo cycle clock must always correspond 
to the PROFIBUS cycle clock. The servo cycle clock and the PROFIBUS cycle clock can be 
scaled to the PROFINET cycle clock. 
Example: 
PROFINET send cycle clock = 0.5 ms 
PROFIBUS cycle clock = servo cycle clock = 1 ms 
The PROFIBUS cycle clock can operated relative to the PROFINET cycle clock at a ratio of 
1:1 to 1:16. 
The table below shows the possible ratio settings for the SIMOTION D4x5 system cycle 
clocks based on the DP cycle of SINAMICS Integrated or PROFINET send cycle clock. 

Table 6- 5 Ratios of system cycle clocks 

DP cycle/send cycle clock: Servo cycle clock Servo cycle clock: IPO 
cycle clock 

IPO cycle clock: IPO 2 
cycle clock 

1:1 ... 1:4, 1:6, 1:8, 1:10, 1:12, 1:14, 1:16 1:1 ... 1:6 1:2 ... 1:64 

6.5.3 Requirements for configuring PROFINET 

Prerequisites 
In order to work with SIMOTION D4x5 via PROFINET IO, the CBE30 option board must be 
inserted into the option slot of the SIMOTION D4x5.  
The PROFINET IO IRT module CBE30 supports parallel operation of: 
● IRTtop or alternatively IRTflex - Isochronous Realtime Ethernet 

– Operation of IRT I/O (e.g., ET 200S) 
– Operation of a SINAMICS S120 with CBE20 as IRT device 

● RT - realtime Ethernet 
– Operation of RT I/O (e.g., ET 200S, ET 200pro, etc.) 
– Operation of a SINAMICS S120 with CBE20 as RT device 

● TCP/IP, UDP, HTTP, … standard Ethernet services 
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Note 
IRTtop (IRT with high performance) and IRTflex (IRT with high flexibility) cannot be 
operated in parallel with V4.1 SP2. 
For mixed operation of IRTtop and RT, make sure that the IRTtop-compatible devices 
form a so-called IRT domain, i.e., there must not be any non-IRTtop devices on the data 
transmission link between the IRTtop devices. 

 

Additional references 
You will find an overview of the specific properties of PROFINET IO on SIMOTION D4x5 in 
the SIMOTION Communication System Manual. 

6.5.4 Configuration tasks 
Configuration of PROFINET involves the following steps: 
1. Insert the SIMOTION D4x5. 
2. Insert and configure the CBE30 module in HW Config. 
3. Create a topology: Here, you specify how the individual ports of the PROFINET IO 

devices are interconnected. 
4. Configure the sync domain: Here, you specify which PROFINET nodes are sync masters 

(clock generator) and sync slaves. 
5. Define the update time: Describes the time during which a PROFINET IO device 

exchanges user data with the PROFINET IO controller. 
6. Configure the direct data exchange: With the direct data exchange you define which 

address areas are to be used for transmitting and which for receiving. 

Additional references 
You will find a detailed description of each configuration step in the chapter entitled 
"Configuring PROFINET IO with SIMOTION" of the SIMOTION Communication System 
Manual. 
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6.6 Configuring an MPI bus 

6.6.1 Operating the X136 interface as MPI 
The X136 interface can also be used as an MPI interface, for example, to connect to an 
external PG/PC.  
When the X136 interface is used as an MPI bus, additional activation of a drive on this 
interface is not possible. 

 
Figure 6-7 Connection of D4x5 (using X136) and MPI bus component 

6.6.2 MPI parameters 

MPI bus addresses and data transmission rate 
Every node on the MPI bus must have a bus address in the range 0 to 31. 
The data transmission rate on the MPI bus can be set to any value for the SIMOTION D4x5.  

Communication attempt unsuccessful 
If communication cannot be established at all, or if it cannot be established with individual 
nodes on the MPI bus, check the following elements: 
● Is the transmission rate setting for the D4x5 used for all nodes? 
● Are there any loose plug connections? 
● Are all bus segments terminated properly? 

Bus segments that are not terminated properly will disrupt communication on the MPI 
bus. 
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Commissioning (software) 7
7.1 Overview of commissioning 

Requirements 
The following requirements must be fulfilled in order to commission the SIMOTION D: 
● The system has been connected and wired. 
● The SIMOTION D is switched on and started up (STOP mode). 
● SIMOTION SCOUT has been installed on the PG/PC and powered up. 
● The communication and networks have been configured. 

 

 
 

Note 
The order numbers (MLFB) of the SINAMICS S120 components must be available. 
You need these order numbers when setting up a SIMOTION project to verify that the 
components selected from the hardware catalog in the HW Config application correspond 
to the ones used in the system. 

 

Commissioning steps 
This section shows you how to configure a system and test the configured drives and axes. 
The commissioning steps are listed below in their recommended order.  
1. Configure the system: 

– Online configuration: D4x5 (Page 111) and CX32 (Page 145)  
During online configuration, you can download all of the information from the 
connected DRIVE-CLiQ components to your user project. 

– Offline configuration: D4x5 (Page 118) and CX32 (Page 146)  
For offline configuration, all of the components and their order numbers must be 
known. 

 

 
 

Note 
The next two sections describe how a SIMOTION D4x5 is configured. If CX32 
Controller Extensions are being used, we recommend carrying out commissioning of 
the D4x5 and CX32 Control Units in stages. This graduated approach is described in a 
separate section. 
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2. Test the configured drive (drive control panel) (Page 163)  
3. Create axes. 
4. Test the configured axis (axis control panel). 
5. Activate the infeed (Active Line Module) 
6. Link an additional encoder (optional) (Page 174)  
7. Configure drive-related I/O (Page 178)  
8. Optimize drive and controller (Page 204)  

This section also contains additional configuration information, e.g. for vector drives, 
Safety Integrated, etc. 

Downloading projects/Copying from RAM to ROM 
Please note the following behavior concerning SIMOTION SCOUT's online functions:  

 

Symbol Function Effect 

 

Downloading the project to the 
target system 

Downloading programs to the 
SIMOTION device and 
performing configuration for the 
SINAMICS Integrated and any 
connected CX32 modules  

 

Downloading CPU/drive unit to 
target device 

The configuration is only loaded 
to the device selected in the 
project tree (which means the 
function needs to be performed 
separately for each 
D4x5/CX32). 

 

Downloading the CPU/drive unit 
to the programming device 

The unit's configuration is only 
loaded to the programming 
device selected in the project 
tree (which means the function 
needs to be performed 
separately for each 
D4x5/CX32). 

 

Copy RAM to ROM Copying from RAM to ROM is 
only performed for the device 
selected in the project tree 
(which means the function 
needs to be performed 
separately for each 
D4x5/CX32). 

 
 

 Note 
Where CX32s are connected, it is better to download the devices individually in the following 
sequence: "D4x5 > SINAMICS Integrated > CX32 (1) > CX32 (2), etc.". Using this method, 
you will be in a better position to identify the locations of any errors that occur. 
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7.2 Performing online configuration for D4x5 

7.2.1 Overview of online configuration 

Introduction 
You can configure the plant in online mode after having completed its wiring. You can load 
the data of SINAMICS components connected via DRIVE-CLiQ to your PG/PC using the 
"Automatic configuration" function. However, this is only possible for initial commissioning. 

 

 Note 
Components without DRIVE-CLiQ connection must be edited in offline mode. You may need 
to edit DRIVE-CLiQ components which were detected in the course of automatic 
configuration (for example, adding encoder data if using SMC modules). 

 

Requirements 
● Your system has been mounted and wired. 
● Communication to the PG/PC (default network addresses, baud rates, etc.) is configured 

and loaded via the corresponding interface (automatic communication configuration). 
See Creating a project and configuring communication (Page 83). 

Procedure 
Online configuration involves the following steps: 
● Establishing a connection to the SINAMICS Integrated 
● Starting the automatic configuration 
● Editing SINAMICS components 
● Performing an HW Config alignment 
● Downloading a project to SIMOTION D4x5 

 

 
 

Note 
Make sure that the default PROFIBUS settings are specified for the PG/PC interface 
communication in SIMOTION SCOUT. If, for example, the PROFIBUS transmission rate 
is different, you cannot perform fast commissioning as outlined below. Instead, you must 
first adapt the PG/PC PROFIBUS settings in HW Config and NetPro. 
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7.2.2 Establishing a connection to SINAMICS Integrated 

Requirement 
You have created a project. 

Procedure 
This section outlines the procedure for initial commissioning. 
To perform online configuration, you must establish an online connection to the SIMOTION 
D4x5. In this case, no connection can yet be established to the SINAMICS Integrated. An 
appropriate message is output. Once the hardware configuration has been loaded to the 
target device, an online connection to the SINAMICS Integrated is established automatically. 
Proceed as follows: 
1. Save and compile the project. 
2. Establish an online connection. 
3. Highlight the SIMOTION D4x5 device in the project navigator. 

 

 
 

Note 
Ensure that you use the "Download to target device" function rather than "Download to 
target system". Automatic commissioning is no longer possible after downloading to the 
target system. If "Download to target system" has been used, "Restore factory settings" 
must be performed on the drive element in order to start an automatic commissioning 
afterwards. 

 

4. Use the "Download to target device" function to download SIMOTION D4x5 to the target 
device. The connection to the SINAMICS Integrated is automatically established. 

Result 
Now you can perform the automatic configuration on the SINAMICS Integrated. See the 
section titled Starting the automatic configuration   

Additional references 
Further information about establishing an online connection to the programming device/PC 
can be found in the following documentation: 
● SIMOTION SCOUT Configuration Manual 
● SIMOTION SCOUT Online Help 
● In FAQ on the "Utilities & Applications" CD 

See also 
Starting the automatic configuration (Page 113) 
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7.2.3 Starting the automatic configuration 

Requirements 
● You have established the connection to the SINAMICS Integrated. 
● Drive objects must not yet be configured. 

However, if you have already configured drive objects, the existing configuration is 
loaded. You must then restore the default settings of the SINAMICS Integrated (see 
Setting SINAMICS Integrated to the default settings (Page 218)). 

Procedure 
1. In the project navigator, open the "Automatic Configuration" dialog box by selecting 

"SINAMICS Integrated" > "Automatic Configuration". 

 
Figure 7-1 Starting the automatic configuration 

 
2. Click "Start Automatic Configuration". 

The "Drive Object Type" dialog box is opened. 

 
Figure 7-2 Selecting the drive object type 
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3. Select whether a servo- or vector-type drive object is to be used. 
4. Click "OK" to close the automatic configuration. As soon as automatic commissioning has 

run, an upload operation (Load to PG) is automatically performed. The next message 
window is a reminder to parameterize the drive offline with the drive wizard. 

 

 
 

Note 
If the firmware of the SINAMICS components is older than the firmware on the CF card, a 
notice is displayed, and the firmware of the SINAMICS component is automatically 
upgraded. After the firmware of a SINAMICS component has been updated, you must 
first go offline and then switch off the 24 V power supply of the component before 
switching it back on again (Power Off/On). 

 

5. Click "Close" to exit the automatic configuration. 

 
Figure 7-3 Automatic commissioning is complete 



 Commissioning (software) 
 7.2 Performing online configuration for D4x5 

D4x5 
Commissioning and Hardware Installation Manual, 08/2008 Edition 115 

Result 
The real components are displayed in the project navigator. If you had previously configured 
drive objects, the settings for these objects are overwritten and the designations are reset. 

 
Figure 7-4 Project navigator with real configuration 

 
You must then edit the SINAMICS components. 

See also 
Editing SINAMICS components (Page 116) 
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7.2.4 Editing SINAMICS components 

Requirement 
● You have loaded all connected DRIVE-CLiQ components to your user project. 
● You have cleared the connection to the target system. 

Procedure 
You can now adapt your component to the application. 
Execute the wizards for all DRIVE-CLiQ components in order to edit (if necessary) the motor, 
encoder, and PZD message frames (PROFIBUS message frame type). 
This procedure conforms to the description Performing offline configuration for the D4x5 
(Page 118). 
The amount of editing work involved depends on the components used. For example, in the 
case of a motor with a DRIVE-CLiQ interface, the motor and encoder type are identified 
automatically. 

 

 Note 
If only the message frame type needs to be selected for the edit, you can also set this in the 
"Configuration" screen form of the drive element. A HW Config match is then required. 

 

7.2.5 Performing a HW Config alignment 
When you have configured all SINAMICS components, perform an alignment with 
HW Config. Use the following procedure: 
1. Go offline with the SIMOTION D4x5. 
2. Save the project and open the "Configuration" entry under "SINAMICS Integrated" in the 

project navigator. 
The system loads the default data including the real configuration (devices that are 
wired). 

3. Check the drive objects and configure the message frames for the drives. 
The following message frame types can be used, for example, in conjunction with 
SINAMICS S120 drives: 
– SIEMENS message frame 105, PZD-10/10: Dynamic life sign, torque reduction, 

encoder data for an encoder, dynamic drive control (DSC) 
– SIEMENS message frame 106, PZD-11/15: Dynamic life sign, torque reduction, 

encoder data for two encoders, dynamic drive control (DSC) 
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Note 
Drive objects without an address must be positioned at the end of the list, otherwise it 
will not be possible to perform HW Config alignment ("Transfer to HW Config"). To 
move the order of a drive object without address, select the associated drive object 
and move it downwards using the arrow key. 

 

4. Click "Transfer to HW Config" to assign addresses to the configured components. The 
addresses are entered in HW Config. 

5. Close the dialog box. 
 

 
 

Note 
If you change the message frames for SINAMICS Integrated again, you must repeat the 
HW Config alignment. The addresses are not updated automatically. 

 

7.2.6 Downloading a configuration 
After you have finished the HW Config alignment, you must download the configuration to 
the SIMOTION D4x5 (incl. SINAMICS Integrated).  
1. Save and compile the project. 
2. Go online. 
3. Use "Target System" > "Load" > "Project to Target System" to load the configuration. 
4. Now perform drive optimization, using the measuring functions and the automatic 

controller setting. 
5. Load your drive optimization settings to the PG/PC with the command "Download" > 

"Load to PG" and save the project. Use the "Copy RAM to ROM" command to save the 
data to the CF card. 

The drive has been assigned parameters and commissioned. You can now test the drive via 
the drive control panel. 

 

 Note 
If you have cleared the "Drives" option under "Tools" > "Settings" > "Download" in 
SIMOTION SCOUT, you must download the configuration to the SINAMICS Integrated 
separately. Right-click "SINAMICS Integrated" and select the "Target device" > "Download" 
menu command. 
As a general rule, we recommend that you follow this procedure to enable you to work 
quickly. 

 

See also 
Optimizing drive and closed-loop controller (Page 204) 
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7.3 Performing offline configuration for the D4x5 

7.3.1 Overview of offline configuration 

Introduction 
You can decouple commissioning of the drive from the system engineering. This enables 
you to configure the system offline (in the office), thus, for example, to configure the drive 
and create a virtual axis. In this way, a SIMOTION project can be created up to a point 
where a basic project specification (including a program) exists. You can then download the 
finished project to the SIMOTION D4x5. Any errors that were made during configuration can 
be cleaned up during online operation (using a desired-actual comparison of the SINAMICS 
topology).  

Requirements 
● You have created a project in SIMOTION SCOUT and inserted a SIMOTION D4x5 into 

the project in the hardware configuration. 
● You have configured the communication between the SIMOTION D4x5 and the PG/PC. 
● For offline configuration, all of the components and their order numbers must be known. 

Procedure 
Offline configuration involves the following steps: 
● Accessing the drive wizard 
● Configuring components 
● Performing an HW Config alignment 
● Downloading a project to SIMOTION D4x5 

 

 
 

Note 
During offline configuration, you can also configure the available options (TB30) and 
terminal modules, e.g., TM41. 

 

See also 
Overview of SIMOTION engineering (Page 163) 
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7.3.2 Accessing the drive wizard 

Integrated drive 
The SIMOTION D4x5 contains an integrated SINAMICS S120 drive device, which is 
automatically inserted along with the SIMOTION D4x5 control unit in the project navigator. 
The integrated drive is capable of exclusive isochronous operation using PROFIdrive-
compliant message frame types.  
The drive wizard is available in SIMOTION SCOUT for configuring the integrated drive and 
its associated modules (e.g., SINAMICS S120 Active Line Modules and SINAMICS S120 
Motor Modules). 

 

 Note 
Take note of all the necessary safety precautions and rules governing connections, which 
can be found in the latest SINAMICS S120 documentation on the SIMOTION SCOUT DVD. 

 

Requirement 
You have created a project and have already inserted a SIMOTION D4x5. 

Procedure 
Select "SINAMICS Integrated" > "Configure drive unit " in the project navigator to open the 
drive wizard for configuring your drive unit.  
You can configure the following components: 
● Infeed (e.g., SINAMICS S120 Active Line Module) 
● Drive 
● Power unit (e.g., SINAMICS S120 Motor Module) 
● Motor 
● Encoder 
● Option module 



Commissioning (software)  
7.3 Performing offline configuration for the D4x5 

 D4x5 
120 Commissioning and Hardware Installation Manual, 08/2008 Edition 

7.3.3 Configuring components 

Requirement 
You have inserted a SIMOTION D4x5 into the project, configured the communication, and 
accessed the drive wizard by double-clicking "Configure Drive Unit" in the project navigator.  

 

 Note 
An overview of reliable configurations, quantity structures and DRIVE-CLiQ topologies can 
be found in the Commissioning Manual for SINAMICS S120.  
It should be noted, for example, that mixed operation of servo and vector is not possible, 
although mixed operation of servo and vector V/f is possible. 
Failure to comply with the rules listed in this manual will result in errors that are not output 
until the download is performed, rather than at the configuration stage. 

 

Procedure 
While executing the wizard you will be prompted to perform, for example, the following 
configuration steps:  
1. In the "Option module" dialog box, select whether to use an option module (e.g. a TB30). 

 
Figure 7-5 Selecting an option module 

 



 Commissioning (software) 
 7.3 Performing offline configuration for the D4x5 

D4x5 
Commissioning and Hardware Installation Manual, 08/2008 Edition 121 

 
 

Note 
Option modules are displayed as a DRIVE object under the Input/Output component in 
the project navigator and can be configured there. 

 

2. In the "Insert infeed" dialog box", select whether or not to use an infeed with a DRIVE-
CLiQ connection. If the DC link has an external supply, select "No" (no DRIVE-CLiQ 
connection). 

 
Figure 7-6 Selecting an infeed a with DRIVE-CLiQ connection 

 

 
 

Note 
If you have selected an uncontrolled infeed without a DRIVE-CLiQ connection, omit steps 
3 to 6 below. 
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3. In the "Infeed configuration" dialog box, enter a name for the drive object and select a 
type for your infeed (e.g. Active Infeed). 

 
Figure 7-7 Selecting the infeed type 

 
4. Using the order number, select an infeed from the list. You can filter the information in 

order to limit the number of infeeds displayed, by using "Type", for example. 

 
Figure 7-8 Selecting an infeed 
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5. You can make additional settings for the infeed in the "Infeed drive object - additional 
data" dialog box. 

 
Figure 7-9 Making settings for the infeed 
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6. In the next dialog box, select how you wish to control the infeed. To do this, you can 
select how you want to configure the process data exchange under "PROFIBUS PZD 
message frame": 
– SIEMENS message frame 370 allows the infeed process data to be transmitted via 

PROFIBUS message frame 370. Message frame 370 contains a control word and 
allows, for example, the infeed to be activated via PROFIBUS. 

– Free message frame configuration via BICO allows the infeed process data to be 
transmitted via a freely configured message frame. 

Message frame 370 is recommended for standard applications. 

 
Figure 7-10 Selecting a PROFIBUS message frame for the infeed 

 
When you use message frame 370, the _ALM_control function block in the the command 
library is available for switching on the Active Line Module (ALM). This function block 
must not be used for Smart Line Modules or Basic Line Modules. 
You can find information about how to activate an Active Line Module via a PROFIBUS 
message frame in the section titled Activating an Active Line Module using a PROFIBUS 
message frame (Page 168). 
Activate the Active Line Module via "Free message frame configuration using BICO". To 
do this, you must wire the device appropriately and interconnect the enable signal via 
BICO. You will find information about interconnecting signals with BICO technology in the 
SINAMICS S120 Commissioning Manual. 
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7. Now configure the drive. 

 
Figure 7-11 Configuring a drive 

 
8. Enter a name for the drive and select the type of drive object (servo or vector). 

 
Figure 7-12 Drive properties 
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9. In the "Control Structure" dialog, you can select the function modules and the control 
type. Here, you can select "Vector" for the V/f control under "Drive objects type". 

 
Figure 7-13 Closed-loop control structure 

 
10. In the "Power Unit" dialog, use the order number to select your Motor Module from the 

list. 

 
Figure 7-14 Selecting a power unit 
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11. If you have selected an infeed without a DRIVE-CLiQ connection in step 2, a message 
prompting you to wire the operation signal will appear. The next dialog box allows you to 
select the source of the infeed's operation signal: 
– Either by selecting a standard motor from the list 
– Or by entering the motor data 
– Or by automatically identifying the motor (motor with DRIVE-CLiQ interface) 

 
Figure 7-15 Selecting the infeed operating signal 

12. with Double Motor Modules, you are requested to specify on which terminal the motor is 
connected. 
You specify the motor in the following dialog boxes:  
– Either by selecting a standard motor from the list 
– Or by entering the motor data 
– Or by automatically identifying the motor (motor with DRIVE-CLiQ interface) 
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Figure 7-16 Selecting a drive (1) 

 

 
 

Note 
A motor with a DRIVE-CLiQ interface is directly connected to the motor module. In this 
way, the motor sensor and temperature signals, as well as the electronic rating plate 
data such as the unique identification number and rated data (voltage, current and 
torque) are transferred directly to the Control Unit. These motors have an integrated 
encoder evaluation. 

 

 
Figure 7-17 Selecting a drive (2) 
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13. Selecting a motor holding brake (if available). 

 
Figure 7-18 Selecting a motor holding brake. 

 
14. In the "Encoder" dialog, select a motor encoder from the list or enter the encoder data 

manually. 

 
Figure 7-19 Selecting a motor encoder (1) 
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Figure 7-20 Selecting a motor encoder (2) 

 

 
 

Note 
If required, you can configure a second or third encoder in the "Encoder" dialog box. You 
can transmit a maximum of 2 encoder values to SIMOTION via the axis message frame. 
In the case of motors with a DRIVE-CLiQ interface, the motor encoder is identified 
automatically. It is not necessary to enter encoder data in such cases (Dialog box for 
selecting Encoder 1 not active (shaded)) 

 

 
15. Select the PROFIBUS message frame in the next dialog box. 

The following message frame types can be used in connection with SINAMICS S120 
drives, for example: 
– SIEMENS message frame 105, PZD-10/10: Dynamic life sign, torque reduction, 

encoder data for one encoder, dynamic drive control (DSC) 
– SIEMENS message frame 106, PZD-11/15: Dynamic life sign, torque reduction, 

encoder data for two encoders, dynamic drive control (DSC) 
The advantages of DSC (compared with having a position controller in the control) are 
the higher Kv factor, the broader bandwidth resulting in a more dynamic response, and 
shorter response times in the event of interference. 
The DSC dynamic drive control can be used for SIEMENS message frame 105, PZD-
10/10 and SIEMENS message frame 106, PZD-11/15. The DSC is activated by default 
for the configuration of the axis using the Drive Wizard. Detailed information for the 
various message frame types can be found in the Function Manual Motion Control, TO 
Axis Electric/Hydraulic, External Encoder. 
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Figure 7-21 Selecting a PROFIBUS process data message frame 

 
After you have configured all of the settings in the drive wizard, the "Summary" dialog 
displays a list of all settings. You can accept these settings with "Finish" or edit the 
configuration of individual components using the "Back" button. 

 
Figure 7-22 Finishing the drive 
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Result 
The configured drive will appear in the project navigator. 

 
Figure 7-23 Representation in the project navigator 

 
You will find an overview of the configured SINAMICS components under 
"SINAMICS_Integrated" > "Topology". 

 
Figure 7-24 Displaying the topology 
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 Note 
If you want to insert other drives, you must run through the drive wizard again for each drive 
and configure the motors, encoders, etc. To insert another drive, double-click "Insert drive" in 
the project navigator. 

 

The input and output addresses of the drive objects with the selected message frame types 
must now be transferred to HW Config. 

7.3.4 Performing a HW Config alignment 

Requirement 
You have configured the different drive units and PROFIBUS message frames. 

Procedure 
When you have configured all SINAMICS components, perform an alignment with 
HW Config. Use the following procedure: 
1. In the project navigator, open the "Configuration" entry under "SINAMICS_Integrated". 

The "SINAMICS Integrated - Configuration" dialog containing a list of available drive 
objects is displayed. 

2. If you want to work over the message frames of the drive objects first, select the drive 
object and change the message frame. 
The input and output addresses of the drive objects are not yet defined as indicated by 
the question marks in the fields. 

 
Figure 7-25 Configuration before data transmission to HW Config 
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Note 
Before the matching, all drive objects without input/output addresses ("---..---") must be 
moved behind the objects with valid input/output addresses or those still to be matched 
("???..???"). 
The icons in the status column show the following information: 

 The message frame is configured differently in HW Config. You must match with HW 
Config. 

 You are using a predefined standard message frame or free BICO interconnection. 
 You are using a modified standard message frame that you have extended to include 

additional data. 
 You are using a message frame for which one of the two message frame lengths is 

too long. The drive object cannot process this entry. 
 

 
1. Click "Transfer to HW Config" to assign addresses to the configured components. The I/O 

addresses are entered in HW Config. The settings are overwritten there. 

 
Figure 7-26 Configuration after HW Config alignment 

2. Close the dialog box. 
 

 
 

Note 
If the message frames for drive objects change (drives, Terminal Modules, etc.) you must 
repeat the data transfer to HW Config. The addresses are not updated automatically. 
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7.3.5 Downloading a project created offline to the target system 

Requirement 
You have configured the hardware. Now, you must download the hardware configuration and 
the entire SIMOTION project to the target device.  
If you have not yet configured your SIMOTION project (i.e. created ST programs, assigned 
execution levels, etc.), complete this step first. 

Procedure 
1. Save and compile the project. 
2. Go online with the SIMOTION D4x5. 
3. Use the "Target system" > "Load" > "Project to target system" menu command to 

download the project to the SIMOTION D4x5. 
Note: In the "Download to Target System" dialog box, select "After loading, copy RAM to 
ROM". This causes the project to be saved additionally to the CF card. 

 
Figure 7-27 Downloading the project to the target system 

 
The SIMOTION project is downloaded to the target system. The connection to the 
SINAMICS Integrated is automatically established, and the drive component is 
downloaded. 

See also 
Downloading a configuration (Page 117) 
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7.3.6 Loading a project created offline to the CF card 

Requirement 
If you cannot go to the SIMOTION D4x5 online, you can also save the project data to the CF 
card offline. The advantage of this is, for example, that the initial download can be performed 
faster. 

 

 Note 
In order to save the project data via the PG/PC, you need a CF card adapter in which you 
can insert the CF card. The CF card must be displayed as a removable storage device with 
any drive letter in Windows Explorer. 
If the CF card is not displayed, check the CF card adapter and contact the hotline if 
necessary. 

 

Procedure 
To save the project data, proceed as follows: 
1. In the project navigator, select SIMOTION D4x5 followed by the "Edit" > "Load to file 

system" menu command. 
2. Select the "Normal save" option in the "Load to File System" dialog box. 

This enables you to save the runtime project data to the CF card in offline mode. 

Archiving a project on the CF card (zip file) 
In SIMOTION SCOUT, You can save the project as a *.zip file to the CF card.  
Proceed as follows to archive the SIMOTION project on the CF card: 
1. Open SIMOTION SCOUT and select the "Project" > "Archive" menu command. 
2. In the "Archive" dialog, select the SIMOTION project and save it to your drive (PG/PC). 
3. Open the project. 
4. Go online with the SIMOTION D4x5. 
5. In the project navigator, select the SIMOTION D4x5 and select the "Target System" > 

"Load" > "Archive project on card" menu command. 
6. In the dialog that is displayed, select the project and click "Open". This saves the project 

to the CF card as Project.zip in the directory USER\SIMOTION\HMI\PRJLOG. 
 

 
 

Note 
If you want to load the current project from the card, select the "Target system" > "Load 
project from card" menu command. 
This assumes that you have backed up the project with "Archive project on card" each 
time a change was made. 
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Additional references 
Detailed information on loading data to the target device can be found in the SIMOTION 
Basic Functions Function Manual. 

7.3.7 Loading a project, including sources and additional data 

Overview 
In the case of SIMOTION V4.1 SP2 and higher, it is possible to load additional data (e.g. 
sources) to the target device when saving a project to the CF card or downloading to the 
D4x5. These data are required for: 
● Online object comparison (e.g. additional properties) 
● Various detailed comparisons (e.g. ST source file comparison) 
● "Load to PG" function (complete upload to offline project) 
● Synchronization with online objects 
In order to be able to load a project's sources and additional data to the programming device, 
this must be specified in the project under "Options" > "Settings" > "CPU download" > "Save 
supplementary data on the target device". 
If the sources and additional data have been saved on the CF card, the options described in 
the sections that follow become available. 

Project comparison 
You intend to carry out servicing work on a commissioned system and have brought a 
project on your PC/PG. This project is not consistent with the project on the D4x5 in the 
system. In order to analyze the differences, perform an object comparison via "Start object 
comparison". 
You have the following options in terms of re-establishing consistency: 
● In the object comparison, it is possible to establish consistency for sources and 

technology objects on an object-granular basis. 
● Consistency can be established for the whole Control Unit by loading the CF card via 

"Target system" > "Load" > "Load to PG". 
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Project not available on the PG/PC 
You intend to carry out servicing work on a commissioned system but do not have a suitable 
project on your PC/PG. The communication parameters of the PG/PC interface are set in 
such a way that you are able to establish a connection to the target device. 
As the current sources were saved on the target device, you wish to work with these again. 
1. Open SIMATIC Manager and create an empty project. ("File" > "New") 
2. Go ONLINE and select "Target System" > "Load station to PG". 
3. Display the accessible nodes and select the D4x5; click "OK" to acknowledge. This will 

upload the HW Config information. 
4. Then, start SIMOTION SCOUT from SIMATIC Manager. To do this, select the D4x5 in 

the project tree and double-click "SIMOTION SCOUT". 
5. Go ONLINE (a connection is still not established to the SINAMICS Integrated). In the 

project navigator, select the D4x5 and select the "Target system" > "Load" > "Load to PG" 
menu command. Select "Load target device to PG" in the dialog box. The SIMOTION 
project information is now uploaded. The displays in the project navigator are now green 
(indicating ONLINE consistency). 

Configuring SINAMICS Integrated connection 
To use SINAMICS Integrated online for a D4x5, the connection must be configured via 
NETPRO. 
1. Go offline and start by opening the NETPRO from SIMOTION SCOUT. 
2. Insert a programming device there. 
3. Ensuring that the D4x5 and PG are in the same subnet, configure and activate the 

connection (line has a yellow background on the programming device). 
4. Save and compile the project with close NETPRO. 

Go ONLINE on to SINAMICS Integrated 
1. Now, go to SINAMICS Integrated ONLINE in SCOUT. 
2. Select "Load to PG". This connection is also displayed in green in the project navigator. 

Additional references 
Detailed information on loading data to the target device can be found in the SIMOTION 
Basic Functions Function Manual. 
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7.4 Configuring a CX32 

7.4.1 Overview 
The SIMOTION CX32 Controller Extension is a component in SINAMICS S120 booksize 
format and supports scaling of the drive-end computing performance of the SIMOTION D435 
and D445 Control Units. Each CX32 can control up to 6 additional servo, 4 vector, or 8 V/f 
drives. 
The CX32 Controller Extension offers the following advantages: 
● At only 25 mm wide, the CX32 is extremely compact. 
● The CX32 is connected to SIMOTION D435/D445 over DRIVE-CLiQ, so high-

performance, isochronous closed-loop control of the drives is possible without the need 
for additional modules. 

● The communication interfaces on the SIMOTION D435/D445 remain available for other 
connections. 

● The data for the CX32 is stored exclusively on the SIMOTION D435/D445 CF card, which 
means that no action needs to be taken when the module is replaced. 

● The "Control operation" signal from an infeed connected to the SIMOTION D4x5 is 
particularly easy to interconnect to the drives of a CX32. 

7.4.2 Basic principles of the CX32 

Basic principles of the CX32 
Each CX32 is entered as a separate DRIVE object in the project navigator on the level of 
SINAMICS Integrated. As a general principle, a CX32 can be configured the same way as 
SINAMICS Integrated. 

Communication 
Communication on the CX32 (as with the SINAMICS Integrated) uses PROFIBUS 
Integrated, although the SINAMICS Integrated is also used to for routing to the relevant 
CX32 via DRIVE-CLiQ. 
Communication with the CX32 runs in the same cycle clock (same DP cycle clock) as 
communication with the SINAMICS Integrated. Direct communication between two CX32 
modules or the SINAMICS Integrated and CX32 is not possible (Exception: Interconnection 
of the infeed's "Operation" signal for the CX32. (How to interconnect the "Operation" signal is 
described in Section CX32 configuring tool) 
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Power-up 
The CX32 does not require its own CF card. Both the firmware and parameterization are 
stored centrally on the SIMOTION D CF card. This means that the CX32 modules only 
power up after the SINAMICS Integrated has done so. As a result, it usually takes longer for 
the system to power up than if a SIMOTION D were being used with just one SINAMICS 
Integrated. 
Copying from RAM to ROM also takes longer, as the devices perform this function one after 
the other. 
Refer to the section titled CX32 configuring tools (Page 148) for information on how to tell 
when powering up is complete. 

Requirements for commissioning 
In order to commission a SIMOTION D with CX32, all drive components which were 
configured offline must also be present and connected to the correct DRIVE-CLiQ port. 
Only when there are no topology errors 
● Will the download be successful (where a project created offline is loaded to the target 

system) 
● Will the system startup be successful 
● Can the CX32 modules be accessed "online" 

Loading the SINAMICS Integrated 
If the SINAMICS Integrated of a SIMOTION D is loaded, the connected CX32 Controller 
Extensions go offline as a result of reinitialization. 

7.4.3 Preparing for configuration 

Preparing for configuration 
The following measures are required to enable online or offline configuration of a CX32. 
1. Create a project and insert a SIMOTION D435 or D445 (in this example, a D435 is used). 
2. Double-click "D4x5" in the project navigator. HW Config is displayed. 
3. In the hardware catalog, open the "PROFIBUS DP" entry and select "SINAMICS". 
4. Drag a SINAMICS CX32 to the PROFIBUS Integrated master system of the SIMOTION D 

module. The mouse pointer permits the CX32 to be inserted on the master system only. 
The "DP Slave Properties" screen form is displayed with the PROFIBUS address. The 
PROFIBUS address is automatically assigned as per the table below. Select the relevant 
DRIVE-CLiQ port by selecting the relevant PROFIBUS address (in this example, 
PROFIBUS address 13). 
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        Figure 7-28 Inserting CX32 in HW Config 

Table 7- 1 CX32 PROFIBUS addresses (PROFIBUS Integrated) 

DRIVE-CLiQ port PROFIBUS address (PROFIBUS Integrated) 
X105 (D445 only) 15 
X104 (D445 only) 14 
X103 (D435/D445) 13 
X102 (D435/D445) 12 
X101 (D435/D445) 11 
X100 (D435/D445) 10 
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5. Click "OK" to confirm your settings. 
The CX32 is displayed in the project navigator and can be configured there in the same 
way as a SINAMICS Integrated. 
In HW Config, the respective PROFIBUS address of the CX32 is represented in 
parentheses in the module icon. 

 
Figure 7-29 CX32 in the project navigator 

6. A CX32 is configured in the same way as a SINAMICS Integrated for a SIMOTION D4x5. 
Offline configuration 
Where configuration is being performed offline, configure the drive components (infeed, 
Motor Modules, motor, encoder, Terminal Modules, etc.) by working through the drive 
wizards for the SINAMICS Integrated or CX32. After you have done this, carry out 
commissioning. 
Automatic commissioning 
With automatic commissioning, the drive components that are physically connected to a 
SIMOTION D are determined online. This means you only need a D4x5 project with 
CX32 modules configured in HW Config. 

See also 
Configuring components (Page 120) 
Performing CX32 configuration online (Page 145) 
Loading a project created offline to the target system (Page 146) 
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7.4.4 Displaying the topology 

Topology of the SINAMICS Integrated 
Because the CX32 is connected to the SINAMICS Integrated of a SIMOTION D4x5 via 
DRIVE-CLiQ, it is also represented in the topology tree of SINAMICS Integrated. 
All inserted CX32s are represented in the SINAMICS Integrated topology without their 
subtopology. 

 
Figure 7-30 SINAMICS Integrated topology 
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CX32 topology 
The CX32 topology represents the DRIVE-CLiQ port required for connection to the 
SINAMICS Integrated. The drive objects connected to the CX32 are also displayed. 

 
Figure 7-31 CX32 topology 

 

 Note 
Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 

 

See also 
CX32 configuring tools (Page 148) 
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7.4.5 Performing CX32 configuration online 

Requirement 
You need a project which has already been created and which contains SIMOTION D4x5 
with SINAMICS Integrated, as well as CX32 Controller Extension(s). 
Additional drive components (Line Module, Motor Modules, Terminal Modules, etc.) are 
configured using "Automatic commissioning" and must not, therefore, be created offline. 

Procedure 
1. Deselect all target devices, with the exception of the SIMOTION D4x5, using the "Target 

System" > "Select Target Devices" menu command in SCOUT. 
2. Go online with the D4x5 by clicking "Connect to target system". 
3. Select the D4x5 in the project tree. Load the configuration to the SIMOTION D4x5 with 

"Download CPU/drive unit to target device". 
4. Copy the parameterization from RAM to ROM with "Target device à Copy RAM to ROM". 
5. Select "Connect Online" in the SINAMICS Integrated context menu. You will then be 

connected to the SINAMICS Integrated online. 
6. Perform "Automatic Configuration" on the SINAMICS Integrated. This may take several 

minutes, depending on the number of components connected. 
The SINAMICS Integrated is now ready for operation (RDY LED is green). The CX32 can 
be accessed online, although it will not yet have been configured (RDY LED is green, 
DP1 LED is red). 

7. Select "Connect Online" in the CX32 context menu. You will then be connected to the 
CX32 online. 

8. Perform automatic configuration on the CX32. The CX32 is now also ready for operation 
(RDY LED is green, DP1 LED is green). 

9. Repeat steps 7 to 8 for each CX32. 
10. Copy the parameterizaton from RAM to ROM with "Copy RAM to ROM". 
11. Save the project. 
 

 

 Note 
Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 
You may have to restore the factory settings before automatic commissioning. If so, go to the 
SINAMICS Integrated or CX32 context menu and select "Target Device" > "Restore factory 
settings". 

 

See also 
CX32 configuring tools (Page 148) 
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7.4.6 Performing CX32 configuration offline 

7.4.6.1 Loading a project created offline to the target system 
The following two options are available for commissioning a project created offline. 
● Loading a project created offline to the target system 
● Loading a project created offline to the CF card 

Requirement 
● Your project, including all SINAMICS Integrated and CX32 drive components, must have 

been configured already (see Preparing for configuration (Page 140)). 
● The actual topology must correspond with the reference topology. 

Procedure 
1. Deselect all target devices, with the exception of the SIMOTION D4x5, using the "Target 

system" > "Select target devices" menu command in SCOUT. 
2. Go online with the D4x5 by clicking "Connect to target system". 
3. Select the D4x5 in the project tree. Load the configuration to the SIMOTION D4x5 with 

"Download CPU/drive unit to target device". 
4. Copy the parameterization from RAM to ROM with "Copy RAM to ROM". 
5. Select "Connect Online" in the SINAMICS Integrated context menu. You will then be 

connected to the SINAMICS Integrated online. 
6. Load the parameterization by selecting "Target device" > "Download" in the SINAMICS 

Integrated context menu. 
7. Copy the parameterization from RAM to ROM with "Copy RAM to ROM". 
8. Then select "Target Device" > "Load to PG" to load the parameterization from the 

SINAMICS Integrated back to the programming device in order to back up the SINAMICS 
parameter calculations. 
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Result 
The SINAMICS Integrated is now ready for operation (RDY LED is green). The CX32 can be 
accessed online, although it will not yet have been configured (RDY LED is green, DP1 LED 
is red). 
1. Select "Connect Online" in the CX32 context menu. You will then be connected to the 

CX32 online. 
2. Load the parameterization to the CX32 and copy the parameterization from RAM to 

ROM. 
3. Then load the parameterization from the CX32 back to the programming device in order 

to back up the SINAMICS parameter calculations. 
4. Repeat steps 1 to 3 for each CX32. 
5. Save the project. 

 

 
 

Note 
Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 

 

See also 
CX32 configuring tools (Page 148) 

7.4.6.2 Loading a project created offline to the CF card 
Loading a project created offline to the CF card has the advantage of being faster than a 
download. 
It should be noted, however, that the first system power-up will take longer, as the 
SINAMICS Integrated and CX32 will perform one-off parameter calculations. These are 
automatically backed up on the CF card. 

Requirement 
● You will need a card reader for the SIMOTION D4x5 CF card. 
● Your project, including all SINAMICS Integrated and CX32 drive components, must have 

been configured already (see Preparing for configuration (Page 140)). 
● The actual topology must correspond with the reference topology. 
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Procedure 
1. Select "Load to file system" in the SIMOTION D4x5 context menu. 
2. Select "Normal save" and click the "Select target" button. Select your card reader's drive 

and confirm with "OK". 
3. If a project has already been saved to the CF card, the message "Memory card file 

already exists. Do you want overwrite this file?" appears. Confirm the message with 
"Yes". 

4. Once the project has been subsequently transferred to the CF card, insert the card into 
the disconnected SIMOTION D4x5. Switch on the power supply for the D4x5 and 
connected components. 

5. After a successful power-up, the RDY LED of the D4x5 and CX32 will be green, as will 
the DP1 LED of the CX32. 

 

 
 

Note 
Topology errors may make it impossible to perform a download, power up a system, or 
access a CX32 online. 

 

7.4.7 CX32 configuring tools 

CX32 power-up 
Powerup times 
The CX32 does not require its own CF card. Both the firmware and parameterization are 
stored centrally on the SIMOTION D CF card. This means the CX32 will only power up once 
the SINAMICS Integrated has done so. As a result, it usually takes longer for the system to 
power up compared to when a SIMOTION D is used with a SINAMICS Integrated and any 
CU320 Control Units which may be connected. 
Detecting when the CX32 powers up in the user program 
The user must wait for the CX32 to power up before the drive objects can be accessed by 
the user program. 
One way of checking is to query the status of system variables on the CX32 drives. 
● <axis name>.actormonitoring.cyclicinterface = ACTIVE AND 
● <axis name>.sensordata[1].state = VALID 
This procedure can also be used to establish when the SINAMICS Integrated drives power 
up. 
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Interconnecting the infeed "Operation" signal on the CX32 
Requirement 
● Drive line-up with SIMOTION D4x5 Control Unit and Line Module with DRIVE-CLiQ 

interface 
● One or more CX32 Controller Extensions with no Line Module of their own (in other 

words, the Motor Modules of the D4x5 and CX32 modules are supplied by the same DC 
link). 

In this example, the Line Module must to be connected to the SIMOTION D4x5 (not the 
CX32). 
Procedure 
When drives are created in Drive System 1, the signal "Closed-loop control operation" r863.0 
from the Line Module is automatically interconnected with the "Infeed operation" signal from 
the drives (Drive 1...n) via p864. 
There is an internal communication channel available (V4.1 SP1 and higher) for the CX32 
Controller Extension (Drive System 2), via which the following signals from the SIMOTION 
D4x5 Control Unit can be automatically interconnected to the CX32 Controller Extensions: 
● "Closed-loop control operation" from the Line Module connected to SIMOTION D4x5 
● Status of the SIMOTION D4x5 onboard digital inputs 
These signals are available on the CX32 Controller Extension; since there is no need to 
perform any additional configuration steps, it is very easy to make additional 
interconnections with them within the CX32. 
Ready signal via parameter r8510.0 
The "Closed-loop control operation" signal from the Line Module connected to the 
SIMOTION D4x5 is available in parameter r8510.0 of the CX32. Using the expert list or the 
drive wizard, interconnect parameter p864 (drives on CX32) with parameter r8510.0 of the 
CX32 Control Unit. 
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   Figure 7-32 Interconnecting the infeed operation signal 

 

 
Figure 7-33 Interconnecting the operation signal (explanatory illustration) 
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Terminal status of D4x5 onboard digital inputs 
The terminal statuses of the SIMOTION D4x5 onboard digital inputs are available in 
parameter r8511[0..15] of the CX32. Additional interconnections can be made on the CX32 
using these. 

Diagnostics with CX32 
Error analysis/correction 
In order to commission a SIMOTION D with CX32, all drive components which were 
configured offline must also be present and connected to the correct DRIVE-CLiQ port. 
Only when there are no topology errors 
● Will the download be successful (where a project created offline is loaded to the target 

system) 
● Will the system startup be successful 
● Can the CX32 modules be accessed online 
Error correction procedure 
If the actual topology of the SINAMICS Integrated is either incomplete or has been inserted 
incorrectly, 
● The RDY LED of the D4x5 remains yellow. 
● The RDY LED and DP1 LED on the CX32 are yellow and red respectively. 
● The CX32 cannot be accessed online in this state. 
Procedure 
Rectifying a topology error 
1. Select "Target System" > "Select Target Devices" in SCOUT. 
2. In the next window, deselect all the target devices apart from the D4x5 and the 

SINAMICS Integrated. 
3. Close the window by clicking "OK". 
4. Now click the "Connect to Target System" button. The D4x5 and the SINAMICS 

Integrated are connected. 
5. Using the alarm window and the topology view of the SINAMICS Integrated, the topology 

error can now be analyzed (for example, a component may be missing or in the wrong 
port). 

6. Switch off the D4x5 and the CX32, rectify the topology error, and switch all devices back 
on again. 

7. Once the SINAMICS Integrated has started up successfully, the RDY LED of the D4x5 
will be green. 
– If the CX32 has been configured and has powered up successfully, the RDY LED and 

DP1 LED of the CX32 will also be green. 
– If, however, the RDY LED on the CX32 is green but the DP1 LED is red, this means 

the CX32 has not yet been configured. If this is the case, perform steps 8 to 11. 
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On the CX32, the RDY LED is green but the DP1 LED is red: 
In this state, the CX32 can be accessed online but has not been configured. 
1. Select the CX32 and select "Connect Online" in the context menu. 
2. Click the "Download CPU/drive unit to target device" button. This will load the CX32 

configuration. 
3. Back up the data to the ROM via "Copy RAM to ROM" in the CX32 context menu. 
4. Once the SINAMICS Integrated and the CX32 have started up successfully, the RDY 

LED of the D4x5 and the CX32 will be green, as will the DP1 LED of the CX32. 

Upgrading the D4x5/CX32 
CX32 modules are always operated with the same firmware version as the SINAMICS 
Integrated of a SIMOTION D. 
This means no additional measures need to be taken for CX32 modules.  
Note that when changing the device version of the SINAMICS, the upgrade for the 
SINAMICS Integrated and for each CX32 must be performed separately. (Context menu 
"SINAMICS drive" > "Target device" > "Device version") 
For information on upgrading a SIMOTION D, refer to Upgrading or replacing D4x5 
(Page 223)  

 

 Note 
Depending on the firmware used, the components are automatically upgraded during 
commissioning. Please note the relevant information in the alarm window of SIMOTION 
SCOUT. 
When the RDY LED flashes yellow at a slow rate (0.5 Hz), this indicates that a D4x5/CX32 
firmware update is in progress. When the RDY LED flashes yellow at a rapid rate (2 Hz), this 
indicates that the firmware update is complete and the components for initializing OFF/ON 
have to be connected. 

 

Replacing a D4x5/CX32 
Replacing a module 
When used as a replacement part, a CX32 behaves like other DRIVE-CLiQ components. 
Exchanging a D445 with a D435 
D445 and D435 modules can be exchanged using Drag&Drop in HW Config. 
It should be noted that a exchanging a D445 with a D435 is not possible if a CX32 has been 
configured with the address 14 or 15 (since a D435 does not have DRIVE-CLiQ ports 
X104/X105, it does not have addresses 14 and 15). 
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7.5 Additional information on configuring the SINAMICS Integrated 

7.5.1 Settings for DP slave properties 

Settings in HW Config 
Depending on the cycle clock ratios (bus cycle clock, servo cycle clock) and the drives used, 
it may be necessary to change the properties of the DP slave (SINAMICS Integrated) on the 
PROFIBUS Integrated. 
Open HW Config. Double-clicking SINAMICS Integrated enables you to display and, if 
required, change the properties of the DP slave on the "Isochronous Mode" tab. Possible 
changes include: 
● Synchronize drive to the equidistant DP cycle 

SINAMICS Integrated and CX32 can only be operated isochronously. For this reason, 
this option cannot be deactivated. 

● Changing the master application cycle (TMAPC) 
The master application cycle must always be the same as the servo cycle clock set 
(setting: "Context Menu of the D4x5" > "Set System Cycle Clocks" in the project tree). As 
long as the DP cycle clock is not scaled to the servo cycle clock, the master application 
cycle will always be the same as the DP cycle clock. 

● Changing the DP cycle (TDP): 
Depending on the requirements in terms of the quantity structures and the response 
times, the DP cycle may need to be changed (see also SIMOTION Basic Functions 
Function Manual). 
In addition, the minimum DP cycle clock for vector drives also depends on the speed 
controller cycle, which in turn depends on the drive quantity structure and device type 
used. This means that, particularly in the case of vector drives, the DP cycle must be 
checked and changed if necessary (see Using vector drives (Page 154)). 

 

 
 

Note 
After TDP has been changed on the PROFIBUS master, the drive system must be 
switched on (POWER ON). 

 

● Changing the TI and TO times 
A change to TI/TO is required in the case of vector drives, for example, where the TI/TO 
time depends on the number of vector drives or, with chassis devices, on the device type 
used. 

If you are changing settings for the SINAMICS Integrated, you must also change the settings 
on the CX32 modules accordingly. This is easily done by using the Align button to transfer 
the settings for all the CX32 modules. 
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       Figure 7-34 HW Config - settings 

 

Additional references 
For additional information, please refer to the 
● SINAMICS S120 Function Manual 
● SIMOTION Basic Functions Function Manual 

7.5.2 Using vector drives 
Changes need to be made in HW Config when using SINAMICS vector drives. This means, 
for example, that the TI/TO time and the minimum DP cycle depend on the number of vector 
drives or, with chassis drives, on the device type used as well. 
Therefore, we recommend adopting the following procedure is when using vector drives with 
SIMOTION D4x5. 
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Scenario 1: Current and speed controller cycle is known 
As long as you know the current and speed controller cycle, you will be able to determine 
times TMAPC, TDP, TI, and TO . Where there are several drives with different cycle clocks, the 
largest cycle clock must be used for the current and speed controller cycle. 

Procedure 
1. Open HW Config. Double-clicking SINAMICS Integrated allows you to change the 

properties of the DP slave on the "Isochronous Mode" tab. 
2. For TI = TO =, enter an integer multiple of the current controller cycle. 
3. For TDP, enter an integer multiple of the speed controller cycle. For drives on the 

SINAMICS Integrated, TDP >= TO must always apply. 
4. Enter TMAPC = TDP (exception: You are working with cycle clock scaling; i.e. servo cycle 

clock > DP cycle clock). 
5. Use the "Target system" > "Load" > "Project to target system" menu command to load the 

parameterization to the SIMOTION D4x5. 
6. After the download has successfully completed, you should determine the current and 

speed controller cycles of the drives from the drives' expert lists, as the cycle clocks are 
set in the SINAMICS drive unit after a project has been downloaded. 
p115[0]: Current controller cycle 
p115[1]: Speed controller cycle 

7. If the current and speed controller cycles from the expert lists are different to the cycle 
clocks used in steps 2 and 3, you will have to repeat the steps with the current values for 
the current and speed controller cycles. 

Table 7- 2 Example for power units in booksize format (vector drives) 

Example Settings 
1 or 2 vector drives 
Current controller cycle = 250 µs 
Speed controller cycle = 1 ms 

TI = TO = at least 250 µs  
TDP = 1 ms (... or 2 ms, 3 ms, ....) 
TMAPC = TDP 

3 or 4 vector drives 
Current controller cycle = 500 µs 
Speed controller cycle = 2 ms 

TI = TO = at least 500 µs  
TDP = 2 ms (... or 4 ms, 8 ms, ....) 
TMAPC = TDP 

 
 

 Note 
Vector drives in chassis format can also be operated with a current controller sampling time 
of 400 µs, amongst other settings. 

 

In a SIMOTION context, the following should be considered: 
● A current controller sampling time of 400 µs is only possible if a CU310/CU320 is used for 

control, and this is not operated isochronously via PROFIBUS/PROFINET on  
SIMOTION D. 

● If the bus is operated isochronously, only cycle clocks with an integer multiple of 125 µs 
are possible (instead of 400.0 µs, 375.0 µs or 500 µs, for example). 
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● The PROFIBUS Integrated of a D4x5/CX32 is always isochronous! This means a current 
controller sampling time of 400 µs is not possible. 

● With CU parameter p0092 = 1, the sampling times are pre-assigned so that isochronous 
operation with a control system is possible. 

Scenario 2: Current and speed controller cycle is not known 
This procedure is especially suitable for devices in chassis format, as the current and speed 
controller cycle also depends on the relevant device type. 
1. In order to determine which cycle clocks are set in the SINAMICS drive unit after a project 

has been downloaded, first enter reliable values for the cycle clocks in HW Config. 
2. Use the "Target system" > "Load" > "Project to target system" menu command to 

download the parameterization. 
3. After the download has successfully completed, you will be able to determine all the 

current and speed controller cycles of the drives from the drives' expert lists. 
p115[0]: Current controller cycle 
p115[1]: Speed controller cycle 

4. 4. If required, it is now possible to optimize the TMAPC, TDP, TI , and TO times in HW Config 
(see procedure for Scenario 1). 

 

Table 7- 3 Recommended cycle clock settings in HW Config 

Setting Explanation 
TDP = 3.0 ms TDP = DP cycle time 
TI = TO = 1.5 ms TI = time of actual value acquisition 

TO = time of setpoint transfer 
TMAPC = 3.0 ms TMAPC = master application cycle time 

Additional references 
Additional information on quantity structures and cycle clock settings can be found in the 
SINAMICS S120 Function Manual. 

See also 
Settings for DP slave properties (Page 153) 
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7.5.3 Setting the time of day 

Time on SIMOTION (real-time clock) 
SIMOTION D4x5 has an integrated real-time clock. All events on a module (alarms, 
messages, etc.) are "time-stamped" based on the time shown by this real-time clock. 
To set the clock from SIMOTION SCOUT, select the D4x5 in the project tree, followed by 
"Target System" > "Set Time". 
Alternatively, the clock can be set using the "rtc" system function block. 

SINAMICS system runtime (operating hours meter) 
With SINAMICS S120 Control Units and the SINAMICS Integrated of a SIMOTION D4x5, 
faults and warnings are "time-stamped" on the basis of the system runtime. This means that 
events are recorded in terms of operating hours rather than in terms of a particular time of 
day or date. 
System runtime 
The entire system runtime is displayed in CU parameter p2114.  
● p2114[0] indicates the system runtime in milliseconds. After reaching 86,400,000 ms (24 

hours), the value is reset. 
● p2114[1] indicates the system runtime in days. 
At power-off the counter value is saved. After the drive unit is powered-up, the counter 
continues to run with the value that was saved the last time that the drive unit was powered-
down. 
As a result, the drive displays the system runtime from 00:00:00 on 01/01/1992 in both the 
alarm window in SIMOTION SCOUT and the diagnostic buffer for entries.  
If faults and warnings need to be "time-stamped" based on a time of day, "Time-stamp 
operating hours" needs to be changed to "Time-stamp UTC format" as described below. 

Setting the time of day on SINAMICS 
Changing to UTC format 
CU parameter p3100 can be used to change the time-stamping mode from operating hours 
to UTC format.  
● p3100 = 0: Time stamp based on operating hours 
● p3100 = 1: Time stamp based on UTC format (UTC: Universal Time Coordinates) 
According to its definition, UTC time begins at 00:00:00 on 01/01/1970 and is expressed in 
days and milliseconds. 
Displaying the current UTC time in the drive system 
p3102[0]: Milliseconds 
p3102[1]: Days 
SIMOTION can transfer the time of day to the drive using a PING mechanism. This is only 
possible, however, if the SIMOTION time format (RTC, Real Time Clock) is converted to the 
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UTC format. To compensate for deviations between the SIMOTION and SINAMICS clocks, 
the time of day must be reset on a regular basis (e.g. hourly). 
When doing this, please note the following: 
● "Time/date to be set" is after "Time/date on SINAMICS": Time and date on SINAMICS is 

updated. 
● "Time/date to be set" is before "Time/date on SINAMICS": The SINAMICS clock must be 

stopped until the SINAMICS "Time/date" has caught up with "Time/date to be set". 
Adopting this procedure ensures that the sequence of SINAMICS diagnostic buffer entries 
remains the same, even if the time of day is reset. 

Additional references 
For more information on this topic, refer to the Online Help. There is also a sample program 
on the SIMOTION Utilities & Applications CD. The SIMOTION Utilities & Applications CD is 
provided as part of the SIMOTION SCOUT scope of delivery. 

7.5.4 SINAMICS diagnostic buffer 
The diagnostic buffer of the SINAMICS Integrated can be displayed in SIMOTION SCOUT 
for SIMOTION version V4.1 SP2 and higher.  
To enable this, select the SINAMICS Integrated in the project tree, followed by "Target 
System" > "Device Diagnostics". 
In addition, the SINAMICS diagnostic buffer entries are displayed in the D4x5 device 
diagnostics. Here, all D4x5 diagnostic buffer entries are displayed first, followed by those of 
the SINAMICS Integrated. The start of the SINAMICS Integrated diagnostic buffer entries is 
marked by an entry: 
"Start of SINAMICS Integrated diagnostic buffer, station address = x" 
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7.5.5 Acyclic communication with the drive 

Overview 
PROFIdrive drive units are supplied with control signals and setpoints by the controller and 
return status signals and actual values. These signals are normally transferred cyclically (i.e. 
continuously) between the controller and the drive. 
For SINAMICS S120, configure the axis message frames for data exchange (see Performing 
offline configuration for the D4x5 (Page 118)). 
As well as offering cyclic data exchange, PROFIdrive drive units have an acyclic 
communication channel. In particular, this is used for reading and writing drive parameters 
(e.g. error codes, warnings, controller parameters, motor data, etc.).  
As a result, data can be transferred on an "acyclic" as opposed to a "cyclic" basis when 
required. Acyclic reading and writing of parameters for PROFIdrive drives is based on the 
DP V1 services "read data record" and "write data record". 
The acyclic DP V1 services are transferred as cyclic communication takes place PROFIBUS 
or PROFINET. The PROFIdrive profile specifies precisely how these basic mechanisms are 
used for read/write access to parameters of a PROFIdrive-compliant drive. 
The PROFIdrive standard states that "pipelining" of jobs on PROFIdrive drives is not 
supported. This means: 
● Only one "write/read data record" can be performed at any one time on a drive unit (e.g. 

SINAMICS S120 Control Unit or the SINAMICS Integrated of a SIMOTION D). 
● However, if several PROFIdrive drive units are connected to a controller, a job can be 

processed for each of these drive units at the same time. In this case, the maximum total 
number of jobs will depend on the control (for SIMOTION, this is a maximum of 8 jobs at 
a time). 

For acyclic data exchange with SINAMICS drives, this means you will have to coordinate the 
write/read jobs with each other (buffer managemenr). An interlock must be set to prevent the 
application or different parts of the application from sending overlapping jobs to the same 
PROFIdrive drive unit. 

Additional references 
Additional information on how to use DP V1 services can be found in the SIMOTION 
Communication System Manual. 
The SIMOTION Utilities & Applications CD also has a DP V1 library with functions able to 
take over coordination tasks commonly associated with acyclic communication. The library 
does not coordinate access to the system functions 
(_ReadRecord/_WriteRecord/_readDriveParameter/_writeDriveParameter/, etc.), but 
expands the range of functions for frequently requested tasks such as time of day 
synchronization. 
The SIMOTION Utilities & Applications CD is provided as part of the SIMOTION SCOUT 
scope of supply. 
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The following functions are amongst those available in the DP V1 library: 
● Buffer management (coordination of a number of parallel DP V1 services) 
● StartUp (function for coordinating the power-up of the SINAMICS drive with SIMOTION) 
● TimeSync (time of day synchronization: Transfer of SIMOTION time of day to the 

SINAMICS drives) 
● SetActIn (activating/deactivating objects in SIMOTION and SINAMICS) 
● RwnPar (reading and writing of drive parameters) 
● GetFault (reading errors and warnings from the drive) 

7.5.6 Control properties and performance features 
With a few exceptions, the integrated drive control of SIMOTION D4x5 has the same control 
properties and performance features as the SINAMICS S120 CU320 Control Unit.  
We would particularly like to draw your attention to the following points: 
● The SINAMICS Integrated has no basic positioner (EPOS). EPOS functionality is 

provided by SIMOTION technology functions. 
● The BOP20 Basic Operator Panel cannot be connected to the SIMOTION D4x5. 

 

NOTICE  
 

With the SIMOTION D4x5, the expert list of the Control Unit in parameter p972 (drive 
unit reset) must not be used for resetting the drive. This leads to a fault on the 
SIMOTION D4x5, with all 8 status LEDs flickering red. In this fault situation, the 
SIMOTION D4x5 must be switched off and on again. 
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7.6 Testing the configured drive 

Introduction 
You can test a configured drive with the drive control panel, where you can specify a speed 
and adjust it with a scaling factor. The drive control panel should only be used for 
commissioning purposes.  

Prerequisites 
● The project has been downloaded to the target system. 
● SIMOTION SCOUT is in online mode. 
● The drive is not being used by a current project in RUN mode. 

 

WARNING  
 

Make sure no one is endangered by the drive test. 
 

Testing a drive with the drive control panel 
1. Open the "Commissioning" object below the drive in the project navigator and double-

click "Control Panel". The drive control panel is displayed in the detail view. 

 
 Figure 7-35 Drive control panel 

 
2. To display the control range and axis diagnostics, click the "Show/hide control range" and 

"Show/hide diagnostics area" buttons. 
3. Click "Assume control priority". The "Assume control priority" dialog box is opened. 
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Note 
If you are using an infeed without a DRIVE-CLiQ interface, you will have to interconnect 
the "Infeed operation" signal (drive parameter p864) yourself. If you are using an infeed 
with a DRIVE-CLiQ interface, select the infeed for which the control priority is to be 
assumed under "Infeed" in the "Assume control priority" dialog box. 
If the infeed is already switched on (e.g. via terminal connection), you cannot assume 
control priority (the infeed or its associated selection will be displayed as disabled). 
The infeed must be switched on before the drive can move ("LM" button, switch infeed 
on/off). 

 

 
Figure 7-36 Assuming control priority 

 
4. Read the notices and click "Accept" to confirm. 
5. Select the "Enables" check box to enable the drive. 

All enables are now set except ON/OFF1. 
6. Enter the desired setpoint in the entry field, and, as a safety setting, slide the scaling to  

0 %. 
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            Figure 7-37 Entering a setpoint 

 
7. Click the "Drive On" button. The green "Enable available" LED lights up. If you move the 

slider to the right, the drive rotates. The current motor speed is displayed under "Actual". 
8. Click "Drive Off" to stop the drive after the test. 
9. Deactivate the enable and click the "Give up control priority" button to deactivate the 

control from the PG/PC. In this state, you can no longer make the drive rotate. 

7.7 Creating and testing axes 

7.7.1 Overview of SIMOTION engineering 

Performing engineering with SIMOTION SCOUT 
You use the engineering software to configure the individual axes and define the project 
sequence by means of programs.  
1. First, run the axis wizard to configure the axes and interconnect to the real drive 

(SINAMICS Integrated). 
2. Then, select the "SINAMICS_Integrated" in the project navigator and deactivate the 

"Connect Online" option in the context menu. This only downloads the project to the 
SIMOTION D4x5. 
Provided you have completed configuration at the drive end, we strongly recommend you 
deactivate the SINAMICS Integrated so that work can be carried out faster. 

3. Complete your SIMOTION application, for example, by creating axis functions and 
SIMOTION execution programs. 

4. Compile the project and download it to the SIMOTION D4x5. 

See also 
Overview of offline configuration (Page 118) 
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7.7.2 Creating an axis with the axis wizard 

Overview 
Axes are integrated as technology objects (TO) in SIMOTION. The axes are created with the 
appropriate settings under the inserted SIMOTION D4x5 and then interconnected to the real 
drive.  

Inserting an axis 
1. In the project navigator, double-click the entry "Axis" > "Insert Axis". 

This will access the axis wizard. 

 
Figure 7-38 Inserting an axis 

 
2. Run the wizard and enter the settings for your system until the "Drive Assignment" dialog 

appears. 

 
Figure 7-39 Assigning a drive 
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3. Click "Align SINAMICS Devices" to display the "Device Alignment" dialog. 

 
Figure 7-40 Device alignment 

 
4. Select the drives to align and click "Align". 

The message frame addresses of the selected drives will be aligned. Note, however, that 
drives that are configured but whose data have not been transferred to HW Config, and 
drives that are configured with "free message frame configuration with binary connector" 
will not appear in this dialog. 

 

 
 

Note 
The device alignment must only be performed if this was not done when the drive was 
being commissioned. You can tell that device alignment has not been performed if there 
is no interconnectable SINAMICS Integrated drive available in the list of drives. 

 

5. Select the "SINAMICS_Integrated" from the list of drive devices and complete the 
settings. 
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6. To do this, click the "Accept data from the drive" button to transfer the SINAMICS 
Integrated values in the axis wizards. 

7. Select the encoder from the "Encoder Assignment" dialog box and then adapt its 
properties. Click the "Accept data from the drive" button to transfer the SINAMICS 
Integrated values in the axis wizards. 

 

 
 

Note 
For motors with DRIVE-CLiQ interface, a "Accept data from the drive" automatically 
transfers the determined drive and encoder data (e.g. encoder type). This requires that 
the data has already been fetched from the attached devices. Namely, an offline 
configuration has already been used to establish an online connection or an online 
configuration has been performed. 

 

8. Work through the remainder of the wizard. 

Result 
The configured axis will appear in the project navigator. You can now test this axis with the 
axis wizard. 

7.7.3 Testing the axis with the axis control panel 

Axis control panel 
The axis control panel is used exclusively for testing axes. You can use the axis control 
panel for the following tasks, for example:  
● To test each part of the system individually before program-driven axis motions are 

initiated. 
● In the event of an error, to test whether the individual axes and drives can be traversed 

from the axis control panel 
● To traverse the axes for optimization purposes (controller optimization) 
● To perform active homing 
● To set and remove the axis enable 
● To test an axis that has been created 

Requirement 
The following requirements must be fulfilled for testing: 
● The project has been downloaded to the target system. 
● SIMOTION SCOUT is in online mode. 
● The mode selector is in position STOP_U. 

Operate the mode selector only via SIMOTION SCOUT ("Target system" > "Control 
operating mode"). 
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Axis test 
1. Open the AXES folder in the project navigator and click the "Control Panel" entry below 

the axis (for example, Axis_1). 
The axis control panel is displayed. 

 
Figure 7-41 Axis control panel 

 
2. To display the control range and axis diagnostics, click the "Show/hide control range" and 

"Show/hide axis diagnostics" buttons. 
3. Click "Assume control priority". 

Confirm the notice that appears with "Yes" to set the control to STOPU mode. 
 

 
 

Note 
In order to move the axis from the PG/PC, you must assume control priority. However, by 
pressing the SPACER bar, you can stop the axis at any time. 
If you are using the axis control panel for a real axis, you must first activate the infeed for 
SINAMICS drives before the axis can be moved. The infeed must be activated before you 
enable the axis. 

 

4. The "Assume control priority" dialog box is opened. 
Read the notices and click "Accept" to confirm. 

5. Activate the infeed (either using message frame 370 or via a BICO interconnection; refer 
to the section entitled "Activating the infeed (Active Line Module"). 

 

 
 

Note 
If you are using an infeed without a DRIVE-CLiQ interface, you will have to interconnect 
the "Infeed operation" signal (drive parameter p864) yourself. 
If you are using an infeed with a DRIVE-CLiQ interface, select the infeed for which the 
control priority is to be assumed under "Infeed" in the "Switch axis enable" dialog box. 
Select this checkbox when the control priority is to be fetched and activated. 
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6. To enable the axis, click the "Set/remove enable" button. 
Confirm the "Switch axis enable" dialog with with "OK". 

7. To enable jog mode, click the "Position-controlled traversing of the axis" button. 
8. Confirm the "Switch axis enable" dialog that appears with with "OK". 
9. Click "Motion" to move the axis. You can monitor the traversing motion under speed and 

position. Use "Stop motion" to stop axis movement again. 
10. To cancel the enable, click the "Set/remove enable" button. Confirm the "Remove axis 

enable" dialog with with "OK". 
11. Click the "Control priority of infeed" button to deactivate the infeed. 
12. Click the "Give up control priority" button to deactivate axis control from the PG/PC. In 

this operating mode, the axes can no longer be controlled from the PG/PC. 

7.8 Activating the infeed (line module) 

7.8.1 Activating the line module via PROFIBUS message frame 

Requirement 
To commission the SINAMICS Integrated, the line module must be activated. If, for example, 
you try to commission a drive without first activating the line module, an error message is 
issued.  

 

 Note 
The following description refers to a commissioning based on factory settings and a standard 
assignment of the control/checkback interface according to PROFIdrive. (Use of message 
frame 370)  
Refer to the SINAMICS S120 Commissioning Manual for a description of this procedure. 
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Control of infeed 
For control purposes, when the infeed is inserted in SIMOTION SCOUT, an appropriate 
binary connector interconnection is predefined and preassigned with default settings.  
In order to activate the infeed via message frame 370, you must create the message frame 
370: 
1. In the project navigator, double-click "Configuration" under "SINAMICS_Integrated". 
2. Select Message frame 370 on the "PROFIBUS Message Frame" tab. 

 
Figure 7-42 Selecting message frame 370 

 
3. Click the "Transfer to HW Config" button. The addresses for the PROFIBUS message 

frame are entered. 

 
Figure 7-43 Start addresses for input and output data 

 
4. Use the "Target system" > "Load" > "Project to target device" menu command to 

download the project to the SIMOTION D4x5. 
5. Now, create the start addresses for the input and output data as I/O variables in the 

symbol browser. 
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Figure 7-44 Creating I/O variables in the symbol browser 

 
6. In the row of output data in the "Control value" column, enter the required enables in the 

control word. The structure of the control word is described in the "Bit pattern of the 
control word" table. 

7. Monitor the status transitions of the infeed in the status word. The structure of the status 
word is described in the "Bit pattern of the status word" table. 

The infeed is enabled by issuing the appropriate control signals. Please note that the scope 
of available control and status signals depends on the infeed type (ALM, SLM, BLM). 

PROFIBUS control word 
To display the PROFIBUS control and status word, select the "SINAMICS_Integrated" > 
"Infeed" > "Control logic" menu command. 
● The relevant bit pattern of the control word showing the available parameters can be 

seen under "Control word, execution control". 
● The relevant bit pattern of the status word showing the available parameters can be seen 

under "Status word, infeed sequence control". 
The table below provides an overview of the control signals available for the respective 
infeed. 

Table 7- 4 Bit pattern of the "Infeed sequence control" control word 

Bit ALM SLM BLM Meaning 
0 x x X = ON (pre-charging contactor/line contactor closed, pulses can be enabled) 

0 = OFF1 (reduce Vdc along the ramp, pulse cancellation and pre-charging 
contactor/line contactor open) 

1 x x x 1 = No OFF2 (enable is possible) 
0 = OFF2 (immediate pulse cancellation and power-on inhibit) 

2    Reserved 
3 x x  1 = Enable operation (pulses can be enabled) 

0 = Inhibit operation (cancel pulses) 
4    Reserved 
5 x   1 = Inhibit motoring 
6 x x  1 = Inhibit regenerative operation 
7 x x X  = Acknowledge faults 
8    
9    

Reserved 

10 x x X 1 = Control via PLC 
11    
12    

Reserved 
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Bit ALM SLM BLM Meaning 
13    
14    
15    

ALM = Active Line Module; SLM = Smart Line Module; BLM = Basic Line Module 

 
The table below provides an overview of the status signals available for the respective 
infeed. 

Table 7- 5 Bit pattern of the "Infeed sequence control" status word 

Bit ALM SLM BLM Meaning 
0 x x x Ready to power up 
1 x x x Ready for operation 
2 x x x Operation enabled 
3 x x  Fault active 
4 x x x "No OFF2" active 
5    Reserved 
6 x x x Power-on inhibit 
7 x x  Warning present 
8    Reserved 
9 x x x Control by PLC 
10    Reserved 
11 x x x Pre-charging completed 
12 x x x Line contactor (bypass connector) closed feedback message 
13    
14    
15    

Reserved 

ALM = Active Line Module; SLM = Smart Line Module; BLM = Basic Line Module 

 
Further information about the PROFIBUS control and status word incl.flow diagrams for the 
activation of the line modules can be found in the SINAMICS S120 Drive Functions Function 
Manual. 

Message frame 370 
The transfer of the control and status word between the SIMOTION D4x5 and the drive unit 
is performed by means of message frame 370. In addition to message frame 370, you can 
also use the "Free message frame configuration via BICO". 

_ALM_control 
The _ALM_control function block can be used to not only enable and disable the active line 
module (ALM), but also perform a simple diagnosis. The _ALM_control function block cannot 
be used for Basic Line Modules (BLM). 
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The _ALM_control function block is part of the command library of the "SIMOTION SCOUT" 
engineering system. For detailed information on the _ALM_control function block, please 
refer to the Standard Function for Active Line Modules (ALM) Function Manual. 

Additional references 
For a detailed description of the control words and status words of the PROFIBUS message 
frames for SINAMICS S120 drives, refer to the SINAMICS S120 Commissioning Manual. 

7.8.2 Activating the line module with a motion task 

Creating a motion task 
The following example shows how an Active Line Module (ALM) is activated. The control 
sequence is created in MCC and must be called via a motion task. 

 

 Note 
A setpoint error is present on the infeed following a transition from RUN to STOP. This error 
must be acknowledged before the infeed is activated again. To ensure this happens, it is 
recommended that you first acknowledge the errors in the motion task and then activate the 
infeed.  
If you select the "Network/DC Link Identification" option when configuring the infeed, the DC 
link for your system is measured (phase, etc.) and saved as non-volatile data during initial 
commissioning. The activation of the infeed will therefore take longer the first time. 

 

The regulated infeed can be enabled by means of a motion task. 

Switching on the ALM 
To enable an ALM, you can proceed as follows: 
1. Configure infeed with message frame 370 
2. Create the I/O variables at the configured infeed address 
3. The I/O variables alm_snd and alm_rcv of data type WORD must be created for this. 

Create an MCC program and integrate this in a motion task (e.g. motion task 7) 
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Table 7- 6 Motion task to enable the infeed 

Task Meaning 

 

Control ALM: 
Bit 10  = 1: Request control by PLC (corresponds to 
16##0400 hex) 

 

Query status: 
Bit 9  = 1: Control by PLC set? 
Bit 6  = 1: Switch-on inhibit set? 
Bit 3 = 0/1: Fault may be present 
(corresponds to 16##0248 hex or 16#240 hex) 

 

Control ALM: 
Bit 10  = 1: Control by PLC 
Bit 7  = 1: Acknowledge faults (edge 0 -> 1) 1) 
Bit 3  = 1: Enable operation 
Bit 1  = 1: No OFF 2 (enable possible) 
 (corresponds to 16##048A hex) 

 

Query status: 
Bit 9  = 1: Control by PLC set? 
Bit 4  = 1: "No OFF2" active? 
Bit 0  = 1: Ready to start? 
(corresponds to 16##0211 hex) 

 

Control ALM: 
Bit 10  = 1: Control by PLC 
Bit 7  = 1: Acknowledge faults  
Bit 3  = 1: Enable operation 
Bit 1  = 1: No OFF 2 (enable possible) 
Bit 0  = 1: ON (edge 0 -> 1) 
(corresponds to 16##048B hex) 
 
The DC link is precharged and the line contactor 
closed with the ON signal. The "Closed-loop control 
operation" signal (r863.0) of the infeed and therefore 
the "Infeed operation" signal (p864) on the drives are 
set. 

Switching off the ALM 
To switch off the Active Line Module, carry out the steps for switching it on in reverse order. 
Before the infeed is switched off, the drives connected to the DC link should be in pulse 
inhibit mode. 
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7.9 Linking an additional encoder 

7.9.1 Fundamentals 

Using encoders 
SIMOTION D provides the option of integrating and configuring further encoders in addition 
to the motor encoder. 
The following encoders are supported for operation with SIMOTION D: 
● Encoders with DRIVE-CLiQ interface 
● Encoders connected to a CU310 or CUA32 via the onboard encoder interface 
● Encoders connected to SIMOTION D4x5 using an SMx module 
● Encoders connected using PROFIBUS or PROFINET 

Configuring two encoders 
The additional encoder can be used in SIMOTION, for example, as: 
● Machine encoder (second encoder) 
● External encoders 
● Encoder for hydraulic axes 
You can use the external encoder, for example, to pick up an actual position value directly 
on the drive axis of a gear unit. If you are operating a second encoder as a machine 
encoder, you can work with encoder switchover. 

Configuration tasks 
Encoders connected using PROFIBUS or PROFINET are configured only for SIMOTION. 
Encoders connected using SMx, DRIVE-CLiQ, or the onboard encoder interface 
(CU310/CUA32), must be configured for the drive (SINAMICS Integrated) and SIMOTION. 
● Configure the second encoder in the drive wizard of the corresponding drive 
● Configuring a second encoder for the TO axis in SIMOTION 
● You can configure the second encoder as one of the following: 

– External encoder 
– Hydraulic axis 
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7.9.2 Configuring a second encoder on the SINAMICS Integrated 

Requirement 
You have configured the drive in the drive wizard. 

Procedure 
1. In the project navigator, open the "Configuration" entry under your drive using the 

"SINAMICS_Integrated" > "Drives" menu command. The "Configuration" dialog box is 
opened. 

2. Click the "Configure DDS..." button to open the drive wizard. 
3. Work through the drive wizard until you reach the "SINAMICS_Integrated - Encoders" 

dialog. 
4. Select the "Encoder 2" option. 

A list of the available encoders will be displayed. 
5. Select the connected encoder and confirm with "Next". 
6. In the "Configuration - SINAMICS Integrated - PROFIBUS (drive) Process Data 

Exchange" dialog box, select a message frame that supports the transmission of two 
encoder values (e.g. SIEMENS message frame 106, PZD-11/15). 

7. Click the "Next" button to work through the remainder of the drive wizard. 
8. In the "SINAMICS_Integrated - Configuration" dialog, click the "Transfer to HW Config" 

button to perform a HW Config alignment. 

Result 
The drive is configured with two encoders. 

7.9.3 Configuring a second encoder for the Axis technology object in SIMOTION 

Requirement 
You have configured the SINAMICS Integrated with two encoders, performed a HW Config 
alignment, and selected a message frame that can transfer two encoder values. 

Procedure 
1. In the project navigator, open the Axis Wizard of the axis. 
2. In the "Drive Assignment" dialog box, select the same message frame that you have 

already used to configure the second encoder on the SINAMICS Integrated or the 
"SINAMICS Integrated > Configuration" screen form (e.g. SIEMENS message frame 106, 
PZD-11/15). 

3. Work through the remainder of the axis wizard. 
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Result 
You have configured a second encoder for an Axis technology object in SIMOTION. The set 
message frame type enables you to use the value of a second encoder. 

7.9.4 Configuring an external encoder in SIMOTION 
An external encoder allows you to determine the position values of a drive without an 
associated axis. 

Encoder using PROFIBUS/PROFINET 
You have used HW Config to configure an encoder on the PROFIBUS or PROFINET. Two 
different possibilities are available for the encoder connection: 
● Encoder interconnection using a PROFIdrive message frame (encoder with message 

frame type 81) 
● Encoder interface as a direct value in the I/O area 

Additional references 
Detailed information is contained in the SIMOTION TO Axis, Electric/Hydraulic, External 
Encoder Function Manual 

Encoder on the drive 
You have configured a drive with two encoders and then an electric axis with the PROFIBUS 
message frame to be used. This procedure is described below. 

Requirement 
You have configured a drive with two encoders and then an electric axis with the PROFIBUS 
message frame to be used. 

Procedure 
1. In the project navigator, select "External Encoder" > "Insert External Encoder" to open the 

wizard for configuring an external encoder. 
2. Work through the wizard until the "Drive Assignment" dialog box. 

The following parameters, among others, will be displayed in this dialog: 
– Encoder input, SINAMICS Integrated in this case 
– Encoder number, encoder 2 of the drive in this case 

3. Click the "Next" button and complete the configuration of the external encoder. 
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Result 
The external encoder is configured and uses the second value, which is transferred by 
means of the selected PROFIBUS message frame. 

Additional references 
Detailed information is contained in the SIMOTION TO Axis, Electric/Hydraulic, External 
Encoder Function Manual 

7.9.5 Configuring a hydraulic axis in SIMOTION 
The hydraulic axis can use a Q-valve, for example, and control it by means of an analog 
output module. In order to determine the actual position value, the encoder required can be 
integrated as follows: 
● Encoder using PROFIBUS/PROFINET 

(refer to the SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual) 
● By using an encoder connected to the drive (see description below) 

Requirement 
You have already configured a drive with two encoders and created an electric axis. 

Procedure 
1. In the project navigator, open the axis wizard via "Axis" > "Insert Axis". 
2. Work through the axis wizard until the "Axis Type" dialog box. 
3. Select the "Hydraulic" axis type and define the valve type and the control. 
4. Run through the axis wizard until the "Encoder Assignment" dialog box. 
5. Select the entry for the SINAMICS Integrated in the "Where Is the Position Encoder 

Connected?" field. 
6. Work through the remainder of the axis wizard to complete the hydraulic axis 

configuration. 

Result 
The hydraulic axis uses the second encoder of the relevant drive of the SINAMICS 
Integrated as its encoder. 

Additional references 
Refer to the SIMOTION TO Axis, Electric/Hydraulic, External Encoder Function Manual. 
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7.10 Configuring drive-related I/Os 

7.10.1 Onboard I/Os and Terminal Modules configuration overview 

Using SINAMICS I/Os by SIMOTION 
Drive-related I/Os assigned to SINAMICS can be used either completely or partially by 
SIMOTION. Examples here are the use of Terminal Modules (TMs) or onboard I/Os of the 
D4x5. To allow the I/Os to be used by SIMOTION, the input and output data must be 
transferred using message frames. This message frame configuration is used to represent 
the I/Os in the logical address space of SIMOTION and so can be used by a SIMOTION 
application. The BICO interconnections on the drive specify which I/Os are represented on 
the message frame. 
These BICO interconnections can be: 
● Freely defined (free message frame configuration; message frame extension). 
● Permanently defined (standard message frames, e.g. message frame 39x; axis message 

frames). . .) 
● Configuration dependent (TM15/TM17 High Feature). 
With the SIMOTION D4x5, message frames are accessed via I/O variables or input/output 
addresses. Depending how the I/Os are to be used, various configuration possibilities are 
appropriate:  

Table 7- 7 Use of I/Os by SIMOTION, overview 

Configuration Description Applications Supported I/Os 
(drive objects) 

Use of message frame 
39x 

Message frames 39x are available 
to enable access to the onboard 
I/Os of a Control Unit (D4xx, 
CU310, CU320, CX32) from 
SIMOTION. 

Configuration when, for example, 
all SIMOTION I/Os are to be 
used. Use of: 
• High-speed outputs of output 

cams 
• Onboard DI/DO 
• Global measuring inputs 

• Onboard I/Os on 
the D4x5 

• Onboard I/Os on 
CU320 CU310, 
CX32 (no high-
speed cam 
outputs) 

Free message frame 
configuration with 
P915/P916 
(TM15/TM17 High 
Feature special case) 

For the TM15/TM17 High Feature, 
when the module is created, an 
automatic interconnection to a 
"free message frame with 
P915/P916" is made. This means 
TMs are available exclusively for 
SIMOTION. 

Use of TM15 and TM17 High 
Feature for: 
• High-speed DI/DO 
• Outputs of output cam 
• Inputs for measuring inputs 

• TM15 
• TM17 High 

Feature 
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Configuration Description Applications Supported I/Os 
(drive objects) 

Free Message Frame 
Configuration via BICO 

Dedicated message frame for the 
data transmission are assigned to 
the associated drive objects. The 
"free message frame configuration 
using BICO", message frame 999, 
is used for the data transmission 
here. 

Preferred solution when I/Os are 
to be divided between 
SIMOTION and SINAMICS and 
a module view is preferred. The 
message frame, for example, is 
created on a drive object (for 
example, on a TM or a Control 
Unit). 

• Onboard I/Os on 
the D4x5, CX32 

• Onboard I/Os on 
the CU320, CU310

• TM15 DI/DO 
• TM31 
• TM41 
• TB30 

Extending a message 
frame 

For the purposes of transmitting 
the I/O data, existing message 
frames are extended to include the 
process status data (PZD). These 
additional PZDs must then be 
interconnected using BICO. 

Preferred solution when I/Os are 
to be divided between 
SIMOTION and SINAMICS and, 
for example, an axis view is 
preferred. (Drive-related I/Os are 
appended to each axis message 
frame.) 

• Onboard I/Os on 
the D4x5, CX32 

• Onboard I/Os on 
the CU320, CU310

• TM15 DI/DO 
• TM31 
• TM41 
• TB30 

 

 Note 
The module hardware for TM15 and TM15 DI/DO is identical. The differentiation is made 
only with the addition of the component in the project navigator of the SIMOTION SCOUT 
using "Inserting input/output component". 
Further information about the TM15 and TM17 High Feature can be found in the TM15 and 
TM17 High Feature Commissioning Manual. 

 

 Note 
The "free message frame configuration using BICO" and the "message frame extension" 
allow you to use inputs/outputs channel-granular by SIMOTION or SINAMICS. 
For message frame 39x, however, all onboard terminals are interconnected automatically to 
message frame 39x using BICO interconnections and so available only for SIMOTION. The 
following is true: 
• All onboard I/Os configured as digital output for the drive are only available for 

SIMOTION, i.e. they can no longer be used by SINAMICS. 
• Digital inputs can be used by SIMOTION and SINAMICS. 
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7.10.2 Use of message frame 39x 
The following section describes the configuration of the onboard I/Os of a SIMOTION D4x5. 
Configuration of the onboard I/Os of a CU310, CU320, or CX32 Control Unit connected to a 
SIMOTION controller is carried out in much the same way in each case. With the exception 
of the "high-speed output cams/DOs", the same functionality as the D4x5 is available on a 
CU310/CU320/CX32. 

Functionality of the 390, 391 and 392 message frames 
A Control Unit's onboard I/Os assigned to SINAMICS can be used by SIMOTION with 
message frames 39x. This functionality is available as of SIMOTION V4.1, SP1. If a 
message frame 39x is set, however, all the onboard I/Os are interconnected automatically to 
this message frame 39x using BICO interconnections and so available for SIMOTION. All 
onboard I/Os of a Control Unit that are parameterized as a digital output are available for 
SIMOTION only. Digital inputs can be used by both SIMOTION and SINAMICS. 
In addition to the use of the onboard I/Os, the 39x message frame permits the use of:  
● High-speed outputs for output cams and high-speed digital outputs (DO) 
● "Global" measuring inputs 
● The control and status word of the Control Unit (CU_STW, CU_ZSW) 
Depending on the selected 39x message frame type, various functionalities can be used. 

Table 7- 8 Functionality of the 390, 391 and 392 message frames, overview 

Telegram Functionality available on the DI/DO  
 D4x5 CX32, CU310, CU320 
390 • CU_STW, CU_ZSW 

• I/O access to the DIs and DOs 
• Maximum of 8 high-speed output 

cams/DOs 

• CU_STW, CU_ZSW 
• I/O access to the DIs and DOs 

391 • CU_STW, CU_ZSW 
• I/O access to the DIs and DOs 
• Maximum of 8 high-speed output 

cams/DOs 
• Maximum of two inputs for 

measuring inputs (global 
measuring inputs) 

• CU_STW, CU_ZSW 
• I/O access to the DIs and DOs 
• Maximum of 2 inputs for measuring 

inputs (global measuring inputs) 1) 

392 • CU_STW, CU_ZSW 
• I/O access to the DIs and DOs 
• Maximum of 8 high-speed output 

cams/DOs 
• Maximum of 6 inputs for 

measuring inputs (global 
measuring inputs) 

• CU_STW, CU_ZSW 
• I/O access to the DIs and DOs 
• Maximum of 6 inputs for measuring 

inputs (global measuring inputs) 1) 

1) In conjunction with CX32, CU310, and CU320, SIMOTION V4.1 SP2 and higher 
 

Because the same terminals are used, the maximum "high-speed output cams/DOs" quantity 
framework reduces by the number of used inputs for measuring inputs.  
The configuration of local measuring inputs does not require message frame 39x to be 
configured. 
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Message frame 39x configuration 
The following requirements must be satisfied before configuring the onboard I/Os of a D4x5: 
● A SCOUT project has been created 
● The D4x5 has been created 
● A SINAMICS Integrated drive has been configured 
Proceed as follows: 
1. In the project navigator, double-click the "Configuration" entry under "SINAMICS 

Integrated". In the work area, the "PROFIBUS message frame" tab is displayed in the 
"SINAMICS Integrated - Configuration" dialog box. 

2. Select the message frame type (SIEMENS message frame 390, 391 or 392) for the 
Control Unit. 

3. Click the "Transfer to HW Config" button to transfer the message frame data to hardware 
configuration. 

A message frame 39x is configured for the D4x5 Control Unit. The address area of the 
message frame is displayed in "SINAMICS_Integrated – Configuration" dialog. The 39x 
message frame configuration automatically makes the BICO interconnections for the DI and 
DI/DO which are then available for SIMOTION. 

 
          Figure 7-45 Message frame 39x configuration 
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Use of the onboard I/O by SIMOTION 
For DI/DO channels, the terminal status of the output can be fetched back using the input 
(DI). 
Message frame 390 transfers the control and status word of the Control Unit in PZD1 and 
the status of the onboard inputs/outputs in PZD2.  
For the 391 and 392 message frames, additional control and status information for the global 
measuring inputs is transferred. The content of PZD3 to PZD15 is used exclusively by the 
measuring input technology object.  

Table 7- 9 Assignment of addresses: Control/status word and onboard I/Os 

PZD Logical hardware address and bit number: D4x5, CU320 CX32, CU310 
  Input Output Input Output 
PZD1 Start address message frame 39x + 0 CU_ZSW CU_STW CU_ZSW CU_STW 
PZD2 Start address message frame 39x + 2, bit 0 

Start address message frame 39x + 2, bit 1 
Start address message frame 39x + 2, bit 2 
Start address message frame 39x + 2, bit 3 
Start address message frame 39x + 2, bit 4 
Start address message frame 39x + 2, bit 5 
Start address message frame 39x + 2, bit 6 
Start address message frame 39x + 2, bit 7 

DI 0 
DI 1 
DI 2 
DI 3 
DI 4 
DI 5 
DI 6 
DI 7 

– 
– 
– 
– 
– 
– 
– 
– 

DI 0 
DI 1 
DI 2 
DI 3 
– 
– 
– 
– 

– 
– 
– 
– 
– 
– 
– 
– 

 Start address message frame 39x + 3, bit 0 
Start address message frame 39x + 3, bit 1 
Start address message frame 39x + 3, bit 2 
Start address message frame 39x + 3, bit 3 
Start address message frame 39x + 3, bit 4 
Start address message frame 39x + 3, bit 5 
Start address message frame 39x + 3, bit 6 
Start address message frame 39x + 3, bit 7 

DI 8 
DI 9 
DI 10 
DI 11 
DI 12 
DI 13 
DI 14 
DI 15 

DO 8 
DO 9 
DO 10 
DO 11 
DO 12 
DO 13 
DO 14 
DO 15 

DI 8 
DI 9 
DI 10 
DI 11 
– 
– 
– 
– 

DO 8 
DO 9 
DO 10 
DO 11 
– 
– 
– 
– 

PZD3 Start address message frame 39x + 4 Used 
internally for 
global 
measuring 
inputs (only 
for message 
frames 391, 
392) 

– Used 
internally for 
global 
measuring 
inputs (only 
for message 
frames 391, 
392) 

– 

PZD4-7 Start address message frame 39x + 6 Used 
internally for 
global 
measuring 
inputs 1 to 2 
(only for 
message 
frames 391, 
392) 

– Used 
internally for 
global 
measuring 
inputs 1 to 2 
(only for 
message 
frames 391, 
392) 

– 
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PZD Logical hardware address and bit number: D4x5, CU320 CX32, CU310 
  Input Output Input Output 
PZD8-15 Start address message frame 39x + 10 Used 

internally for 
global 
measuring 
inputs 3 to 6 
(only for 
message 
frame 392) 

– Used 
internally for 
global 
measuring 
inputs 3 to 6 
(only for 
message 
frame 392) 

– 

 
To allow access to the individual PZDs by the I/Os, I/O variables must be created in 
SIMOTION. For this purpose, the input/output addresses displayed in the "PROFIBUS 
message frame" tab in the "SINAMICS Integrated - Configuration" dialog box are required. 
The following figure shows an example of I/Os created in SCOUT: In this example, the start 
address of the 390 message frame for the input and output data is each 276. 

 
 Figure 7-46 Example: Access to message frame 390 using I/O variables. 
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Configuring DI/DO as input or output 
When a DI/DO is to be used as digital input or digital output, interconnection screen forms 
can be used for configuring. 
Proceed as follows: 
1. Double-click the "Inputs/outputs" entry below the SINAMICS_Integrated > Control Unit in 

the project navigator. 
2. Click the "Bidirectional digital inputs/outputs" tab. 
3. In this tab, configure the required inputs or outputs. 

 
    Figure 7-47 Configuring DI/DO as input or output 

The configuration can also be set channel-granular on the p728 parameter using the expert 
list of the Control Unit. 

 

 Note 
When the 39x message frames are used, a HW Config must always be performed after 
changes have been made to onboard I/O-relevant parameters. "Download to the target 
system" must then be used to download the changed configuration data into the target 
device. The matching is always made only for the associated selected Control Unit and not 
project-global. 
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7.10.3 Free message frame configuring with P915/P916 (only TM15/TM17 High Feature) 
The TM15 and TM17 High Feature Terminal Modules are connected to the Control Unit 
using the DRIVE-CLiQ interface. This assigns the Terminal Modules to the SINAMICS. 
When a TM15 or TM17 High Feature is added to SIMOTION SCOUT, an automatic 
interconnection to a "free message frame with P915/P916" is made. There are no other 
interconnection options for the TM15 (but not TM15 DI/DO) and TM17 High Feature. 
The structure and the length of the message frame depends on the configured properties of 
the inputs and outputs. The I/O channels can be parameterized as digital input, digital 
output, input for measuring input or output for output cam. 
The automatic interconnection of the message frame means the functionality of the modules 
can only be used by SIMOTION and is controlled from the SIMOTION user program using 
input/output addresses or I/O variables. A drive-side configuring using BICO/DCC 
SINAMICS is not possible.  

Additional references 
Additional information about this topic is available in the following documents: 
● To configure the TM15 and TM17 High Feature, refer to the SIMOTION TM15 and TM17 

High Feature Commissioning Manual. 
● To configure output cams and measuring inputs, refer to the SIMOTION Motion Control 

Output Cams and Measuring Inputs Function Manual. 
● For I/O processing with the TM15 and TM17 High Feature (timing, classification in the 

task system), refer to the SIMOTION SCOUT Basic Functions Function Manual. 
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7.10.4 Free Message Frame Configuration via BICO 

Overview 
For the "free message frame configuring using BICO", dedicated message frames for the 
data transmission are assigned to the associated drive objects (e.g. Terminal Modules). 
Message frame type: Free message frame configuring using BICO (message frame 999)  
To allow SIMOTION to access the SINAMICS drive signals, e.g. I/Os, they must be 
interconnected to the SINAMICS using BICO to the message frame. The "free message 
frame configuring using" is a preferred solution when I/Os are to be divided channel-granular 
between SIMOTION and SINAMICS and a module view is preferred.  

Table 7- 10 Drive object: Maximum number of PZDs 

Maximum number of PZDs for configuring the PROFIBUS 
message frames 

Drive object 

Input data 
(from the SIMOTION D 
viewpoint) 

Output data 
(from the SIMOTION D 
viewpoint) 

TM15 DI/DO 5 5 
TM31 5 5 
TM41 19 16 
Control Unit (CU) 15 5 

Free message frame configuring using the TM31 as example 
The example describes the interconnection of a signal to the TM31, which is connected to a 
SIMOTION D4x5. 
Steps in configuring user-specific message frames using BICO: 
● Configuring user-specific message frames 
● Interconnecting the message frame for TM31 
● Create I/O variables in SIMOTION SCOUT 

Requirement 
You have already created a project and configured a drive. 

Configuring user-specific message frames 
1. Double-click "Insert I/O component" under "SINAMICS_Integrated" in the project 

navigator, and then select the "TM31" Terminal Module from the "Drive objects type" field 
of the dialog box that appears. 

2. Enter a name for the module to be inserted and confirm your entry with OK. 
3. Double-click the "Configuration" entry at "SINAMICS Integrated" in the project navigator 

to open the "PROFIBUS Message Frame" screen form. 
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"Free message frame configuration with BICO" (message frame 999) is set for the 
inserted TM31. Insert the number of PZDs (Process Status Data) for the I/O data. Please 
note the maximum possible number of PZDs for the various drive objects. An TM31, for 
example, supports 5 PZDs in both the send and the receive direction. 

4. Enter the value 5 in the "Length" column in the "Input data" or "Output data" fields. 

 
      Figure 7-48 Inserting a specific number of PZDs for the I/O data 

5. Click "Transfer to HW Config" in order to transfer the data to HW Config and to specify 
the address space of the I/O data. 

 

 
 

Note 
Before the matching, all drive objects without input/output addresses ("---..---") must be 
moved behind the objects with valid input/output addresses or those still to be matched 
("???..???"). 
The icons in the status column show the following information: 

 The message frame is configured differently in HW Config. You must match with HW 
Config. 

 You are using a predefined standard message frame or free BICO interconnection. 
 You are using a modified standard message frame that you have extended to include 

additional data. 
 You are using a message frame for which one of the two message frame lengths is 

too long. The drive object cannot process this entry. 
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      Figure 7-49 Reading the I/O address space 

You can now transfer data from TM31 to SIMOTION (PROFIBUS send direction) or receive 
data from there (PROFIBUS receive direction). 

Interconnecting the message frame for TM31 
The next section describes how you can transfer signals from TM31 to SIMOTION 
(PROFIBUS send direction). 

 

 Note 
To perform interconnections in online mode, you must: 
• Prior to the interconnection, download the message frame configuration into the target 

device. Function: Download the CPU/drive unit to the target unit. 
• After the interconnection, load the settings from the target device to the PC/PC. Function: 

Load the CPU / drive unit to the PG. 
 

 
1. Double-click the "PROFIBUS" entry in the "Communication" dialog of the TM31 you 

created. The corresponding dialog box opens. 
2. Click "Binector/connector converter" in the "PROFIBUS send direction" tab. The 

"Binector/connector converter" tab opens 
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3. Select the source for status word 1 by clicking the "Status word 1 sources" field, and then 
select the corresponding PZD: In this example, TM31 -> p2051. . . Select PZD1. 

 
Figure 7-50 Selecting the PZD 

4. Click the button in front of the "Status word 1 sources" field. The PZD bits will now be 
displayed. 

5. Click in a field and select the default signal, for example, bit 0. 
This bit can be used, for example, to transmit the status at digital input DI 0 to 
SIMOTION. 

 
Figure 7-51 Selecting a signal 

6. Interconnect all signals you need. 
 
How to transfer a signal from SIMOTION to TM31 (PROFIBUS receive direction): 
1. Double-click the "PROFIBUS" entry in the "Communication" dialog of the TM31 you 

created. The corresponding dialog box opens. 
2. Click "Binector/connector converter" in the "PROFIBUS receive direction" tab. The 

"Connector/binector converter" tab opens 
3. Interconnect all required signals. Proceed as defined in the description of the "PROFIBUS 

send direction". 
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Creating an I/O variable in SIMOTION 
Create the I/O variables in SIMOTION SCOUT in order to access the signals of TM31. You 
require the input or output addresses for the TM31 message frame in the "PROFIBUS 
Message Frame" dialog box. This allows you to assign the variable either as a complete 
word, a byte or a single bit. 
1. In the project navigator, double-click "I/O" below the D4x5 created. The symbol browser 

opens 
2. Enter a name for the I/O variable. 
3. Enter an I/O address, e.g.  

PI277.0 - This accesses PZD1, bit 0 of the configured message frame. 
PI276.0 - This accesses PZD1, bit 8 of the configured message frame. 
SIMOTION can now access the signal. 

The PROFIdrive profile specifies that the process status data (PZD) is defined as a 16-bit 
value. When determining the I/O address note that the low-order byte of the SIMOTION I/O 
variable is assigned to the high-order process data (PZD) bits of the message frame, and 
vice versa: 
 

I/O address Byte 276 Byte 277 
Bytes represented in 
bit format 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

PZD in bit 
representation 

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

7.10.5 Extending a message frame 
Extending a message frame involves extending existing standard message frames (e.g. axis 
message frames) to include additional process status data (PZD). These additional PZDs 
are then interconnected using BICO (e.g. to an actual speed value or to the status of a digital 
input).  
A message frame extension is then the preferred variant when I/Os are to be distributed 
between SIMOTION and SINAMICS and, for example, an axis view is preferred (drive-
related I/O should be appended to each axis message frame). 
Proceed as follows: 
1. Insert a drive using the Drive Wizard and select PROFIBUS (drive), e.g. "standard 

message frame 103", for process data exchange. 
2. Double-click the "Configuration" entry below "SINAMICS Integrated" in the project 

navigator in order to open the "PROFIBUS message frame" tab. 
The tab contains the default length of I/O data for the drive you inserted. As the 
addresses of I/O data have not yet been transferred to HW Config the default entry "???" 
is set. 
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3. Select the row of the object of which you want to expand the message frame. 

 
      Figure 7-52 PROFIBUS message frame 

4. Click "Add line" and select the "Message frame extension" option in the menu shown. 
A new line which contains the message frame extension is inserted below the current 
line. 

5. Enter the "length" for the number of PZDs by which the message frame is to be extended 
in the Input data and Output data columns. 

 

 
 

Note 
Before the matching, all drive objects without input/output addresses ("---..---") must be 
moved behind the objects with valid input/output addresses or those still to be matched 
("???..???"). 
The icons in the status column show the following information: 

 The message frame is configured differently in HW Config. You must match with HW 
Config. 

 You are using a predefined standard message frame or free BICO interconnection. 
 You are using a modified standard message frame that you have extended to include 

additional data. 
 You are using a message frame for which one of the two message frame lengths is 

too long. The drive object cannot process this entry. 
 

6. Click "Transfer to HW Config" in order to transfer the changes to HW Config. 
The red check mark on the line indicates that a modified standard message frame is 
being used. The I/O address data is entered after its transfer to HW Config. 

7. Change to the configured drive and double-click the "PROFIBUS" entry in 
"Communication". 

8. Deactivate the "Suppress inactive interconnections" option to display all PZDs of the 
message frame. 
The send and receive data (at least 16 entries) will be displayed. The first PZDs are 
assigned the standard message frame by default and cannot be changed. 
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9. Now use BICO to interconnect the inserted PZDs (at the end of the PZD list) with the 
required signals. 

 
Figure 7-53 Example: Interconnecting the onboard DI in the PROFIBUS send direction 

 

 
 

Note 
A warning message is not output if you interconnect more PZDs than were specified in 
the additional PZDs. Please note that a SERVO drive object supports a maximum of 16 
PZD setpoints and 19 PZD actual values. Each VECTOR drive object supports a 
maximum of 32 PZD setpoints/actual values 
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7.10.6 Using high-speed outputs for output cams on the D4x5 

Using high-speed outputs for output cams/DOs with D4x5 
Output cams are defined as being the position-dependent output of switching signals. The 
TO outputCam and TO camTrack technology objects control the output of output cams for 
SIMOTION. 
The onboard digital outputs of the SIMOTION D4x5 can be used as cam output or as high-
speed output with write access to the user program. In order to be able to use the high-
speed outputs, one of the 39x message frames must be created.  

 

 Note 
If I/O data is transferred using bus message frames, the update of the I/O data is subject to 
the set bus cycle. This means an I/O using a 39x message frame can change its status just 
once in each bus cycle of the PROFIBUS Integrated. 
With SIMOTION D4x5 onboard outputs, the outputs are controlled using direct write 
accesses to the hardware (i.e. bypassing the message frame). This means: 
• Write accesses to digital outputs act with a particularly short delay time because the write 

access is independent of the bus cycle. 
• A more accurate output of the cam output is possible 
For fast write accesses from the user program, the resulting delay time has the following 
form: 
• User program delay time -> terminal register: max. 75 μs 
• Load-dependent output delay time of the hardware for the D4x5:  

L -> H: max. 400 μs  
H -> L: max. 100 μs 

 

High-speed outputs of output cams 
If you use the output as high-speed output of a cam output, for the configuration of the TO 
outputCam / TO camTrack, enter the logical hardware address and the bit number of the 
used output in the configuration screen form of the TO. 
For additional information, see the SIMOTION Motion Control Output Cams and Measuring 
Inputs Function Manual. 
High-speed digital outputs 
If you use the output as high-speed digital output, create an I/O variable in SIMOTION 
SCOUT. The same addresses should be used for the high-speed digital outputs as those 
normally used for the digital outputs. 

Table 7- 11 Logical hardware address and the bit number (high-speed outputs for cam outputs/DOs) 

Logical hardware address and bit number Output on the D4x5 
Start address message frame 39x +3, bit 0 DO 8 
Start address message frame 39x +3, bit 1 DO 9 
Start address message frame 39x +3, bit 2 DO 10 
Start address message frame 39x +3, bit 3 DO 11 
Start address message frame 39x +3, bit 4 DO 12 
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Logical hardware address and bit number Output on the D4x5 
Start address message frame 39x +3, bit 5 DO 13 
Start address message frame 39x +3, bit 6 DO 14 
Start address message frame 39x +3, bit 7 DO 15 

See also 
For information on how to configure message frame 39x and how to parameterize a DI/DO 
as DO, see Use of message frame 39x (Page 180)  

7.10.7 Using inputs for measuring inputs on the D4x5 

Configuring inputs for measuring inputs 
Measuring inputs are used for fast, accurate measurement of actual positions. This is 
achieved with hardware support (for example, the measuring input on the assigned drive 
unit). Digital inputs for standard peripherals, e.g. the SIMATIC ET 200 distributed I/O system, 
cannot generally be used as inputs for measuring inputs.  
For SIMOTION, the TO measuringInput controls the measuring input functionality. 
SIMOTION differentiates between two classes of inputs for measuring inputs; these classes 
have different properties that are configured differently. 

Local and global measuring inputs 
Depending on the used hardware platform, the following local and global measuring inputs 
are available for the measuring tasks:  
● Local measuring inputs are axis-related and implemented in the SINAMICS drive. The 

actual position value is measured. 
● Global measuring inputs can be freely assigned to the axes and add an internal 

timestamp to the measurement result for more precise determination of the axis positions.  
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Table 7- 12 Comparison of local and global measuring inputs 

 Local measuring input Global measuring input 
Supported hardware D4x5, CX32, CU310, CU320 TM15, TM17 High Feature 

As of V4.1 SP1: D410, D4x5 
As of V4.1 SP2: CX32, CU310, CU320 

Measurement operation With a signal edge at the relevant input, 
the current actual values of an encoder 
connected to a Control Unit are 
measured with positioning accuracy to 
determine lengths and distances. 

With a signal edge at the relevant input, 
the current actual values of one or 
more encoders are measured using 
timestamp functionality with positioning 
accuracy in order to provide information 
for determining lengths and distances 
(possible with any encoders included in 
the project). 

Configuration of the TO measuringInput 
in the SIMOTION SCOUT 

The assignment of inputs is always 
permanent depending on the hardware 
of the Control Unit and is performed 
during the configuration of the TO 
measuringInput using the measuring 
input number. 

The assignment of inputs is not fixed 
depending on the hardware and is 
performed during the configuration of 
the TO measuringInput using the 
hardware address. 

TO measuringInput setting Single 
measurement 
(Measurement jobs must be issued 
individually for each measurement. 
Several interpolation cycle clocks lie 
between two measurements.) 

yes yes 

TO measuringInput setting Cyclical 
measurement 
(The measurement is activated just 
once and runs cyclically until 
deactivated.) 

(yes) 
Although the TO measuringInput can 
be requested to perform a cyclical 
measurement, it subdivides such a 
measurement into the execution of a 
series of single tasks. In such a case, 
the minimum separation between two 
measurements is several servo cycles. 

yes 
D4x5, CX32, CU310, CU320: 
The minimum interval between two 
measurements is 3 servo cycles (max. 
2 edges per measurement) 
TM17 High Feature: 
Minimum interval between two 
measurements is 1 servo cycle (max. 2 
edges per measurement) 
TM15: 
No cyclic measurement available 

Use of multiple TO measuringInputs on 
one axis/encoder, whereby these can 
be active concurrently. 

no yes 

Listening TO measuringInput no yes 
Measuring on virtual axes no yes 
Measuring on axes attached to a 
different drive unit 

no yes 
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Table 7- 13 Measuring inputs - Overview of quantity structures and functionality 

 Max. available quantity structure 
 CU310 D4x5 CX32 CU320 TM15 TM17 High 

Feature 
Max. number of inputs 
for measuring inputs 

3 6 3 6 24 16 

Can be configured as a 
local measuring input 

x x x x - - 

Can be configured as a 
global measuring input 

x x x x x x 

Configuring local measuring inputs 
Local measuring inputs are always permanently assigned to an axis (drive). They are 
configured separately for each drive. The drive and the input for the measuring input must 
always be located on the same Control Unit. The measuring results are transferred using the 
axis message frame in accordance with the PROFIdrive profile. Message frame 39x does 
not need to be configured for local measuring inputs.  
The settings for the use of the local measuring inputs must be made in the expert list. 

Table 7- 14 Local measuring inputs, required settings in the expert list (1) 

Parameterization as  All DI/DOs used as measuring inputs need to 
be defined as inputs via parameter p728[8..15] 
of the Control Unit. D4x5, CU320 CX32, CU310 

p728[8] (DI/DO 8) Input Input 
p728[9] (DI/DO 9) Input Input 
p728[10] (DI/DO 10) Input Input 
p728[11] (DI/DO 11) Input Input 
p728[12] (DI/DO 12) Input _ 
p728[13] (DI/DO 13) Input _ 
p728[14] (DI/DO 14) Input _ 

DI/DO parameterization as 
input on the Control Unit 

p728[15] (DI/DO 15) Input _ 
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Table 7- 15 Local measuring inputs, required settings in the expert list (2) 

Parameterization as  The terminals for the local inputs for 
measuring inputs must be assigned via 
parameters p488[0..2] and p489[0..2] of the 
drive. 

D4x5, CU320 CX32, CU310 

p488[0]  
(measuring input 1 input terminal, encoder 1) 
p488[1]  
(measuring input 1 input terminal, encoder 2) 
p488[2]  
(measuring input 1 input terminal, encoder 3) 
p489[0]  
(measuring input 2 input terminal, encoder 1) 
p489[1]  
(measuring input 2 input terminal, encoder 2) 

Specification of the input 
terminal of the measuring 
input in the expert list of the 
drive 

p489[2]  
(measuring input 2 input terminal, encoder 3) 

DI/DO 9, 
DI/DO 10, or 
DI/DO 11  
DI/DO 13  
DI/DO 14  
DI/DO 15 

DI/DO 9, 
DI/DO 10 or 
DI/DO 11 

 
 
Because a maximum of three encoders can be assigned to a drive, the index [0..2] specifies 
whether the measurement applies to 1, 2 or 3. 
The following must be taken into account: 
● Only two TO measuringInputs can be configured per TO axis or TO externalEncoder. 
● Only one TO measuringInput can be active on a TO axis or TO externalEncoder. 

Table 7- 16 Local measuring inputs, configuration of the TO measuringInput 

Axis measuring system no. Under axis measuring system number, enter the number of the used 
encoder system (namely, encoder 1, 2 or 3). Encoder system 1 is the 
default setting. 

Local measuring Activate the checkbox when a local measuring input is used. 
Measuring input number Enter here which measuring input is used (namely, 1 or 2). Input 1 is 

the default setting. 

Detailed information can be found in the SIMOTION Motion Control Output Cams and 
Measuring Inputs Function Manual. 
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Configuring global measuring inputs 
Global measuring inputs can be freely assigned to the axes (drives) and add an internal 
timestamp to the measurement result for more precise determination of the axis positions. 
The drive and the input for the measuring input do not need to be located on the same 
Control Unit. The measuring results are not transferred using the axis message frame, but 
using the 391/392 axis message frame.  

Table 7- 17 Global measuring inputs, required settings in the expert list (1) 

Parameterization as  All DI/DOs used as measuring inputs need to 
be defined as inputs via parameter p728[8..15] 
of the Control Unit. D4x5, CU320 CX32, CU310 

p728[8] (DI/DO 8) Input Input 
p728[9] (DI/DO 9) Input Input 
p728[10] (DI/DO 10) Input Input 
p728[11] (DI/DO 11) Input Input 
p728[12] (DI/DO 12) Input _ 
p728[13] (DI/DO 13) Input _ 
p728[14] (DI/DO 14) Input _ 

DI/DO parameterization as 
input on the Control Unit 

p728[15] (DI/DO 15) Input _ 

 

Table 7- 18 Global measuring inputs, required settings in the expert list (2) 

Parameterization as  Parameter p680[0..5] of the Control Unit is 
used to specify the terminals of the global 
inputs for the measuring inputs. Depending on 
the Control Unit and message frame 39x, a 
maximum of 6 global inputs for measuring 
inputs can be specified. 

D4x5, CU320 CX32, CU310 

p680[0]  
(measuring input 1 input terminal, encoder 1) 
p680[1]  
(measuring input input terminal, encoder 2) 
p680[2]  
(measuring input input terminal, encoder 3) 
p680[3]  
(measuring input input terminal, encoder 1) 
p680[4]  
(measuring input input terminal, encoder 2) 

Specifying the input 
terminals of the measuring 
inputs 

p680[5]  
(measuring input input terminal, encoder 3) 

DI/DO 9 or 
DI/DO 10 or 
DI/DO 11 or 
DI/DO 13 or 
DI/DO 14 or 
DI/DO 15 

DI/DO 9 or 
DI/DO 10 or 
DI/DO 11 

 
In addition to the parameter settings, message frame 391 (max. two measuring inputs) or 
message frame 392 (max. six measuring inputs) must be set for the Control Unit. The p680 
parameter is used to define a terminal as global measuring inputs. Message frame 391 can 
be used to assign parameter p680[0..1]; message frame 392 can be used to assign 
parameter p680[0...5]. The parameter used to set the required terminal is not relevant. The 
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logical hardware address and the bit number of the digital input to be used as the measuring 
input are used to assign the measuring input to an axis. 
The p490 parameter of the Control Unit can be used to invert a measuring input. 

 

 Note 
The p684, and r685 to r688 parameters of the Control Unit have no relevance for 
SIMOTION. 

 

 Note 
When the 39x message frames are used, a HW Config must always be performed after 
changes have been made to onboard I/O-relevant parameters. "Download to the target 
system" must then be used to download the changed configuration data into the target 
device. 

 

 
 

Axis measuring system no. Under "Axis measuring system number", enter the number of the encoder system used 
(encoder 1...3). Encoder system 1 is the default setting. 

Global measuring Activate the checkbox when a global measuring input is used. 
Enter the logical HW address and the bit number of the input used here. 
Logical HW address and bit number Input 

D4x5, CU320 
Input 
CX32, CU310 

Start address message frame 39x +3, bit 0 - - 
Start address message frame 39x +3, bit 1 DI/DO9 DI/DO9 
Start address message frame 39x +3, bit 2 DI/DO10 DI/DO10 
Start address message frame 39x +3, bit 3 DI/DO11 DI/DO11 
Start address message frame 39x +3, bit 4 - - 
Start address message frame 39x +3, bit 5 DI/DO13 - 
Start address message frame 39x +3, bit 6 DI/DO14 - 

Logical HW address and bit 
number 

Start address message frame 39x +3, bit 7 DI/DO15 - 

Additional references 
Detailed information can be found in the SIMOTION Motion Control Output Cams and 
Measuring Inputs Function Manual. 

7.10.8 Outputs of cam outputs and probe inputs on TM15/TM17 High Feature 

Quantity structure for TM15/TM17 High Feature 
The TM15/TM17 High Feature Terminal Modules can be used to extend the quantity 
structure of the outputs for cam outputs and inputs for measuring inputs. 
● TM15, maximum 24 outputs for cam outputs/inputs for measuring inputs 
● TM17 High Feature, maximum 16 outputs for cam outputs/inputs for measuring inputs 
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Additional references 
Detailed information for the configuration can be found in the following documents 
● SIMOTION Output Cams and Measuring Inputs Function Manual 
● TM15/TM17 High Feature Terminal Modules Commissioning Manual 

7.11 Creating and parameterizing a TM41 

7.11.1 Overview 
The TM41 terminal module can be used to expand the number of digital I/O and of analog 
inputs within a drive system. TM41 also returns TTL signals which emulate an incremental 
encoder, for example, for a master control system.  
The emulated encoder signal has the signal characteristic of an incremental TTL encoder (A 
track, B track, R track). The resolution of the encoder signal can be specified in the 
configuration. 

 

 Note 
The digital I/Os and the analog input can be interconnected via BICO configuration in the 
same way as a TM31. 

 

The TM41 encoder interface (incremental encoder representation) can 
● Be interconnected with an encoder signal of the control unit using parameterization, e.g. 

sin/cos incremental encoder. For detailed information, consult the SINAMICS manuals. 
● From the SIMOTION viewpoint, can be accessed as axis. This allows you to return the 

axis position (a master value) as encoder signal to a second controller, for example. The 
section that follows describes the configuration process. 

Configuring the TM41 involves the following steps: 
● Configuring TM41 at SINAMICS Integrated 
● Configuring TM41 using the Axis Wizard. 

7.11.2 Configuring TM41 at SINAMICS Integrated 
TM41 can be configured after you completed the configuration of SINAMICS Integrated. Use 
the following procedure:  
1. Double-click "Insert InputIOutput Ccomponent" at "Input/output component" in the Project 

Navigator. 
2. Select TM41 from the "Drive object type" field of the "Insert Input/Output Component" 

dialog box and assign a unique name to the module. 
3. Confirm your entry with "OK". 

The TM41 is inserted in the Project Navigator by the name you entered. 
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4. Double-click "Inputs/outputs". The "Inputs/Outputs" property dialog box of TM41 opens. 
5. Set "SIMOTION" as the operating mode on the "Pulse encoder emulation" tab, and make 

the settings for the emulated sensor signal. 
6. Double-click "Configuration" under "SINAMICS_Integrated" in the project navigator and 

select the "PROFIBUS message frame" tab. 
7. Select "Standard message frame 3" for the TM41 drive object. 
8. Click "Transfer to HW Config" to align the message frame with HW Config. The I/O 

addresses are displayed. 
 
You have now programmed the TM41 and aligned it with HW Config. 

7.11.3 Configuring TM41 using the Axis Wizard. 
After configuring the TM41 for a SINAMICS Integrated device in the project navigator, you 
can interconnect it with an axis using the Axis Wizard. The Wizard implements the TM41 as 
drive device.  
1. Open the Axis Wizard and create a positioning or synchronization axis (electrical). 
2. Step the Axis Wizard forward until the "Drive Assignment" dialog box opens. 
3. Select "SINAMICS_Integrated" as the drive device and "TM41" as the drive. 

TM41 operates as setpoint sink of the axis with this setup. 

 
Figure 7-54 Drive assignment 
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4. Change to the "Inc. encoder data" dialog box to enter the values you configured at TM41. 
TM41 operates as actual value of the axis with this setup. 

Detailed information on configuring incremental encoder emulation with the TM41 can be 
found in the following FAQ: http://support.automation.siemens.com/WW/view/en/27554028   

7.12 Creating a DMC20 

7.12.1 DMC20 hub properties 

DRIVE-CLiQ hub properties 
You can use a DMC20 DRIVE-CLiQ hub to extend the number of DRIVE-CLiQ interfaces 
and configure a point-to-point topology. You require a relatively large number of DRIVE-CLiQ 
interfaces when, for example, you want to connect the following supplementary components 
to SIMOTION D4x5: 
● Direct measuring systems 
● Terminal modules 
● Reduction of the network hierarchy levels 
A star topology has the following advantages: 
● The components can be used as end nodes of their line. 
● The line communication is not affected.  

Application examples 
Typical applications of DRIVE-CLiQ hubs are encoder expansion and hot plugging. 
● In an encoder expansion, direct measuring systems are connected. For example, these 

are attached directly to the machine in the control cabinet. Several encoders can be 
connected to one hub in the cabinet. 

● Hot plugging is the option for changing motor modules while in operation. To do so, the 
motor modules are connected via a DRIVE-CLiQ hub in the form of a star topology. This 
means they can be deactivated without impairing downstream components (via 
cascading). 

 

 
 

Note 
Cascading is permitted one time only (from hub to hub). 
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Additional references 
Additional information on the DMC20 DRIVE-CLiQ hub is contained in the  
● SIMOTION D4x5 Manual. 
● Supplementary SINAMICS System Components for SIMOTION Manual 

7.12.2 Creating a DRIVE-CLiQ hub 

Introduction 
A DMC20 can be inserted directly in the project navigator. When you insert the DMC20, the 
hub is not wired, but rather represented in the topology tree in the component storage. The 
hub has to be wired manually.  

Procedure 
1. Right-click "Topology" in the project navigator. 
2. On the context menu, select the "Insert New Object" > "DRIVE-CLiQ Hub" command and 

confirm with "OK". 
3. Double-click "Topology" to display the topology tree. 

In the topology tree, the hub is stored in the component archive.  
4. Use a drag-and-drop operation to move the hub to the desired DRIVE-CLiQ interface. 

The components connected to the hub are displayed in the topology tree. 

Result 
The added hub is displayed for the "Topology" entry in the project navigator. All components 
connected to a hub are also displayed during an automatic configuration. 
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7.13 Optimizing drive and closed-loop controller 

7.13.1 Overview of automatic controller setting 

Overview 
For the controller optimization of the drive, SIMOTION SCOUT offers a wizard for the 
automatic controller setting. 
In the "Automatic Controller Setting" screen form, you can configure an automatic setting for 
the speed controller and the DSC (dynamic servo control) position controller for SINAMICS 
drive units. The necessary steps for this calculation can be controlled from this screen form. 
The calculated parameter values for the speed controller or position controller are displayed 
and can then be transferred online to the drive or axis on the controller. 
You can perform the automatic controller setting using the "Target System" > "Automatic 
Controller Setting" menu command. 
For a detailed description of the parameters that can be defined, to the SIMOTION SCOUT 
Online Help. 

Requirements 
● You have configured a SINAMICS drive. 
● The configured drive is operated in the "Servo" drive object type. 
● Closed-loop control takes place with the motor encoder. 
● There is an online connection to the relevant drive unit. 

Procedure 
Automatic controller setting involves the following steps: 
1. Setting the speed controller 
2. Setting the position controller 

 

 
 

Note 
You can stop the automatic controller setting by pressing SPACEBAR. 
• The step currently being executed is aborted. 
• The drive enable is canceled. 
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Additional references 
Information on the controller structure can be found in the SIMOTION TO Axis, 
Electric/Hydraulic, External Encoder Function Manual. 
In addition to the automatic controller setting, SIMOTION SCOUT also offers the option of 
optimizing the drive and controller manually by means of measuring functions, trace, and 
function generator (see Measuring functions, trace, and function generator (Page 207), and 
Manual speed controller optimization (Page 209)). 

7.13.2 Automatic speed controller setting 

Features 
The automatic speed controller setting has the following features: 
● Attenuation of resonances in the speed-controlled system 
● Automatic setting of the gain factor Kp and the integral time Tn of the speed controller 
● The speed setpoint filter and the reference model are not adjusted 

Procedure 
To perform an automatic setting of the speed controller, proceed as follows: 
1. Select the "Target System" > "Automatic Controller Setting" menu command. 
2. Select the drive unit and the drive. 
3. Select the "Speed controller" from the "Controller Selection". 
4. Then click "Assume control priority" to assume the control priority. 
5. Press the "Drive On" button to enable the drive. 

Perform these steps (1 to 4) in automatic mode or as individual steps. 
6. Click "Transfer" to transfer the calculated parameter values for the speed controller to the 

drive. 
7. Disable the drive by clicking the "Drive Off" button. 
8. Click the "Give up control priority" button to give up the control priority of the PG/PC. 
9. Save the online parameters. 
You can now transfer the automatically set parameters to the project. 
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Backing up parameters 
Proceed as follows to back up the parameters: 
1. In the project navigator, select the SINAMICS unit with the drive for which you want to 

perform the automatic setting 
2. Select "Copy RAM to ROM" in the context menu. 
3. Select "Load to PG" from the context menu. 
If necessary, the automatic controller settings can be verified with the measuring functions. 

7.13.3 Automatic position controller setting 

Introduction 
In the "Automatic Controller Setting" screen form, you can select the SINAMICS drive unit 
and the drive for which you want to carry out an automatic DSC position controller setting. 
The necessary steps for this calculation can be performed from this screen form. The 
calculated Kv value is displayed and can then be accepted online in the configuration data of 
the axis that is assigned to the drive.  

Requirements 
In addition to the General requirements for the automatic controller setting, the following 
boundary conditions apply for setting the position controller: 
● DSC is required for the position controller setting. 
● The speed controller has already been configured (e.g. with the automatic speed 

controller setting). 
● At least one axis is connected to the SINAMICS drive (servo). 
● The actual values and manipulated variables between the controller and the drive have 

been correctly normalized by the user. These values are not checked. 
● An online connection to the SIMOTION device must be established to transfer the results 

of the automatic position controller setting. 
● The balancing filter is not changed. 
● For operation without precontrol, the equivalent time constant of the position controller 

must be adjusted manually by the user (PostionTimeConstant = 1/Kv). 
● Vibration on the load side is not taken into account for the position controller setting. 

Procedure 
To perform an automatic setting of the position controller, proceed as follows:  
1. Select the "Target System" > "Automatic Controller Setting" menu command. 
2. Select the drive unit and the drive (axis). 
3. Select the "Position controller (DSC)" from "Controller Selection". 
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4. Then click "Assume control priority" to assume the control priority. 
5. Press the "Drive On" button to enable the drive. 

Perform the steps either in automatic mode or as individual steps. 
6. Select the axis data sets to which the Kv factor are to be transferred. 
7. Click "Transfer" to transfer the calculated Kv factor to the axis data sets. 
8. Disable the drive by clicking the "Drive Off" button. 
9. Give up the control priority of the PG/PC. 
10. Save the online parameters. 
You can now transfer the automatically set parameters to the project.  

Backing up parameters 
Proceed as follows to back up the parameters:  
1. In the project navigator, select the SIMOTION unit with the axis for which you want to 

perform the automatic setting 
2. Select "Copy Current data to RAM" from the context menu. 
3. Select "Copy RAM to ROM" in the context menu. 
4. Select "Load Configuration Data to PG" from the context menu. 
If necessary, the automatic controller settings can be verified with the measuring functions. 

7.13.4 Measuring functions, trace, and function generator 

Drive optimization 
Drive optimization is part of commissioning and can be performed with SIMOTION SCOUT.  

 

CAUTION  
Controller optimization may only be performed by skilled personnel with control engineering 
knowledge. 
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Controller optimization 
Various measuring functions are available for controller optimization of the drive. These 
measuring functions enable the control of the higher-level control loop to be selectively 
switched off and the dynamic response of individual drives to be analyzed through simple 
parameter assignment. The function generator and the trace recorder are used. 
The control loop is supplied with the ramp-function generator signal at a specific point (e.g., 
speed setpoint), and the signal from the trace recorder is recorded at another point (e.g., 
speed actual value). 

 
Figure 7-55 Optimizing a closed-loop controller 

 
Depending on the form of controller optimization to be performed, it is possible to define the 
quality (e.g. signal form, amplitude, transient recovery time) of the disabled signal, the 
measuring duration for step functions in the time range, or the bandwidth and number of 
averaging operations in the frequency range for the trace. The analytical and graphical 
evaluation can then be performed accordingly (FFT diagram, Bode diagram). 
The following measuring functions are available: 
● Setpoint step-change at current controller 
● Reference frequency response at current controller 
● Setpoint jump at speed controller 
● Disturbance step-change at speed controller 
● Reference frequency response at speed controller 
● Disturbance frequency response at speed controller 
● Speed-controlled system (input at current setpoint filter) 
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Additional references 
For additional information about drive optimization, consult the SINAMICS S120 
Commissioning Manual. 
Additional information on trace and measuring functions, as well as on the function 
generator, can be found in the SIMOTION SCOUT Online Help. 

7.13.5 Manual speed controller optimization 

Requirement 
You have already created a project and configured an axis and a drive. You can now 
optimize the speed controller. 

Procedure 
1. Open the project and go to online mode. 

2. Click  to call the "Measuring Functions" dialog. 
3. Select the drive unit and the drive. 
4. Select "Speed controller setpoint jump". You can change the values in the following fields: 

"Settling time", "Amplitude", "Offset", "Ramp-up time", and "Measuring time". 

 
Figure 7-56 Speed controller measuring function 

 
Four channels can be traced. Certain channels are preassigned, depending of the 
measuring function. 

5. Download the changes to the drive by clicking  (Download Parameter Assignment). 
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Starting the measuring function 
1. Then click "Assume control priority" to assume the control priority. 

Read the notice that appears and click "Accept" to confirm. 
2. Press the "Drive On" button to enable the drive. 
3. Click  (Start measuring function) to start the measuring functions. 

The axis is moved during the measurement. For this reason, a safety message that 
allows the process to be aborted is displayed. 
After reading the notices, you can begin the measurement with "Accept" or abort it with 
"Abort". 

4. The traced signals are represented on the "Timing Diagram" tab. 

 
Figure 7-57 Timing diagram before parameter change 



 Commissioning (software) 
 7.13 Optimizing drive and closed-loop controller 

D4x5 
Commissioning and Hardware Installation Manual, 08/2008 Edition 211 

Adjusting the P-Gain 
You can adjust the P-gain of the controller to optimize the transient response. 
1. In the project navigator under the corresponding drive, for example, Servo_1, use the 

menu command "Open-Loop/Closed-Loop Control" > "Speed Controller" to display the 
"Speed Controller with Encoder" dialog. 

2. Enter an appropriate value in the "P-gain" field and the "Reset time" field. 
 

CAUTION  
 

The values entered take immediate effect. 
 

 
Figure 7-58 Entering P-gain 

 
3. For verification purposes, perform the measurement again. 
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4. With the modified parameters, the controller displays a much better transient response. If 
necessary, you can continue changing the value until the transient response is optimal. 

 
Figure 7-59 Measurement with modified P-gain 

7.14 Downloading and storing user data 

Overview 
After commissioning the SIMOTION D4x5, we recommend that you back up the user data 
(programs, configuration data, and parameter assignments) to the CF card. 

Loading user data 
The "Target system" > "Load" > "Download to target system" menu command is used to 
transfer the following data from the SIMOTION SCOUT Engineering System to the "non-
volatile data" area of the SIMOTION D4x5: 
● Configuration data 
● Programs 
● Parameter assignments 
● Technology packages 
The hardware configuration of SIMOTION D4x5 and the retain variables are also saved to 
the "non-volatile data" area.  
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 Note 
Using the menu:  
• "Target system" > "Load" > "Download to target system" downloads all of the project data 

to the target system. 
• "Target system" > "Load" > "Download" only downloads the data of the selected 

device/drive element to the target system. 
After the SIMOTION D4x5 is switched off, the contents of the "volatile data" area are lost. 

 

Additional information on the SIMOTION SCOUT Engineering System can be found in the 
SIMOTION SCOUT Configuration Manual. 

Storing user data 
In SIMOTION SCOUT, the "Copy RAM to ROM" menu command saves the following data 
from the RAM to the CF card: 
● Technology packages and user data from the "volatile data" area 
● Baud rate, PROFIBUS DP addresses, IP address, subnet dialog and router address, and 

the Retain variables with their initial values from the "non-volatile data" area 
 

 
 

Note 
The "Copy RAM to ROM" function does not save the current values of the retain variables 
to the CF card. Use the system function "_savePersistentMemoryData" for this. 

 

For the SINAMICS Integrated, a "Copy RAM to ROM" function must be performed 
separately. This requires that the drive element has been selected in the project navigator.  

See also 
Properties of the user memory (Page 73) 
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7.15 Deleting data 

7.15.1 Overview of data deletion 
The SIMOTION D4x5 memory described in the "user memory concept" can be deleted in 
various gradations. This enables you to determine whether data in your system should be 
deleted completely or partially.  
You have the following options for deleting SIMOTION C4x5 data: 
● Memory reset of SIMOTION D4x5 
● Deleting user data from CF card 
● Setting SINAMICS Integrated to the default settings 
● Setting SIMOTION D4x5 to the default settings 

7.15.2 Overall reset of SIMOTION D4x5 

Introduction 
During the memory reset operation, the memory of the SIMOTION D4x5 and the non-volatile 
data in the SRAM, except for the communication configuration (baud rates, network 
addresses, etc.), are deleted. The data on the CF card are retained during the memory reset.  
You must perform a memory reset of SIMOTION D4x5: 
● When you want to undo changes you have made to your user data (programs, 

configuration data, parameter assignments) that you have not backed up with the "Copy 
RAM to ROM" menu command. 

● If the STOP LED is flashing (yellow and slowly) to indicate that the SIMOTION D4x5 is 
requesting a memory reset. 

● When the retain data do not match the project on the CF card, resulting in an error 
(diagnostic buffer entry). 

You can perform the memory reset online via SIMOTION SCOUT or offline via the mode 
selector on the SIMOTION D4x5. 

Data deleted on memory reset 
The following data are deleted during a memory reset: 
● User data (units, configuration data, parameter settings, task configuration) 
● Technology packages 
● Retain TO (absolute encoder adjustment) 
● Retain variables 

Retain variables are variables in the interface or implementation section of a UNIT 
declared with VAR_GLOBAL RETAIN 
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Note 
Absolute encoder data are deleted during a memory reset operation and must therefore 
be readjusted after the memory reset. 

 

Reset-proof data 
The following data are retained during a memory reset: 
● TCP/IP parameters and DP parameters 
● Diagnostics buffer 
● Data that was saved with the _savePersistentMemoryData, _saveUnitDataSet or 

_exportUnitDataSet commands and the "Copy RAM to ROM" function. 
If backup files (PMEMORY.XML/PMEMORY.BAK) have been backed up with 
_savePersistentMemoryData, the data in these files are backed up again to the non-
volatile data after the memory reset. Thus, the user can perform a memory reset to force 
the backed up non-volatile data to be restored. 

● Licenses 
The technology packages and user data (configuration data, programs, parameter 
assignments) that were previously backed up to the CF card using the "Copy RAM to ROM" 
menu command will be transferred to the "non-volatile data" area of the SIMOTION D4x5 
during the next power-up. Thus, an existing configuration on the CF card is loaded to the 
SIMOTION device following the memory reset. 

Memory reset via SIMOTION SCOUT 
You can only perform a memory reset via SIMOTION SCOUT if you are online with the 
SIMOTION D4x5. 
1. Select the SIMOTION D4x5 in the project navigator of SIMOTION SCOUT. 
2. Select "Target device" > "Control Operating Mode" from the context menu in order to 

open the "D4x5: System Mode" dialog box. 
3. Select the STOP mode. 
4. Then select MRES mode to perform the memory reset.  
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Memory reset with the mode selector 
You can perform a memory reset with the mode selector if you are offline with the 
SIMOTION D4x5. 

 

CAUTION  
Always use an insulated screwdriver to activate the mode selector. Otherwise, static 
electricity can destroy the switch. 

 

Proceed as follows to initiate a memory reset:  
1. Place the mode selector in the STOP position (selector setting 2, see figure below). 

 
Figure 7-60 Memory reset with the mode selector (STOP position) 

 
2. When the yellow STOP LED illuminates, turn the selector to the MRES position (selector 

setting 3). The STOP LED begins to flash. 
Wait until the STOP LED stops flashing. 

3. Turn the selector back to the STOP setting. 
4. You must turn the selector back to the MRES position again within 3 seconds. The 

memory reset will now be performed. 
The SIMOTION D4x5 has completed the memory reset when the STOP LED is 
illuminated (not flashing). 

 

 
 

Note 
If you do not return the mode selector to the MRES position (selector setting 3) within 3 
seconds (i.e. you allow more time to elapse), under certain circumstances the memory 
reset will not take place. You must then repeat the procedure. 

 

NOTICE  
 

Note that the MRES position (selector setting 3) during power-up causes the default 
settings to be restored. See "Setting SIMOTION D4x5 to the default settings". 
Make sure you do not accidentally switch the power supply OFF/ON in the MRES 
selector setting, as this will reproduce the default settings instead of performing the 
desired memory reset. 
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7.15.3 Deleting user data from CF card 

Overview 
You can delete the user data with SIMOTION SCOUT. This requires you to go online on the 
SIMOTION D4x5. The following data are deleted during this operation: 
● User data from the "volatile data" area 
● Non-volatile data, except for the IP and DP parameters 
● User data on the CF card (user directories), including the SINAMICS configuration 
You can thus continue to go online to the SIMOTION D4x5 with your PG/PC. The licenses 
on the CF card are retained.  

Deleting user data 
1. In SIMOTION SCOUT, open the project you want to modify. 
2. Go online with the SIMOTION D4x5. 
3. Select the SIMOTION D4x5 in the project navigator and select the "Delete User Data on 

Card" option in the "Target System" menu. 
4. Confirm the "Delete User Data from Card" prompt with "OK". 

The user data are deleted, and the SINAMICS Integrated goes offline. 
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7.15.4 Restoring the default settings of SINAMICS Integrated 

Prerequisite 
You must be online to SINAMICS Integrated in order to restore its default settings.  

Restoring the default settings 
1. Right-click "SINAMICS_Integrated" in the Project Navigator. 
2. Select the "Target device > Restore default settings" command from the shortcut menu. 
This restores the delivery state of SINAMICS Integrated. 

7.15.5 Setting SIMOTION D4x5 to the default settings 

Overview 
SIMOTION D4x5 is supplied with preset parameters, such as the transmission rate or 
PROFIBUS addresses. You can restore the default settings with the mode selector. The 
following data are deleted during this operation: 
● Non-volatile data in the SIMOTION device 
● The backup copy of the non-volatile data on the CF card 

(PMEMORY.XML/PMEMORY.BAK) 
● User data from the "volatile data" area and on the CF card 
● The communication configuration (IP parameters and DP parameters) 
The licenses on the CF card are retained.  

Restoring default settings with the mode selector 
1. The power supply is switched off. 
2. Set the mode selector on the SIMOTION D4x5 to MRES (selector setting 3). 
3. Switch on the power supply. 

The backed-up SRAM and the user data are deleted. The default settings are loaded. 
SIMOTION D4x5 is in STOP mode. 

4. Now use the mode selector to change to the desired operating mode. 
 

 
 

Note 
The communication parameters are now reset to the default settings (PROFIBUS 
address 2, baud rate of 1.5 Mbit/s). The communication configuration for SIMOTION 
D4x5 must be repeated. 
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7.16 Powering down the system 
If you wish to shut the system down, you must ensure that all axes and system parts are set 
to a safe state. You can accomplish this, for example, by providing a separate motion task 
for this purpose.  
Once the system is at a standstill, you can switch off the power supply. 

 

 Note 
You must observe the safety notices for SINAMICS components, which you can find in the 
corresponding SINAMICS manuals. 

 

7.17 Configuring Safety Integrated functions 

Integrated safety functions 
The integrated safety functions of SINAMICS S120, when used in conjunction with 
SIMOTION D, provide highly effective application-oriented protection for personnel and 
machinery. 
The following Safety Integrated functions are currently available: 
(Terms in accordance with IEC 61800-5-2) 
● Safe Torque Off (STO) 
● Safe Brake Control (SBC) 
● Safe Stop1 (SS1) 
● Safe Stop2 (SS2) 
● Safe Operating Stop (SOS) 
● Safely Limited Speed (SLS) 
● Safe Speed Monitor (SSM) 

Control circuit 
The Safety Integrated functions are completely integrated into the drive system. They can be 
activated as follows: 
● Via terminals on the Control Unit and on the power unit (STO, SBC, SS1 only) 
● Via terminals on the TM54F Terminal Module (SIMOTION V4.1 SP1 and higher) 
● Via PROFIBUS with PROFIsafe (SIMOTION V4.1 SP1 HF6 and higher) 
The Safety Integrated functions are implemented electronically and therefore offer short 
response times in comparison to solutions with externally implemented monitoring functions. 
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 Note 
Although SIMOTION does not contain any safety-related functionality, it provides support for 
SINAMICS drives that can perform safety-related functions. 
The purpose of this support that SIMOTION offers for the safety-related monitoring functions 
is to prevent fault reactions at the drive end by ensuring that the drive does not exit the 
monitored operating state. 

 

Hardware required 
Where safety functions are controlled via the TM54F or PROFIBUS with PROFIsafe, at the 
very least the following hardware versions must be used: 
● SIMOTION D425: 6AU1425-0AA00-0AA0, product version D 
● SIMOTION D435: 6AU1435-0AA00-0AA1, product version D 
● SIMOTION D445: 6AU1445-0AA00-0AA0, product version B 
● SIMOTION CX32: 6SL3040-0NA00-0AA0 

Quantity structures 
The maximum number of servo drives with Safety Integrated functions for each Control Unit 
is: 

Table 7- 19 SIMOTION D4x5 quantity structures 

Control unit Maximum number of servo drives when safety function is activated 
 Via CU/EP terminals Via TM54F terminals Via PROFIBUS with 

PROFIsafe 
SIMOTION D4x5 6 5 5 
SIMOTION D4x5  
(with CX32) 

5 4 4 

CX32 6 5 4 (V4.1 SP1 HF6) 
5 (V4.1 SP2 and 
higher) 

Safety Integrated functions with TM54F 
Safety Integrated functions are activated via fail-safe digital inputs on the TM54F. This 
means that every drive control (SINAMICS Integrated of SIMOTION D4x5, CX32, CU320, 
etc.) requires its own TM54F (assuming relevant safety functions are to be used on the 
Control Unit concerned). 
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Safety Integrated functions with PROFIsafe 
Safety Integrated functions are activated via "PROFIsafe on PROFIBUS" safe 
communication. Control (F logic) is based on a SIMATIC F CPU connected via PROFIBUS 
to PROFIsafe. Examples are the SIMATIC S7-300 CPU 317F-2 DP (not pictured) or the ET 
200S IM151-7 F-CPU with the PROFIBUS DP master interface module (see image). 

 
Figure 7-61 SIMOTION D, control of F functions via PROFIBUS with PROFIsafe 

Topologies 
The topologies that may be used with the SIMOTION D4x5 and CX32 are listed below. In 
each case, the description specifies whether the control of Safety Integrated functions is 
routed through the drives. 
● SIMATIC F CPU (master), connected via PROFIBUS with PROFIsafe to SIMOTION D4x5 

(intelligent DP slave) 
– Routing to SINAMICS Integrated drives for the D4x5 and CX32, as of V4.1 SP1 HF6 
– Routing to drives of a CU310/CU320 connected to the D4x5, as of V4.1 SP2 

(CU310/CU320 is connected as a slave to the DP master interface of the D4x5) 
● SIMATIC CPU (master), F slave-to-slave communication between a SIMATIC F CPU 

(slave) and a SIMOTION D4x5 (slave) via PROFIBUS with PROFIsafe; 
– Routing to SINAMICS Integrated drives for the D4x5 and CX32, as of V4.1 SP2 
– Routing to drives of a CU310/CU320 connected to the D4x5, as of V4.1 SP2 

(CU310/CU320 is connected as a slave to the DP master interface of the D4x5) 
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● SIMOTION D4x5 is the master for F slave-to-slave communication - e.g. between a 
SIMATIC F CPU and a CU320, as of V4.1 SP1 

 

 
 

Note 
Control for the Safety Integrated functions cannot be routed to the SINAMICS Integrated 
of the D4x5 or a CX32 in this constellation. 

 

Additional references 
Additional information on configuring Safety Integrated functions can be found in the  
● SINAMICS S120 Safety Integrated Function Manual 
● TO Axis Electric/Hydraulic, External Encoder Function Manual 
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Service and maintenance 8
8.1 Upgrading or replacing D4x5 

Introduction 
A distinction can be made between the following cases in terms of upgrading and replacing: 
● Replacing modules (see Replacing modules (Page 224)) 

Replacing components (spare parts) 
– Replacing parts for SIMOTION D4x5 
– Removal and replacement of the SIMOTION D4x5 
– Replacing modules for D4x5 without PC/PG 
– Replacing DRIVE-CLiQ modules 

● Performing a software and firmware upgrade (see Performing a software and firmware 
upgrade (Page 229)) 
Updating firmware for D4x5 and SINAMICS Integrated 
– Upgrading the SIMOTION D4x5 
– Upgrading the SINAMICS Integrated 

● Adapting a project for new modules (see Adapting a project for a new module 
(Page 233)) 
The project needs to be adapted when you want to change the type (e.g. D425 -> D435) 
or version of the SIMOTION device in your existing project.  
– Replacing the SIMOTION device in HW Config 
– Upgrading technology packages 
– Upgrading libraries 
– Upgrading the CF card's bootloader 

● Upgrading SIMOTION D Control Units and projects with upgrade data created previously 
(see Upgrading SIMOTION devices (device update tool) (Page 236)) 
– Creating upgrade data using the SCOUT "Start update devices tool" function 
– Transferring upgrade data to the CF card, USB memory stick, or IT DIAG file 
– Upgrading modules with the option of downgrading if the upgrade does not produce 

the desired result 



Service and maintenance  
8.2 Replacing modules 

 D4x5 
224 Commissioning and Hardware Installation Manual, 08/2008 Edition 

Upgrading or replacing hardware 
If you want to change from one module to the other, there are several points that have to be 
observed.  
● The number of DRIVE-CLiQ interfaces is different for the various versions; see the 

SIMOTION D4x5 Manual. 
● A connected CX32 is assigned a fixed DRIVE-CLiQ address which might require 

reconfiguration, e.g. if changing from a SIMOTION D435 (4 DRIVE-CLiQ ports) to a 
SIMOTION D445 (6 DRIVE-CLiQ ports). See the section titled Configuring a CX32 
(Page 139). 

● You must upgrade the firmware of the components as well as the firmware of the 
SINAMICS components: See the section titled "SIMOTION D software and firmware 
upgrade." 

8.2 Replacing modules 

8.2.1 Parts replacement for SIMOTION D4x5 

Replacement rules for SIMOTION D435 
In the case of replacement parts, you cannot replace the modules as you wish. You must 
comply with the following rules for a SIMOTION D435: 
● A SIMOTION D435 with the order number 6AU1 435-0AA00-0AA0 can be replaced by a 

SIMOTION D435 with the order number 6AU1 435-0AA00-0AA1. 
 

 
 

Note 
A SIMOTION D435 with the order number 6AU1 435-0AA00-0AA1 can not be replaced 
by a SIMOTION D435 with the order number 6AU1 435-0AA00-0AA0. 

 

SIMOTION D4x5 replacement with firmware downgrade 
When replacing a SIMOTION D4x5 V3.2.x with a SIMOTION D4x5, on which a version >= 
V4.0 has previously been run, the following behavior may be observed: 
● The module signals "Reset requested" (after power-up, the STOP LED flashes yellow at 

0.5 Hz) and 
● It is not possible to go online. 
This scenario occurs if the module still contains retain data from a project >= V4.0 that is not 
compatible with a V3.2.x project (buffering of retain data by SuperCap or the battery used). 
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The following options can be used to delete retain data: 
● Option 1: Reset the SIMOTION D4x5 to its default settings via the mode selector. This 

involves turning the PLC switch (right-hand switch) to position 3 whilst the SIMOTION 
D4x5 is switched off, and then switching on the 24 V supply. Once the module has 
powered up ("STOP" LED is no longer flashing), the PLC switch can be set to "0" once 
more and the project can be loaded. 

 

NOTICE  
 

All project data on the CF is deleted! (see Setting SIMOTION D4x5 to the default 
settings (Page 218)) 

 

● Option 2: Delete the SIMOTION D4x5 retain data using the service selector switch. This 
involves turning the SIM/NCK switch (left-hand switch) to position 1 whilst the SIMOTION 
D4x5 is switched off, and then switching on the 24 V supply. After the power-up, the 
SIM/NCK switch must be set to "0" once more. Using this method will ensure that the 
project data remains on the CF card. 

See also 
Removal and replacement of the SIMOTION D4x5 (Page 225) 

8.2.2 Removal and replacement of the SIMOTION D4x5 

Removing the control unit 
 

WARNING  
The control unit can be replaced only when the load power supply has been switched off. 
Therefore, switch off the power supply now. 

 

You can only replace SIMOTION D4x5 as a complete unit.  
Proceed as follows: 
1. Switch off the power supply. 
2. Remove the front cover and remove the Compact Flash card from the plug-in slot. 
3. Undo the connections on the terminal strip for the power supply. 
4. Disconnect the DRIVE-CLiQ connectors to the SINAMICS S120 modules, the connectors 

for the PROFIBUS DP interfaces (X126 and X136), and, if necessary, the Ethernet 
connectors to the X120 and X130 interfaces. 

5. If necessary, remove the connectors to the digital inputs and outputs at interfaces X122 
and X132. 

6. Disconnect any option module which may be inserted (CBE30, TB30). 
7. Depending on the mounting method, lift the control unit from the connection to the 

SINAMICS S120 drive assembly or remove the mounting screws of the control unit. 
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Installing a new module 
Proceed as follows to install a new SIMOTION D4x5:  
1. Remove the front cover from the new control unit. 
2. Mount the new control unit as described. 
3. Reconnect all connectors that were removed previously. 
4. Connect the load power supply on the terminal strip. 
5. Reapply the provided shielding for all cables. 
6. Reinsert the original Compact Flash card in the plug-in slot. 
7. Reattach the front cover and close it. 
8. Switch on the power supply. The control unit is immediately ready to operate. 

See also 
Parts replacement for SIMOTION D4x5 (Page 224) 

8.2.3 Replacing modules for SIMOTION D4x5 without PC/PG 

Requirement 
If a SIMOTION D4x5 must be replaced and a PG/PC is not available, you can only load your 
data to the new module from the CF card. 
During commissioning, you must have saved your project to the CF card (for example, by 
using a CF card adapter or online using "Copy RAM to ROM"). 

Transferring data 
The CF card contains the following data, which can be transferred to the new module: 
● SIMOTION Kernel (D4x5 firmware) 
● Technology packages 
● User data 
● Baud rate 
● PROFIBUS DP addresses 
● IP address, subnet dialog, and router address 
Non-volatile data can only be transferred to the new device if a backup to the CF card is 
performed on the SIMOTION D4x5 using the "_savePersistentMemoryData" command. 
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 Note 
If an absolute encoder overflow occurs after "_savePersistentMemoryData", the actual 
position value will not be correct after the data have been restored. In this case, homing 
(absolute encoder adjustment) must be repeated. 
The retain variables are saved with their initial values. 
The current values of the Retain variables are lost!  
The diagnostics buffer is lost! 

 

See also 
User memory concept (Page 72) 

8.2.4 Replacing the DRIVE-CLiQ module 

Module replacement 
DRIVE-CLiQ can be replaced or newly inserted during operation (without POWER OFF) or 
when the system is switched off.  

Requirement 
● The affected main components are located at the end of the line. 
● If an infeed is affected, the power units supplied by it are inoperable. 

Procedure for "Removing a component" 
1. Deactivate the affected component or drive object. 
2. Remove the DRIVE-CLiQ connector. 
3. Remove the supply voltage of the component and uninstall the component. 

Procedure for "Installing a component" 
1. Install the component and connect the supply voltage again. 
2. Reconnect the DRIVE-CLiQ cable at the same location (port). The cable must have the 

same length as the old one. 
3. Activate the affected component or drive object. 

 

WARNING  
 

In order to replace this component, the power in the module must be switched off. 
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Parameters for topology comparator and component replacement 
In the expert list, you can use CU parameter p9906 to specify how the electronic type plates 
are compared for all the components of a Control Unit. The type of comparison can be 
changed subsequently for each individual component by using p9907/p9908 or right-clicking 
in the topology. All data on the electronic type plate is compared by default. 
● For p9909 = 1, the serial number and the hardware version of the new replaced 

component are automatically transferred from the actual topology into the target topology 
and then saved in a non-volatile manner. 

● For p9909 = 0, serial numbers and hardware versions are not automatically transferred. 
With this setting, spare parts/component replacement without tool support (SINAMICS V2.2 
and higher) can be performed. The new serial number of the spare part is automatically 
transferred from the actual topology to the setpoint topology and saved in non-volatile 
memory. In order for this to occur, the exchanged components must be of the same type and 
have the same order number, such as "6SL3055-0AA0-5BA0". The last or last two digits of 
the order number (depending on the component type) are not checked, as the HW version, 
for example, is encoded in these positions. This mechanism is also applied when several 
components are replaced. 

Modified wiring following module replacement 
With the default setting of the topology comparator, modified wiring configurations of the 
DRIVE-CLiQ components (e.g. a cross-exchange) are not accepted for safety reasons and 
are generated by a malfunction.  
If a cross-exchange of components is required (i.e. existing components are replaced with 
other existing components, and no spare parts are used), e.g. for troubleshooting purposes, 
the topology comparator must be reduced via parameter p9906, or preferably via 
p9907/p9908; alternatively, by right-clicking in the topology. 

 

NOTICE  
In this case, incorrect insertion of components is no longer monitored. 

 

Automatic upgrading/downgrading 
Starting with SINAMICS firmware version 2.5, the DRIVE-CLiQ components are 
automatically upgraded or downgraded to the version of the component firmware on the CF 
card. Components that cannot be downgraded to the component firmware version on the CF 
card (for example, old firmware on the card and new components on which the old firmware 
cannot be loaded) retain their firmware version. The resulting firmware version combinations 
are always functional. 
An upgrade/downgrade operation in progress is indicated on the components (e.g. Motor 
module, Terminal module, etc.) by a 0.5 Hz red/green flashing LED and on the SIMOTION 
D4x5/CX32 by a 0.5 Hz yellow flashing RDY LED. 
Once the firmware upgrade/downgrade has been successfully completed, this is indicated on 
the components by flashing at a frequency of 2 Hz and on the SIMOTION D4x5/CX32 by 
yellow flashing of the RDY LED at 2 Hz. After the upgrade/downgrade is completed, the 
power must be cycled off and back on (POWER OFF/ON). The upgrade/downgrade function 
can be deactivated using the p7826 CU parameter in the expert list.  
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Additional references 
For additional information about this topic, consult the SINAMICS S120 Commissioning 
Manual. 

8.3 Performing a software and firmware upgrade 

Upgrading the SIMOTION D4x5 
The actions described in this section also apply to downgrading to an older version. There 
are various options for performing a software and firmware update for the SIMOTION D4x5: 
● Upgrade with a CF card adapter 
● Upgrade using IT-DIAG (license required) 
● Upgrade using the SCOUT "Start update devices tool" function 

Upgrade with a CF card adapter 
The current firmware for the SIMOTION devices can be found on the SIMOTION SCOUT 
DVDs (e.g. the d4xx.zip file for the SIMOTION D4xx firmware is located in the 
\3_D4xx\Firmware\... directory). Upgrading the SIMOTION D4x5 automatically updates the 
firmware of all connected SINAMICS components. 

 

 Note 
Observe the readme files and upgrade instructions included in the delivery of new 
SIMOTION versions. Use only CF cards that have been released for SIMOTION D4x5 and 
have an appropriate and correct bootloader version. 

 

You can obtain the compatibility relationships from the "software products" compatibility list 
on the SIMOTION SCOUT Add-On CD, as well as on the Internet at 
http://support.automation.siemens.com/WW/view/en/18857317. 

 

NOTICE  
The upgrade operation deletes all project data and parameters from the CF card! 
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Procedure 
To perform an upgrade, proceed as follows: 
1. Switch off the power supply. 
2. Remove the CF card from the SIMOTION D4x5 and insert it in the CF card adaptor of 

your PC. 
3. Open Windows Explorer. The CF card must be displayed as a removable storage device 

with any drive letter in Windows Explorer. 
4. If your application involves backing up your data to the CF card (_saveunitdataset), 

proceed as follows: 
Save the "...\USER\SIMOTION\USER_DIR\UPP\UNITDS" folder to the CF card using the 
Card Reader tool and Windows Explorer on the PC/PG. 

5. Delete all data from the CF card. 
6. Completely unzip the file provided to the CF card, using a ZIP file utility such as "WinZip". 

Please observe that the file structure has to be kept in the unzip settings. 
7. Copy the folder saved in step 4 back to the appropriate folder structure on the CF card. 
8. Remove the CF card from the CF card adaptor of your PG/PC. 
9. Insert the prepared CF card in the SIMOTION D4x5. 
10. Switch on the power supply for the SIMOTION D4x5. 

The new firmware is loaded from the CF card to the SIMOTION D4x5. 
 

 
 

Note 
The license key is stored in the "KEYS" directory on the CF card. When the SIMOTION 
device powers up for the first time (firmware version V4.1 or higher), the license key is 
saved in the boot sector of the CF card. The license key in the boot sector cannot be 
deleted by an operation action. The license key remains saved even by formatting the CF 
card or rewriting the bootloader. 
If the license key is no longer present on the CF card (because the "KEYS" directory has 
been deleted, for example), it will be written again from the boot sector to the "KEYS" 
directory while the SIMOTION device is powering up. The license key can be changed at 
any time, for example, by relicensing. At the next startup, the license key will be saved 
again in the boot sector. 
If you are using a firmware version < V4.1, or the license key has not yet been backed up 
by a power-up, back up the license key as outlined in step 4 and transfer it back to the CF 
card as outlined in step 7. 
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New compilation and loading of a project 
After having upgraded the controller, the project must be newly compiled and loaded. If you 
are loading the SIMOTION configuration and the SINAMICS configuration simultaneously 
(standard setting when clicking the download button in the toolbar), SIMOTION SCOUT goes 
online to the SINAMICS after downloading the SIMOTION part and loads this part into the 
device as well.  
The firmware update is performed automatically. After an automatic firmware update, the 
modules must be switched off and on. This is also indicated with a message in the alarms 
window in the details area. 

Updating the firmware of the SINAMICS components 
With SINAMICS V2.5 and higher, the firmware of DRIVE-CLiQ components is upgraded 
automatically, depending on parameter p7826. 
● p7826 = 0: Upgrade/downgrade deactivated 
● p7826 = 1: Upgrade and downgrade 
● p7826 = 2: Upgrade only 
 

 

CAUTION  
The automatic FW update via p7826 = 1 (upgrade and downgrade) must not be deactivated 
when Safety Integrated is used. 

 

If you are upgrading the firmware manually, proceed as follows:  
1. In the project navigator, select the SINAMICS component, such as the SINAMICS 

Integrated. 
2. Double-click "Configuration" in the project navigator. 

The "SINAMICS_Integrated - Configuration" dialog box will open with a list of available 
drive objects. 

3. Click "Version Overview" to display a list of connected SINAMICS components. 
4. Go online and select the devices whose firmware you wish to update. 

The list displays the current firmware version of the devices. 
5. Click "Firmware update" to download the new firmware to the devices. To do so, you 

must all components whose firmware is to be updated. 
6. When the firmware update is completed, cycle the 24 V power supply off and on again. 

The device is ready to operate. 
 

 
 

Note 
The SINAMICS components must be parameterized for a firmware update. Otherwise, 
the firmware cannot be updated. 
You can also update the firmware by means of the Expert list. Refer to the SINAMICS 
S120 Commissioning Manual for a description of this procedure. 
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Upgrading the device version of SINAMICS components 
You can upgrade the device versions of the configured SINAMICS devices (SINAMICS 
Integrated, CX32 or CU3xx) using SIMOTION SCOUT. An upgrade is required for the 
SINAMICS Integrated / CX32, for example, in the following cases: 
● A different SINAMICS version is to be assigned to a SIMOTION version (e.g. for D445 

V4.0: from S120 V2.4 to SM150 V2.4) 
● The module type has been changed (e.g. from D435 to D445) 
● A module version has been changed (e.g. from D435 V4.0 to D435 V4.1) 

 

 
 

Note 
The SINAMICS version can only ever be upgraded in a project; it cannot be downgraded. 
Each SINAMICS Integrated and each CX32 must be upgraded separately. A CX32 must 
always be operated with the same version as the SINAMICS Integrated 

 

As an alternative to the following described procedure, the device versions of all configured 
SINAMICS devices (only SINAMICS Integrated and CX32, not CU3xx) can also be 
automatically upgraded via an "Upgrade of technology packages". This is particularly 
suitable for the upgrade of projects to another version, as generally the technology packages 
are also upgraded. Refer to Adapting a project for a new module (Page 233). 
To upgrade a SINAMICS device: 
1. Right-click the respective device, e.g. the "SINAMICS_Integrated". 
2. Select "Target Device" > "Device Version" in the context menu. 

The "Device Version" dialog is displayed. All available firmware versions are listed there. 

 
Figure 8-1 Device version 

 
3. Select the device version of the SINAMICS Integrated you are using and click "Change 

version". 
The SINAMICS components are thus updated. 
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Loading a project to the target system 
1. Click "Connect to target system" to establish a connection to the target system. 
2. Perform a "Download" followed by "Copy RAM to ROM" to download the updated offline 

project back to the drive unit. 
The automatic follow-up configuration in the target device means that you must once again 
perform "Load to PG" followed by a backup. 

8.4 Adapting a project for a new module 
The project needs to be adapted when you want to replace the type (e.g. D425 -> D435) or 
version of the SIMOTION device in your existing project. Perform this replacement in 
HWConfig. 
One SIMOTION D can only be replaced by another if the SINAMICS version involved is the 
same or higher. It is not possible to downgrade to a lower SINAMICS version. 

To replace a SIMOTION device: 
1. Double-click the SIMOTION device to be replaced in the project navigator in SIMOTION 

SCOUT. HW Config is opened. 
2. Open the "SIMOTION Drive-Based" folder in the hardware catalog. 

 

 
 

Note 
SIMOTION D is modeled as a compact device in HW Config. When modules are being 
replaced, this means the new module must be moved to the header of the module rack 
shown and not to slot 2. Please make sure that you do not delete the D4x5 rack!  
When you drag and drop the new module to the rack header, the old module will be 
replaced. Alternatively, you can: 
• Select the rack header and double-click the new module in the module catalog to 

replace the previous module, or: 
• Right-click the rack header and select "Replace object". 

 

3. Drag and drop the new module to the top field of the module rack. 
4. Confirm the displayed dialog box with "Yes" if you want to replace the SIMOTION device. 
5. Accept the changes made to the hardware configuration with "Station" > "Save and 

Compile". 
6. Close HW Config. 
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Note 
The data for the SIMOTION device is immediately accepted in the SIMOTION SCOUT 
project, and the entire project is saved. In this way, the project also accepts all changes in 
the project (e.g. axis configuration). 
If you are using technology packages in your project, these will also need to be updated. 

 

Upgrading technology packages 
When modules are replaced or project data is imported, the versions of the technology 
packages (TP) assigned to the individual technology objects (TO) are not automatically 
upgraded to a version valid for the SIMOTION device. This upgrade requires a separate 
step.  

To adapt the technology package version of the new SIMOTION device: 
1. Select the desired SIMOTION device in the project navigator. 
2. Choose "Select Technology Packages" from the context menu. 

 

 
 

Note 
If the last step you performed was to replace the SIMOTION device, the "Technology 
Packages from Another Version" dialog box appears. Confirm this with "OK" to delete the 
existing links to the technology packages, thus enabling new technology packages to be 
assigned. The "Select Technology Packages" dialog box will now appear. 

 

The "Select Technology Packages" window opens. 
3. Activate the checkbox for the technology packages. 

The technology packages must have the same version as the kernel. Consequently, in 
SIMOTION SCOUT V3.0 and higher, the same version as the kernel is automatically 
assigned to each technology package. 

4. If technology objects for your project indicating an incorrect version appear under 
"Incorrect version", click "Update". Otherwise, continue with step 6. 

 

 
 

Note 
The device versions of all configured SINAMICS devices (only SINAMICS Integrated and 
CX32, not CU3xx) can also be automatically upgraded via the "Update" button. 

 

5. The "Update Technology Packages" dialog box opens. 
Confirm with "OK". A message appears. 

6. Confirm the message with "OK". 
7. If the update is successful, a message appears. Confirm with "OK". 
8. Confirm the "Select Technology Packages" dialog window with "OK". 

The TP upgrade is complete. 
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Upgrading the library 
An upgrade of the libraries you are using is required if the version of the SIMOTION device 
or TOs in your existing project has changed. 
1. Open the LIBRARY directory in the project navigator. 
2. Select a library, right-click to open the context menu, and select "Properties...." 
3. Select the "TPs/TOs" tab in the "Properties" window. 
4. Select the SIMOTION device and the technology packages for which the library is to be 

valid. 
5. Close the dialog box with "OK". 

 

 
 

Note 
Please also observe the notes on device-dependencies in the SIMOTION SCOUT online 
help. 

 

Save variables 
Retentive and non-retentive data is retained by an upgrade within a version (e.g. V4.1 SP1 
to V4.1 SP2). This is not the case with a platform replacement or version change. 
If you replace the SIMOTION platform or change the version, you must back up the data in 
order to be able to use this again. With the "Save variables" function, you have the possibility 
of saving and restoring retentive and non-retentive data, unit variables in the interface and 
implementation sections, as well as global device variables. 

Upgrading the CF card's bootloader 
Upgrading the D4x5 may also render it necessary to upgrade the bootloader of the CF card. 
Detailed information on the compatibility relationships for the CF card, bootloader version, 
SIMOTION D4x5 hardware and SIMOTION firmware version can be found in the software 
compatibility list. This list is available both in the supplied documentation of the SIMOTION 
SCOUT CD at \1_Important\German\Kompatibilität\ . . . and on the Internet at 
http://support.automation.siemens.com/WW/view/en/18857317. 

Additional references 
For more information, refer to the SIMOTION SCOUT Configuration Manual. 

See also 
Bootloader on the CompactFlash card (Page 241) 
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8.5 Upgrading SIMOTION devices (device update tool) 

Overview 
With SIMOTION V4.1 SP2 and higher, SIMOTION D Control Units and projects can be 
upgraded using previously created upgrade data. 
Performing an upgrade using upgrade data has the following advantages: 
● User-friendly creation of upgrade data via SIMOTION SCOUT with the aid of a wizard (at 

the machine manufacturer's site) 
● SIMOTION devices can be upgraded by the machine operator without the SIMOTION 

SCOUT Engineering System. 
● The machine manufacturer can conveniently send upgrade data via e-mail or post to the 

machine operator. 
● There is no need to use license keys, as licenses are either retained or upgraded at the 

same time. 
● Retain data is retained during upgrades within a version 
● An upgrade which has been imported can be discarded again, and the previous 

configuration restored. 
● You can update either a single SIMOTION device or multiple devices from one or more 

SIMOTION projects. 
● It is possible to upgrade parts of a configuration only (e.g. Technology Packages only, 

firmware only, project only, etc.). 
Upgrade data is created by the application engineer at the machine manufacturer's premises 
using SIMOTION SCOUT. The upgrade data can then be handled flexibly depending on both 
the SIMOTION device in question (SIMOTION C, D, or P) and the customer requirements: 
● Creating upgrade data and then copying them to a storage or update medium: 

– CF card 
– USB memory stick or 
– IT DIAG file 

● Alternatively, the upgrade data can be created and stored in an archive on the PC, with a 
view to importing it to an upgrade medium suitable for SIMOTION devices at a later point. 

● The process of importing the data to an upgrade medium can be performed at the 
machine manufacturer's premises; alternatively, if the upgrade archive has been 
transferred to the machine operator, the service engineer can do this on-site. 

● The service engineer imports the upgrade data on an operator-guided basis (without any 
involvement by the application engineer) to the SIMOTION device(s), and upgrades the 
SIMOTION devices in the process (SIMOTION SCOUT is not required on-site). 

The following describes how to upgrade a SIMOTION D4x5 with a USB memory stick. This 
assumes you have a USB memory stick containing the appropriate upgrade data. 
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Requirement 
● You have a USB stick containing the upgrade data. 
● You have a SIMOTION D module with the required HW version. 
The following hardware is required in order to upgrade a SIMOTION D4x5 using a USB stick: 

Table 8- 1 Hardware required for USB stick upgrades 

Module Order No. Minimum hardware release 
required 1) 

Minimum BIOS version 
required 2) 

SIMOTION D425 6AU1 425-0AA00-0AA0 F  V00.00.04.00 
SIMOTION D435 6AU1 435-0AA00-0AA0 Update via USB stick not supported 
SIMOTION D435 6AU1 435-0AA00-0AA1 F 

 
V00.00.04.00 

SIMOTION D445 6AU1 445-0AA00-0AA0 A No restrictions 
1) You can find the hardware release marked on the type plates of the SIMOTION D. 
2) The BIOS version is shown in the device diagnostics in SIMOTION SCOUT. 

Required BIOS version 
With SIMOTION D425/D435, a BIOS version of at least V00.00.04.00 is required for USB 
support. Modules from hardware release "F" and higher are supplied with a corresponding 
BIOS version. A BIOS update can be conducted on SIMOTION D425/D435 modules with a 
BIOS version < V00.00.04.00. 
Proceed as follows to do this: 
1. Switch the module off and insert a CF card with SIMOTION D4x5 firmware version V4.1 

SP2 or higher. 
2. Turn the left rotary switch (SIM/NCK) to selector setting "12" (hex: C) 
3. Switch the module on and wait until the BIOS update has been carried out. You can tell 

when a BIOS update is complete as the D4x5 will have powered up and will be in either 
STOP or RUN mode. 

4. Switch the module off and reset the rotary switch to "0". 
 

NOTICE  
 

A BIOS update must not be interrupted under any circumstances. With this in mind, do 
not switch the module off until the BIOS update is complete. A damaged BIOS will 
require expensive repair work to be carried out at the plant. 
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Procedure 
When using a USB stick to perform an upgrade, proceed as follows: 
1. Insert the USB stick into one of the two USB interfaces on the D4x5 (only one USB stick 

may be inserted). 
2. Switch the device OFF/ON or reset it using the RESET button. 
3. SIMOTION D will now begin copying the data from the USB stick to the CF card. During 

this process, the RDY LED flashes green. Once copying is complete, the RDY LED will 
change to 
– Green (constant) if the process has completed successfully 
– Red (constant) if copying was not successful 

4. Switch the D4x5 off and remove the USB stick. 
5. Now switch the D4x5 on again. 

– If the copying procedure has been successful, the D4x5 will have been upgraded. 
– If the copying procedure has not been successful, the D4x5 powers up in the output 

configuration. 
If the upgrade has not been successful (for example, the machine is not behaving as 
desired), the upgrade can be undone as follows: 
1. Switch the D4x5 off. 
2. Turn the left rotary switch (SIM/NCK) to setting "11" (hex: B) 
3. Switch the D4x5 on. 

The D4x5 will now restore the data that was backed up during the upgrade (TP, project, 
user data). The data from the upgrade process will be deleted. The D4x5 will then restart. 
During the next power-up, the configuration will be restored to its state prior to the 
upgrade. 

4. Switch off the D4x5 and reset the left rotary switch (SIM/NCK) to selector setting "0". 

Additional references 
Detailed information on upgrading devices can be found in the Upgrading SIMOTION 
Devices Operating Instructions. 
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8.6 SIMOTION Compact Flash card 

8.6.1 Changing the CompactFlash Card 

Requirement 
 

CAUTION  
The CF card may only be unplugged and plugged in when the system is switched off (zero 
current)! 

 

Procedure 
To change the CF card, proceed as follows:  
1. Switch off the power supply. 
2. Remove the CF card from the plug-in slot of the control unit. 
3. Gently insert the new CF card into the empty plug-in slot until it clicks into place. The 

direction of insertion of the CF card is indicated by an arrow located on both the plug-in 
slot and the CF card. 
When properly installed, the card does not extend beyond the housing of the SIMOTION 
D4x5. 

4. Switch the power supply on again. 

8.6.2 Writing to the the CompactFlash card 

Overview 
You can write to the CF card by:  
● Storing the technology and user data on the CF card 

This function requires the connection to be established between the PG/PC and the 
module. 

● Writing to the CF card via the PG/PC 
For this function, you need a CF card adapter. 

 

 
 

Note 
The CF card always comes formatted. It contains the SIMOTION Kernel (D4x5 firmware).
To ensure that the CF card functions properly, the card must not be repartitioned. 

 



Service and maintenance  
8.6 SIMOTION Compact Flash card 

 D4x5 
240 Commissioning and Hardware Installation Manual, 08/2008 Edition 

Storing the technology and user data on the CF card 
The CF card can be used as storage volume for technology packags and user data 
(programs, configuration data, and parameter assignments) from the "volatile data" area. 
Use the following procedure: 
1. Establish the connection between the SIMOTION D4x5 and the PG/PC. 
2. In SIMOTION SCOUT, the CF card is written to by means of the "Copy RAM to ROM" 

menu command. 

Writing to the CF card via the PG/PC 
With a suitable memory card adapter, you can write to the CF card directly via a PG/PC. 
Always save your project data to CompactFlash Card using the programming device/PC 
before you update the SIMOTION firmware, for example. 

 

 Note 
Files that have been written to the CF card with "Copy RAM to ROM" in SIMOTION SCOUT 
must not be modified or deleted with Windows. This can corrupt the project. 

 

8.6.3 Formatting the CompactFlash card 
You can format the CF card, for example, if it is corrupt. Use the following procedure:  
1. Insert the CF card into a USB Flash card reader connected to your PG/PC. 
2. Format the CF card in Windows (FAT or FAT16 file system). 
3. If the boot sector of the CF card is also defective, you will have to rewrite the bootloader. 

 

NOTICE  
 

The CF card must only be formatted with FAT or FAT16, and must not be formatted with 
FAT32 or NTFS.  
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8.6.4 Bootloader on the CompactFlash card 

Writing a bootloader 
A bootloader may need to be written in the following situations: 
● When a new bootloader is required for the SIMOTION D4x5 firmware version used 
● When a new bootloader is required for the SIMOTION D4x5 hardware version used 
● When the bootloader is defective. 
The bootloader version can be read out using the SIMOTION SCOUT device diagnostics. If 
this is not possible because of the following reason, this can be caused by an incorrect 
bootloader version. Possible description of error: All 8 LEDs light up yellow.  
In this case, replace the bootloader version with the current version. 
Use the "Options > Write boot sector..." function to write the bootloader version in the 
SIMOTION SCOUT to the CF card. 
Detailed information on the compatibility relationships for the CF card, bootloader version, 
SIMOTION D4x5 hardware and SIMOTION firmware version can be found in the software 
compatibility list. This list is available both in the supplied documentation of the SIMOTION 
SCOUT CD at \1_Important\German\Kompatibilität\ . . . and on the Internet at 
http://support.automation.siemens.com/WW/view/en/18857317. 

8.6.5 Recommended method for dealing with CF cards 

Correct way to use the CF card 
The following points should be noted when using the CF card: 
● The CF card may only be unplugged and plugged in when the system is switched off 

(zero current). 
● CF cards cannot be rewritten as many times as the user wishes. 

With this is mind, it is better if you avoid writing user data from the application to the CF 
card on a cyclic basis. Depending on the system, a writing process from the application 
may trigger one or more writing processes on the CF card. Therefore, we recommend 
you adopt a conservative approach in terms of the number of writing processes. In other 
words, do not perform more than 100,000 write access instances from the user program 
over the estimated service life of the application. 

● We recommend you avoid switching off the module during write accesses to the CF card 
(e.g. Copy RAM to ROM, savePersistentMemoryData, _saveUnitDataSet, 
_exportUnitDataSet, etc.). 
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Diagnostics 9
9.1 Diagnostics via LED displays 

LED status key 
The LED displays indicate the different operating modes and any errors occurring on the 
SIMOTION D4x5. They do so by illuminating, flashing, or flickering in different colors.  
The following table provides an overview of all occurring LED display combinations. 
The meaning of the symbols used in the table is as follows: 
● 1 = LED on 
● 0 = LED off 
● 0.5/1 = flashing LED (0.5 Hz) 
● 2/1 = flashing LED (2 Hz) 
● λ = flickering LED 
● x=LED can illuminate 

LED displays 
Every LED can illuminate in yellow, red, or green. In the following table, the color of the LED 
is indicated along with the illumination status. 

Table 9- 1 LED displays 

Meaning LED display 
 RDY RUN STOP STOPU SF DP1 DP2 OPT 
Power-up 1 

 (yellow) 
1 
 (yellow) 

1  
 (yellow) 

1  
 (yellow) 

1  
 (yellow) 

1 
 (yellow) 

1  
 (yellow) 

1 
 (yellow) 

Power-up of the D4x5 without 
CF card or with CF card 
without valid operating system 
(the bootloader may be 
defective). 

1  
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

1 
 (yellow) 

CF card has begun to boot, 
however, an error has 
occurred (faulty FW). 

0.5/1 
(red) 

0 0 0 0 0 0  

D4x5 is ready to operate: 
SIMOTION task system is 
running, and SINAMICS 
Integrated is ready to operate 

1 
 (green) 

x x x x x x x 

SINAMICS Integrated has not 
powered up (SINAMICS 
firmware not available or 
faulty), or a fault has occurred.

1 
(red) 

x x x x 0 0 x 
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Meaning LED display 
 RDY RUN STOP STOPU SF DP1 DP2 OPT 
Read or write access to CF 
card. 

 
 (yellow) 

x x x x x x x 

Upgrade/downgrade operation 
running.  

0.5/1 
(yellow) 

x x x x x x x 

The upgrade/downgrade 
operation has completed 
(power OFF/ON of the 
upgraded/downgraded 
devices is necessary) 

2/1 
(yellow) 

x x x x x x x 

RUN x 1 
 (green) 

0 0 x x x x 

Transition from RUN - STOPU x 1 
 (green) 

0 2/1 
 (yellow) 

x x x x 

Transition from STOPU - RUN x 2/1 
 (green) 

0 1 
 (yellow) 

x x x x 

STOPU x 0 0 1 
 (yellow) 

x x x x 

Service mode x 2/1 
 (green) 

0 2/1 
 (yellow) 

x x x x 

Transition from STOPU - 
STOP 

x 0 2/1 
 (yellow) 

1 
 (yellow) 

x x x x 

STOP x 0 1 
 (yellow) 

0 x x x x 

Transition from STOP - 
STOPU 

x 0 1 
 (yellow) 

2/1 
 (yellow) 

x x x x 

Request for overall reset by 
the D4x5 itself or via the mode 
selector 

x 0 0.5/1 
 (yellow) 

0 x x x x 

Overall reset in progress 1 0 0 0 0 0 0 0 
Overall reset completed 1 

 (green) 
0 1 

 (yellow) 
0 x x x x 

An interrupt that can be 
acknowledged (alarm, 
message, note) is pending 

1 
 (green) 

x x x 1 
(red) 

x x x 

Fault is present to which the 
user program (SIMOTION) 
cannot respond. The following 
actions may be required to 
rectify the fault: 
• Power OFF/ON 
• Examine the CF card 
• New commissioning 

procedure 
• Replace the D4x5 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Λ 
(red) 

Sublicensing of 
technology/option objects 

1 
 (green) 

x x x 0.5/1 
(red) 

x x x 
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Meaning LED display 
 RDY RUN STOP STOPU SF DP1 DP2 OPT 
 
PROFIBUS DP interfaces as master 
No parameter assignment 
available 

1 
 (green) 

x x x x 0 0 x 

At least one slave is missing. 1 
 (green) 

x x x x 1 
(red) 

1 
(red) 

x 

Bus status "Clear" 1 
 (green) 

x x x x 0.5/1 
 (green) 

0.5/1 
 (green) 

x 

Bus status "Operate" 1 
 (green) 

x x x x 1 
 (green) 

1 
 (green) 

x 

 
PROFIBUS DP interfaces as i-slave 
No parameter assignment 
available 

1 
 (green) 

x x x x 0 0 x 

No parameter assignment 
master available 

1 
 (green) 

x x x x 1 
(red) 

1 
(red) 

x 

Bus status "Clear" 1 
 (green) 

x x x x 0.5/1 
 (green) 

0.5/1 
 (green) 

x 

Bus status "Operate" 1 
 (green) 

x x x x 1 
 (green) 

1 
 (green) 

x 

 
HOLD mode 
SIMOTION switches to HOLD 
mode as soon as the program 
comes to a breakpoint. When 
the program leaves the 
breakpoint, SIMOTION 
switches out of HOLD mode. 

x 0.5/1 
 (green) 

1 
 (yellow) 

1 
 (yellow) 

x x x x 

Fan not inserted or insufficient 
fan speed 
(D445 only) 

2/1 
(Red/yell
ow) 

       

Incompatible hardware; 
SIMOTION kernel is no longer 
operating with complete 
functionality on the hardware 
being used 

1  
 (yellow) 

1  
(red) 

x x x x x x 

 
No CBE30 connected        0 
CBE30 runs error-free        1 

 (green) 
Bus error (CBE30): 
• Failure of a connected I/O 

device. 
• At least one of the 

assigned IO devices 
cannot be addressed. 

• Incorrect or no 
configuration. 

       2/1 
(red) 
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Meaning LED display 
 RDY RUN STOP STOPU SF DP1 DP2 OPT 
Firmware downloaded        2/1 

 (green) 
Firmware download faulty        05/1 

(red) 
 

 Note 
There are additional status indicators available for the SF and RDY LEDs when 
upgrading/downgrading the SIMOTION D4x5 using upgrade data that has been created. 

 

Additional references 
More detailed information can be found in the Upgrading SIMOTION Devices Operating 
Instructions. 
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9.2 Diagnostics functions via the service selector switch 
The left rotary switch (SIM/NCK) allows you to write diagnostics data to the CF card. This 
diagnostics data can provide important information in the event of a fault (crash) on the 
D4x5. 
If this function has been performed, diagnostic data is written to the CF card. This data can 
then be sent in a suitable form (e.g. compressed as a *.zip file) to Technical Support for 
evaluation. 

Procedure 
Proceed as follows: 
1. Turn the left rotary switch (SIM/NCK) to setting 13 (hex: D) 
2. Switch the D4x5 off. 
3. Switch the D4x5 on. The data will be written to the CF card. Wait until the D4x5 has 

powered up. 
4. Shut down the D4x5 and remove the CF card. 
5. A DIAG folder is created in the \USER\SIMOTION\HMI\SYSLOG directory. This folder 

contains the diagnostic data. 
6. Transfer the diagnostics data to Technical Support for evaluation. 
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Standards and approvals A
A.1 General rules 

IEC 1131 
The SIMOTION programmable controller meets the requirements and criteria of the 
Standard IEC 1131, Section 2.  

CE marking 
Our products meet the general and safety-related requirements of the following EC 
guidelines and conform to the uniform standards (EN) for programmable controllers 
published in the official gazettes of the European Union:  
89/336/EEC "Electromagnetic Compatibility" (EMC guideline) 
The EC declaration of conformity is contained in this manual. 

EMC Directive 
SIMOTION products are designed for industrial use.  

Table A- 1 EMC Directive 

Field of application Requirements for 
 Emitted interference Immunity to noise 
Industry EN 50081-2 EN 61000-6-2  

UL certification 
Recognized component mark for United States and the Canada Underwriters Laboratories 
(UL) according to Standard UL 508, File 16 4110.  

Declaration of conformity 
The current Declaration of Conformity is on the Internet at  
http://support.automation.siemens.com/WW/view/de/15257461 
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A.2 Safety of electronic controllers 

Introduction 
The following remarks relate to fundamental criteria and apply irrespective of the type of 
controller and the manufacturer.  

Reliability 
Comprehensive and cost-effective measures have been taken during development and 
production to increase the reliability of the devices and components as far as possible. 
These include 
● The selection of high-quality components 
● Worst-case dimensioning of all circuits 
● Systematic and computerized inspection of all supplied components 
● Burning in of all LSI circuits (e.g. processors, memories, etc.) 
● Measures to prevent static discharge when handling MOS circuits 
● Visual checks during various stages of manufacture 
● Continuous heat testing at higher ambient temperatures for several days 
● Computerized final inspection 
● Statistical analysis of all returned goods so that corrective measures can be initiated 

immediately 
● Monitoring of the primary controller components using online tests 
These measures are considered to be basic measures for safety engineering. They avoid or 
control the majority of faults that may occur. 

Risk 
A higher degree of safety standard applies to all applications and situations where there is a 
risk of material damage or injury to persons if there is a failure. Special regulations specific to 
the system apply to such applications. These must be taken into account for configuration of 
the controller (e.g. VDE 0116 for furnaces). 
For electronic controllers with safety responsibility, the measures required for preventing or 
controlling faults depend on the hazard inherent in the plant. In this respect, the basic 
measures listed above are no longer adequate once the hazard exceeds a certain potential. 
Additional measures (e.g. double redundancy, tests, checksums, etc.) for the controller must 
implemented and certified (DIN VDE 0801).  
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Division into safety-critical and non-safety-critical areas 
Nearly all systems contain parts that perform safety-related tasks (e.g. emergency stop 
switch, protective grating, two-hand controls). To avoid having to apply safety-related criteria 
to the entire controller, it is customary to divide the controller into two areas - one that is 
critical to safety and one that is not critical to safety. No special demands are made 
concerning safety in the area that is not safety-critical as an electronic fault would not have 
any effect on the safety of the system. However, in the safety-critical area, only controllers 
and circuits that comply with the relevant regulations, may be used. 

Important note 
Even if an extremely high level of conceptual safety has been achieved in the design of an 
electronic controller - e.g. through implementation of a multi-channel design - strict 
adherence to all instructions in the operator's guide is mandatory, as incorrect handling could 
invalidate measures taken to prevent hazardous faults or create additional potential hazards. 

 

DANGER  
Electrical, magnetic and electromagnetic fields (EMF) that occur during operation can pose 
a danger to persons who are present in the direct vicinity of the product - especially 
persons with pacemakers, implants, or similar devices.  
The relevant directives and standards must be observed by the machine/plant operators 
and persons present in the vicinity of the product. These are, for example, EMF Directive 
2004/40/EEC and standards EN 12198-1 and -3 pertinent to the European Economic Area 
(EEA), as well as accident prevention code BGV 11 and the associated rule BGR 11 
"Electromagnetic fields" of the German employer's liability accident insurance association.  
These state that a hazard analysis must be drawn up for every workplace, from which 
measures for reducing dangers and their impact on persons are derived and applied, and 
exposure and danger zones are defined and observed.  
The safety information in the Storage, Transport, Installation, Commissioning, Operation, 
Maintenance, Disassembly and Disposal sections must also be taken into account. 
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A.3 Electromagnetic compatibility 

Definition 
Electromagnetic compatibility is the capability of an electrical apparatus to function 
satisfactorily in its electromagnetic environment without affecting this environment. 
The control unit complies with the requirements of the EC directive on EMC and the EMC 
law 89/339/EEC. 

Relevant standards for the electromagnetic compatibility (EMC) 
The following standards for EMC must be satisfied in order to comply with the EMC 
installation guideline (Order No. 6FC5297-☐AD30-0AP☐): 

Table A- 2 EMC standards 

Subject matter Standard 
Product standard DIN EN 61800-3 
Emitted Interference DIN EN 61000-6-4 
Immunity to noise DIN EN 61000-6-2 
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ESD guidelines B
B.1 ESD definition 

What does ESD mean?  
All electronic modules are equipped with highly integrated modules or components. Because 
of the technology used, these electronic components are very sensitive to overvoltages and 
thus to discharge of static electricity.  
The acronym ESD has become the established designation for such Electrostatic Sensitive 
Devices. The ESD designation is used internationally to refer to electrostatic sensitive 
devices. 
Electrostatic sensitive devices are identified by the following symbol: 

 
Figure B-1 Symbol for identification of electrostatic sensitive devices 

 
 

CAUTION  
Electrostatic sensitive devices can be irreparably damaged by voltages that are far lower 
than anything a person can perceive. These voltages occur if you touch a component or the 
electrical connection of a module without having previously discharged any static from your 
body. Any damage that occurs to a module as a result of overvoltage is generally not 
recognized immediately and only comes to light after the equipment has been operating for 
some time. 
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B.2 Electrostatic charging of individuals 
Any person who is not conductively connected to the electrical potential of the environment 
can accumulate an electrostatic charge. 
This figure indicates the maximum electrostatic charges that can accumulate on an operator 
when he comes into contact with the indicated materials. These values comply with the 
specifications in IEC 801-2. 

 
Figure B-2 Electrostatic voltage that can accumulate on operating personnel 
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B.3 Basic measures for protection against discharge of static electricity 

Ensure sufficient grounding 
When working with electrostatic sensitive devices, make sure that the you, your workstation, 
and the packaging are properly grounded. This prevents the accumulation of static 
electricity. 

Avoid direct contact 
You should only touch ESD components if unavoidable (for example, during maintenance 
work). When you touch modules, make sure that you do not touch either the pins on the 
modules or the printed conductors. If you follow these instructions, electrostatic discharge 
cannot reach or damage sensitive components. 
If you have to take measurements on a module, make sure that you first discharge any static 
that may have accumulated in your body. To do this, touch a grounded metal object. Only 
use grounded measuring instruments. 





 

D4x5 
Commissioning and Hardware Installation Manual, 08/2008 Edition 257 

Appendix C
C.1 List of abbreviations 

Table C- 1 Abbreviations 

Abbreviation Description 
ASIC Application Specific Integrated Circuit 
OS Operating state 
CF card CompactFlash Card 
CUA Control Unit Adapter 
DAC Digital-to-analog converter 
DESINA Decentralized and standardized installation technology for machine tools and 

manufacturing systems 
DI Digital Input 
DIP Dual In Line Package 
DO Digital Output 
DP Distributed I/O 
DRIVE-CLiQ DRIVE Component Link with IQ 
DSC Dynamic Servo Control (DSC) enables the actual position value to be evaluated in 

a fast speed controller cycle directly in the drive. 
ECOFAST Energy and Communication Field Installation System 
ESD Electrostatically Sensitive Devices 
EMC Electromagnetic Compatibility 
EP Enable Pulses 
ES Engineering System 
FW Firmware 
GSD Device master data (device parameter list for integration in HW config) 
HTL High Threshold-Logic 
HW Hardware 
IM Interface module 
I/O Input/Output 
IRT Isochronous Real Time Ethernet 
KTY Special temperature sensor 
LED Light Emitting Diode 
OLP Optical Link Plug 
PB PROFIBUS 
PELV Protective Extra Low Voltage 
PG/PC Programming Device / Personal Computer 
PN PROFINET 
PROFIBUS DP Process Field Bus - Decentral Periphery 
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Abbreviation Description 
PS Power Supply 
PTC Positive Temperature Coefficient 
PZD Process status data 
RT Real Time Ethernet (non-isochronous PROFINET) 
SBC Safe Brake Control 
SCOUT SIMOTION Controlling with Optimized Usability Toolbox  

(Engineering system in the SIMOTION product family) 
SITOP Power supply 
SM Sensor module (SINAMICS) 
SMC Sensor Module Cabinet, encoder connection to DRIVE-CLiQ 
SME Sensor Module External, encoder connection to DRIVE-CLiQ (with high safety 

class) 
SMx Sensor Module 

(overview for various sensor modules, e.g. SMI (integrated sensor module) or SME 
(external sensor module)) 

SS1 Safe Stop 1 
STO Safe Torque Off 
SW Software 
TCP/IP Transmission Control Protocol / Internet Protocol 
TIA Totally Integrated Automation 
TM Terminal Module for DRIVE-CLiQ 
TO Technology object 
TP Technology package 
TTL Transistor Transistor Logic 
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Index 

A 
Abbreviations, 258 
Active setting 

Programming devices/PCs, 97 
Ambient conditions 

Climatic, 30 
Automatic configuration, 113 
Automatic controller setting 

Position controller, 206 
Speed controller, 205 

Automatic position controller setting, 206 
Automatic speed controller setting, 205 
Axis 

Creating with axis wizard, 164 
Testing with the axis control panel, 167 

Axis control panel, 166 
Axis grouping, 17 

DRIVE-CLiQ components, 18 
SIMOTION D, 17 
SINAMICS infeed, 17 
SINAMICS power unit, 17 

B 
Bootloader, 241 

Reading, 241 
Writing, 241 

Bus connector, 56 
MPI, 61 
setting the terminating resistor, 58 

C 
CE 

Identifier, 249 
CF card 

inserting, 68 
Properties, 68 

Commissioning 
Commissioning steps, 109 
Requirements, 109 

Compact Flash card 
Changing, 239 
Writing to, 239 

CompactFlash card, 75 

Formatting, 240 
Conditions of use, 28 
Configuration 

Global measuring inputs on the D4x5, 194 
Local measuring inputs on the D4x5, 194 
Measuring inputs on the D4x5, 194 

Configuring 
DI/DOs on D4x5, 183 

Controller optimization, 208 
Automatic position controller setting, 206 
Automatic speed controller setting, 205 
Function generator, 208 
Measuring functions, 208 
Trace, 208 

CX32 configuration 
Online configuration, 145 
Overview, 139 
Requirement, 140 
topology, 143 

Cycle clock scaling 
external/internal PROFIBUS, 94 

D 
D4x5 

I/Os, 178 
installing, 226 
Message frame extension, 190 
Onboard I/Os, 178 
Removal, 225 
Replacing, 223 
Upgrading, 223 

D4x5 configuration 
Message frame 39x, 180 

D4x5 message frame configuration 
Message frame 39x, 180 

D4x5 onboard I/Os 
Digital outputs, 193 

D4x5 quantity structure 
High-speed output cams/DOs, 180 

Data transmission rate 
Aligning, 96 

Declaration of conformity, 249 
Default settings 

Restoring, 218 
Deleting data, 214 
Designs, 34 
Diagnostic buffer entries, 78 
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Diagnostics, 243 
Digital I/O 

Connecting cables, 53 
Wiring, 53 

Distributed I/O systems, 20 
DMC20 

Creating, 203 
Properties, 202 

DP cycle, 92 
PROFINET, 104 

Drive optimization, 207 
Drive wizard 

Calling, 119 
DRIVE-CLiQ 

Advantages, 22 
Components, 22 
Connectable components, 48 
Rules for wiring, 46 

E 
EMC guidelines, 43, 249 
EMERGENCY OFF concept, 43 
Equipment 

open, 33 
Equipotential bonding, 41 
ESD guideline, 253 
Ethernet 

Configuring addresses, 100 
Interfaces, 99 
Properties, 98 

Extending a message frame 
D4x5, 190 

F 
Fan/battery module, 81 

Fan control, 81 
Fan faults, 82 
Max. permissible supply air temperature, 81 

Free message frame configuration on the D410 
P915/P916, 185 

G 
Global measuring inputs on the D4x5, 194 

Parameter, 198 
Guideline 

ESD, 253 

H 
Hardware 

Configuring, 116 
High-speed output cams 

D4x5, 193 
HW Config 

Perform alignment, 133 
Hydraulic axis 

configuring in SIMOTION, 177 

I 
I/O systems 

PROFIBUS, 20 
Released, 23 

I/O systems. PROFINET, 21 
I/Os of the D4x5, 178 
IEC 1131, 249 
Inputs for measuring inputs on the D4x5, 194 
Integrated drive 

Downloading a configuration, 117 
SINAMICS S120, 119 

L 
LED display 

Diagnostics, 243 
Load 

Project, 135 
Local measuring inputs on the D4x5, 194 

Parameter, 196 

M 
Measuring inputs on the D4x5 

Comparison of local and global measuring 
inputs, 194 

Memory model, 72 
Memory reset, 214 

via SIMOTION SCOUT, 215 
with mode selector, 216 

Message frame 391 on the D4x5, 180 
Message frame 392 on the D4x5, 180 
Message frame 39x on the D4x5, 180 

PZD1, 182 
PZD2, 182 
PZD3, 182 
PZD3 to 15, 182 

Message frame configuration for the D4x5, 180 
Message frame configuration on the D4x5, 185 
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BICO, 186 
Interconnection, 185, 186 
Message frame 999, 186 

Message frame extension 
D4x5, 190 

Message frames on the D4x5 
39x, 180 

Modules 
Transport and storage conditions, 27 

Mounting 
on rear wall of control cabinet, 38 
Side, 36 
With spacers, 37 

MPI bus 
Bus connector, 61 
Connection rules, 62 
interface, 107 
Parameters, 107 

MPI interface, 91 

N 
Network failure, 77 
Non-volatile data 

Backup, 77 
Diagnostics, 78 
Power-up, 78 
Saving to the CF card, 74 

O 
Offline configuration 

Overview, 118 
Procedure, 118 
Requirement, 118 

Onboard I/Os of the D4x5, 178 
Onboard I/Os on the D4x5, 194 

Inputs for measuring inputs, 194 
Online configuration 

Procedure, 111 
Requirement, 111 

Opening the front cover, 42 
Overview of connections, 40 
Overview of the use of the I/Os on the D405, 178 

P 
PG/PC connection 

enabling the active setting, 97 
via Ethernet, 87 
via PROFIBUS, 85 

Power supply 
connecting, 45 
Rules for the line voltage, 44 
Safety regulations, 43 
Switching on, 70 
VDE guideline, 43 

Power-up 
Control unit, 70 

Process status data, 186 
PROFIBUS address, 92 
PROFIBUS cable 

Baud rate, 56 
Cable length, 56 
connecting, 58 
Properties, 56 
removing, 58 
Rules for cabling, 57 

PROFIBUS DP 
Creating a new subnet, 96 
Data transmission rate, 96 
Definitions, 89 
DP cycle, 92 
Interfaces, 90 

PROFINET 
DP cycle, 104 
IO controller, 105 
IO device, 105 
Properties, 105 
Wiring, 63 

PROFINET cable types, 64 
Project 

archiving on CF card, 136 
creating, 83 

Protection against external electrical phenomena, 44 
PZD, 186 

Maximum number, 186 

R 
References, 4 
Regulated infeed 

Activating, 168 
Enabling with motion task, 172 

Replace module 
DRIVE-CLiQ, 227 
Without PG/PC, 226 

Restoring the default settings 
SINAMICS Integrated, 218 
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S 
Safety information, 25 
Safety of electronic controllers, 250 
Shield contact 

Using, 54 
SIMOTION D 

User memory concept, 72 
SIMOTION D4x5 

Hardware components, 17 
Installation, 34 
Possible applications, 16 
Software components, 18 
System overview, 15 
Variants, 16 

SIMOTION SCOUT, 83 
engineering, 163 

Speed controller 
Adjusting the P-Gain, 211 
Optimum, 209 
Starting the measuring function, 210 

Standard IE cable types, 64 
Subnet 

Connection components, 55 
Connection rules, 59 
Segment, 55 
Terminating resistor, 55 

Switching on 
information, 69 
Requirement, 67 

System 
Powering down, 219 

System components, 19 
System cycle clock 

Bus cycle clock, 92 
DP cycle, 104 
IPO cycle clock, 92, 104 
Servo cycle clock, 92 

System cycle clocks, 93 
Ratios of system cycle clocks, 93 

System function 
_savePersistentMemoryData, 77 

T 
Technology package 

Upgrade, 234 

Terminal Module TM41, 200 
Configuring, 200 

Terminating resistor, 55 
Testing the drive, 161 
TM41 

Programming, 201 
Totally Integrated Automation, 15 

U 
UL certification, 249 
Upgrade 

Technology package, 234 
Within a platform, 233 
Without node change, 233 

Upgrading 
Firmware, 229 
Hardware, 224 
Software, 229 

Upgrading hardware, 224 
Upgrading of firmware, 231 
User data 

Deleting, 217 
Loading, 212 
Saving, 213 

User memory concept, 72 
Backup time, 74 
Fan/battery module, 74 
Non-volatile data, 73 
Volatile data, 75 

V 
Vibrations 

Reduction, 29 
Volatile data, 75 

X 
X122/X132 interfaces, 53 
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